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Inventory Adapters and Connectors

FlexNet Manager Suite relies on software and hardware inventory collected from the computers in your computing estate
to calculate what licenses are required. While the system includes a full inventory-gathering capacity, it also allows you to
import inventory collected by other tools you may already have.

As well, the system uses a considerable amount of business-related data, including organizational structure, and records
of purchases, to correctly track your existing license entitlements. This business data can also be imported from other
sources in your enterprise. However, business-related data is not the subject of this document: instead, see Using FlexNet
Business Adapters, which covers both the creation of business adapters and import of data through them.

This document, therefore, focuses on the collection of software and hardware inventory.

The data collected by the 'third party' tools usually needs to be rationalized in different ways, and mapped into the data
fields within the FlexNet Manager Suite database. The interfaces that allow this mapping are called adapters, structured
as XML files. Several adapters are provided by default with the system, or are available for download from the Flexera
Product and License Center. You can also build custom adapters for inventory using the Inventory Adapter Studio,
supplied with the product.

Some other inventory systems allow a rather simpler interface, where the preparation of XML-based adapters is not
necessary. Instead, it is enough to declare a connection to these systems, most often from an inventory beacon. Some
such systems are databases for third-party tools, where a direct connection may be possible, given a suitable connection
string. The incoming data can then be mapped automatically into the operations databases for FlexNet Manager Suite,
most often directly into the compliance database. Since the preparation of XML-based adapter files is not required in
these cases, they are referred to simply as connectors.

This document gives priority to several of the standard adapters available for FlexNet Manager Suite, because these are
the more complex cases that may require special installation, or custom XML files and the like. Over time, coverage of
connectors will also increase.

Before diving into the details of the various connectors and adapters, some useful tables compare the kinds of
information available from various data sources (see Inventory Comparison Matrix).

Following the details about available adapters and connectors, the Inventory Adapter Studio is documented. This is for
advanced and experienced developers who wish to create custom adapters (see The Inventory Adapter Studio).

Between these 'bookends', the following adapters and connectors are documented, in this (alphabetical) order:

¢ ADDM — now rebranded as BMC Discovery (see below)
o App-V—see App-V Server Adapter

e Atrium — see BMC Atrium and Remedy Integration

¢ AWS EC2 — see AWS EC2 Connector

¢ BMC Discovery — see BMC Discovery (ADDM) Adapter
o Data Platform — see Data Platform Integration

e HP DDMI — see HP DDMI Adapter



HPE Universal Discovery — see HPE Universal Discovery Adapter
Microsoft Azure - see Microsoft Azure Connector

Office 365 — see Managing Microsoft Office 365 Licenses

Oracle Enterprise Manager — see Oracle Enterprise Manager Adapter*
Flexera SaaS Manager — see Flexera SaaS Manager Connector
Salesforce — see Salesforce Subscription Management

ServiceNow — see ServiceNow Integration with FlexNet Manager Suite
Tanium Connector — see Tanium Connector

XenApp server adapter — see XenApp Server Adapter.
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Inventory Comparison Matrix

Not all inventory sources are created equal. Some sources do better at collecting details necessary for licensing
calculations than others. The following tables let you quickly assess what data may be missing from various sources.

Strictly speaking, not all the products listed in these tables are inventory sources (particularly in the later tables).
However, they are all data sources that can provide data for FlexNet Manager Suite to use in license compliance
calculations.

D Note: For supported versions of these products, please review the FlexNet Manager Suite System Requirements and
Compatibility on Flexera HelpNet for the current version of FlexNet Manager Suite.

Inventory Sources

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

d DB
€06€ Installer File Server Application

FlexNet inventory agent (previously Managesoft)

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Microsoft SCCM (previously SMS)l

Yes Yes Yes Yes Yes Yes No Yes No No

Flexera Normalize (Data Plat‘form)2
Yes Yes No No No No No No No No
BMC Discovery (previously ADDM)

Yes Yes Yes Yes Yes No Yes No Yes No

BMC BladelLogic Client Automation (previously Mc:rimba)3
Yes Yes Yes Yes Yes Yes Partial No No No

HP Discovery and Dependency Mapping Inventory (DDMI)

16 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Inventory Comparison Matrix

Information Collected per Product

Computer User Product Evidence Virtualization Clusters
code

Installer File Server Application

Yes Yes Yes Yes Yes No No No No
HPE Universal Discovery (HP-UD)

Yes Yes Yes Yes Yes No No No No
IBM License Metric Tool (ILMT) on Microsoft SQL Server

Yes No Yes Yes No No Yes No Yes
IBM License Metric Tool (ILMT) on IBM DB2

Yes No Yes Yes No No Yes No Yes

BigFix platform (previously Tivoli Endpoint Manager and IBM BigFix)4

Yes Yes Yes Yes No No No No No

Microsoft Exchange ActiveS ync5

Yes Yes No No No No No No No

Symantec IT Management Suite (formerIyA[tiris)6

Yes Yes Yes Yes Yes No Partial No No

1. App-V integration provides application virtualization in Microsoft SCCM (previously SMS).

2. Doesn't support BDNA running on Oracle DB. v5 was released April 9th, 2018 as a separate download.

3. Virtualization: VMware, and Solaris Zones. Collects VM properties, but doesn't collect host-VM relationships.

Oracle

] ]

No

No

No

No

No

No

No

4. Doesn't collect publisher information, and has potential for false recognition positives. BigFix platform inventory

source does not provide the serial number from UNIX-like platforms.
5. Mobile devices only.

6. Virtualization: VMware, and Hyper-V. Doesn't collect pool or resource allocations.

Server Virtualization

Information Collected per Product

Computer User Product Evidence Virtualization Clusters
code Installer File Server Application
Microsoft Hyper-V*
Yes Yes
Oracle VM Server for x86
Yes Yes
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Information Collected per Product

Computer User Product Evidence Virtualization Clusters Oracle

code . . ] ]
Installer Server Application

VMware vCenter*

Yes Yes
VMware ESXi Server*

Yes
VMware vSphere*

Yes

* Refer to the Inventory Sources table above for sources that provide data for these technologies.

Application Virtualization

Information Collected per Product

Computer User Product Evidence Virtualization Clusters

d
€O6€ Installer File Server Application

App-V Server*

Partial Partial Yes No No Yes No Yes No No

App-V integrated with scem?

Yes Yes Yes No No Yes No Yes No No

EdgeSight for Citrix Virtual Apps (previously XenApp EdgeSight)3
Yes Yes Partial No Yes Yes No Yes No No
Citrix XenApp server

Yes Yes Yes No Yes Yes No Yes No No

Citrix Virtual Desktops4
Yes
Flexera SaaS Manager

Dummy5 Yes Yes Partial®  No Yes No Yes No No

1. Requires mapping of packages to applications within FlexNet Manager Suite. Requires Active Directory integration and
FlexNet inventory agent.

2. Provided by SCCM adapter.
3. Installer evidence is gathered when combined with Flexera's XenApp server agent.

4. Provided by a dedicated FlexNet inventory agent.
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5. Flexera SaaS Manager does not track computers. Since FlexNet Manager Suite requires a computer record for various
database links, a single dummy record is created (if not already present from previous imports) during import from this
connector. Note that this connector imports completed licenses managed in Flexera SaaS Manager, including all
entitlements, for inclusion in the nightly license compliance calculations.

6. Imports from the Flexera SaaS Manager connector import installer evidence for Office 365, allowing for application
recognition in the nightly license reconciliation. This matches the behavior of earlier connectors for Office 365.

Other System Integrations

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle
code Installer File Server Application b8
Oracle Database”
Yes
Oracle E-Business Suite*
Yes

Oracle Enterprise Momager1

Salesforce

Yes
Office 365

Yes
SAP BASIS*

Yes
Tanium Asset

Yes Yes Yes Yes

* Provided by a dedicated FlexNet inventory agent.

1. Provides Oracle database connection details for use with a dedicated FlexNet inventory agent.

ITSM System Integrations

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

code . . .- ] ]
Installer File Server Application

. 1
ServiceNow

BMC Atrium CMDB and Remedy”
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1. Export computers and installed applications to ServiceNow. Import contracts and assets from ServiceNow into FlexNet
Manager Suite.

2. Export computers and installed applications to Atrium. Import asset details from Remedy and Atrium into FlexNet
Manager Suite.
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BMC Discovery (ADDM) Adapter

The tool from BMC for collecting hardware and software information, previously known as Atrium Discovery and
Dependency Mapping (ADDM), from version 11 has been renamed BMC Discovery. This tool can be a useful inventory
source as input to FlexNet Manager Suite to help in calculating license consumption as part of assessing your overall
license compliance.

To collect inventory information from BMC Discovery and import into the operations databases maintained by FlexNet
Manager Suite requires a data adapter. The adapter is documented in the following chapters.

Supported versions

The BMC Discovery adapter supports inventory import from the following releases of the BMC tool: 9.0, 10.0-10.2 (ADDM),
11.0-11.3,12.0
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Choosing a Configuration

The adapter to extract data from BMC Discovery can operate at different levels of detail, and with different overheads,
that depend on what level of licensing information you need to collect. This section gives a brief overview of how the
adapter works, and explains the different configurations and how to choose between them. You need to choose the
configuration appropriate for your enterprise before implementing the adapter.

How the Adapter Works

Although it is downloaded as a single zipped archive, the adapter includes several components to improve your license
reporting. The overview of the finished system shows:

* An optional set of patterns that can be deployed to each BMC Discovery instance to improve the initial level of
inventory detail collected by BMC Discovery.

o Astaging server, which includes a simple SQL database where data collected from BMC Discovery can be massaged
for upload to FlexNet Manager Suite. The executable that speeds the data extraction process also resides here. For
on-premises solutions, this staging database may optionally reside on the central operations databases server.

¢ The conversion and upload component, which converts data formats and uploads the result to the central
operations databases maintained by FlexNet Manager Suite.

Operation is summarized in this high-level diagram:

Figure 1: Process overview

e = e
Target device BMC ADDM Staging FlexNet Manager Platform
FnmpADDMStage ComplianceReader
e Inveritory | S r | ~—T1——T7—""
= N 1 —._; 1
) =t " XML aver HTTR(S) |= : il
T ) Data Stora Web XmlApi gver Hi 1) - ADDM _Stage
= g | - [Devl-:elnfq:ml
i 2 [5L-1 I
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el = o |
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The diagram shows:
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1. Optionally making use of additional patterns packaged with the adapter download, inventory details are collected
by BMC Discovery (previously ADDM).

2. The executable FnmpADDMStage . exe uses the web API to extract the information from BMC Discovery. This
method is used because the export process is 100 times faster than using mappings, and there is no requirement
to configure custom mappings for each BMC Discovery instance. This executable optionally writes the gathered
data into local XML files (available for inspection when required), and (determined by the mode of operation) also
writes the data from these XML files into the staging database.

3. Astandard component of FlexNet Manager Suite called a Compliance Reader, executing from the central
application server, collects data from the staging database and imports it into the operations databases. This final
stage occurs when you run an inventory import to process the incoming inventory.

Components Explained

This section describes each of the components in more detail, with information to help you decide which of these you
will implement in your enterprise. Installation and setup follows in a separate section. The components described
below are:

« Optional collection patterns to enrich the inventory detail collected by BMC Discovery (see Optional Patterns)
o The FlexNet inventory agent (see The FlexNet inventory agent)
o The scripts for creating the staging database in Microsoft SQL Server (see Database Table Creation)

* The FnmpADDMStage . exe executable to extract inventory information from BMC Discovery, optionally write it to

XML files, and insert it into the staging database (see The Adapter Executable).

Optional Patterns

There are six collection patterns in all.

e FileEvidence allows collection of file evidence for use within FlexNet Manager Suite. This evidence may be of

two sub-types:

o Executable files that form part of the application, which are gathered only for Window platforms, and may allow
application recognition (particularly to the level of editions and versions)

o Identification files including 1SO tag files, which may be gathered across any platform (including Windows and

UNIX-based environments).

The next two collection patterns run both on Windows and on non-Windows devices, instructing the BMC Discovery
inventory agent to gather additional data:

e InstallAnywhereEvidence returns the list of package titles found in the repository maintained by Flexera’s

InstallAnywhere

e InstallShieldMultiplatformEvidence returns the list of packages installed by InstallShield Multiplatform,

an earlier installation technology developed by Flexera.

The next collection pattern is for non-Windows devices only, and uses the FlexNet inventory agent to capture

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1
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additional data elements and integrate these with the BMC Discovery inventory collected in the standard way:

* UnixHardwareData gets accurate hardware details to allow license metrics for capacity-based license
calculations (such as for Processor, Core, IBM PVU, and other license types).

=X
|

=] Note: This pattern relies on the installation of two files, ndtrack. sh and ndtrack. in1i, that are not included

with the adapter package. These files are available with any installation of the FlexNet Beacon or application
server. For more information, see The FlexNet inventory agent.

The last collection pattern contains instructions for the BMC Discovery inventory agent to pull additional data from
the Windows Registry and WMI on Windows-based computers:

e WindowsLastLoggedOnUser recovers information about end-users that is required for user-based licensing (such
as Named User license types).
=
|==I" Note: There is no equivalent data available for UNIX-like systems.
To help you assess which of the patterns you wish to use, the following table summarizes the available collection
patterns. The default state, whether the pattern is enabled or disabled, is shown in the Pattern column. The Footprint
column details the additional installation impact (other than loading the pattern into BMC Discovery) required for the
collection pattern (the downside of using the pattern), and the Impact column shows what will not work if you omit
this pattern (the downside of not using it).

24

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Pattern Footprint

FileEvidence No installation required.
Default: Functionality is This pattern is configurable for
controlled in two parts: paths searched (per platform),

and for file name extensions
used for tag files. Search times
on target machines will
depend on configuration and

o Gathering identity (or tag)
files (all platforms) is
enabled by default

« Gathering executable the numbers of installed

evidence (Windows only) is applications found.

disabled by default.

InstallAnywhere Evidence Noinstallation required.
Default: Enabled

InstallShield No installation required.
MultiplatformEvidence
Default: Enabled

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1
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Impact of omitting pattern
An application that

» Isnotalready correctly recognized by BMC
Discovery (perhaps because it is installed
but not currently running), and

« Relies exclusively on file evidence (as
distinct from installer evidence) for
recognition within FlexNet Manager Suite

will not be recognized for inventory collected
through BMC Discovery without this pattern.
While the Application Recognition Library
rarely makes use of file evidence for Windows-
based applications, some publishers including
IBM and Oracle make use of special identity
files. Software identity (SWID) tags are also in
increasing use, and these are identified using
this pattern.

Likely impact of omitting this pattern in total is
medium (through the loss of identity files).
Likely impact of leaving executable gathering
turned off is low.

Ij Note: Within FlexNet Manager Suite, file
evidence is also required for application
usage tracking; but no application usage
tracking is possible through the BMC
Discovery inventory tool.

BMC Discovery does not recognize installation
evidence from InstallAnywhere. Unless it
recognizes the application by other means, the
application will be missed without this pattern.

BMC Discovery does not recognize installation
evidence from InstallShield Multiplatform.
Unless it recognizes the application by other
means, the application will be missed without
this pattern.
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Pattern Footprint Impact of omitting pattern

UnixHardwareData Requires less than 13 MB Without this, BMC Discovery does not capture

Default: Enabled installation (ndtrack.sh and sufficient hardware attributes from servers to
ndtrack.ini), either on the support license consumption calculations on
hard disk of the target license types based on hardware capacity
machines, or on a network metrics (such as Processor, Core, IBM PVU, and
share accessible to them all. other license types). Assess impact based on
Run-time is a second or so the license types you need to support through
when triggered by BMC BMC Discovery inventory (mandatory for
Discovery. capacity metrics).

WindowsLast LoggedOnUser No installation required. Without this pattern, BMC Discovery does not

Default: Enabled report any end-user identification that is

needed for licenses requiring identification of
the individual (such as Named User license
types). Note that for general user-based
licensing, in the absence of end-user identities,
FlexNet Manager Suite will calculate every
installation of such software as usage by an
unknown end-user, so that only license types
depending specifically on identity will be
affected. If you wish to allocate license
entitlements to specific individuals, you also
require this identification. Impact: medium.

D Note: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, there is an
additional pattern that improves the details about processors collected by BMC Discovery. This level of detail is
required only for Oracle and IBM license calculations (for other licenses, the patterns above are adequate). By
contractual arrangement with BMC, this pattern can be provided only to customers approved by BMC. For further
information, ask your Flexera consultant, who can arrange the necessary approval and provide the pattern for you.
Notice that for BMC Discovery release 11.1 or later, the additional pattern is deprecated. BMC Discovery 11.1 (and
later) has improved processor information collection which makes this additional pattern unnecessary.

For more information:

» About each of these patterns, please see Appendix A: Details of Patterns
« About installing these patterns, see Installing Optional Patterns

« About enabling or disabling each of the patterns, see Enabling Optional Patterns.

The FlexNet inventory agent

The FlexNet inventory agent is a standard component of any installation of FlexNet Beacon, and of the application
server that is included with FlexNet Manager Suite. For this reason, the necessary files are not included in the BMC
Discovery adapter zip archive, since they are already present in any standard product implementation. Installation to
suit the BMC Discovery adapter is described in Installing the FlexNet inventory agent.

For use on Linux or UNIX platforms, the agent has two component files:
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e ndtrack.sh, an agent responsible for collecting inventory details (in this case, from the BMC Discovery inventory
system) and writing them in an intermediate format to a data file, ready for upload to an application server. The
script has no active elements until it is triggered by BMC Discovery through one of the enhanced collection
patterns.

« ndtrack.ini, atext file that contains configuration variables for ndtrack. sh.

The combined disk space requirement of both files is under 13MB.

|_¢' Important: Inventory fails to upload from FlexNet inventory agent if the account running ndtrack. sh has a hash
(#) character in the user name. The hash (#) character is not permitted, and causes failure of the upload of the
generated . nd1 files to the application server.

Database Table Creation

The staging server requires an operating version of Microsoft SQL Server 2012 or later. Any edition is suitable,
including Microsoft SQL Server Express (if its limitations on CPU, RAM, and database size are adequate for your
purposes). As described in Choosing a Staging Server, the staging database may be located on a separate staging
server, or on your central (on-premises) operations databases on your FlexNet Manager Suite server.

In the SQL\ subdirectory of your unzipped adapter archive, the script ADDM_staging.sql is provided for creating the
staging database, its tables, and its stored procedure. Obviously, this must be run on the SQL Server instance that is to
host the staging database.

|_¢ Important: If you have been using an earlier version of ADDM, and are now migrating to BMC Discovery release 11
(or later), you must run the same ADDM_staging. sql script to update your staging database schema. If you are
continuing to use ADDM release 10 (or earlier), the update to the staging database schema is not required, and you
may omit it for now; but if you choose to apply the upgrade now (so that the staging database is prepared for any
future migration to BMC Discovery 11 or later), you must also use the latest version of the FnmpADDMStage . exe

executable from the same Adapter Tools for FlexNet Manager Suite 2020 R1.z1ip archive. This executable
transfers to BMC Discovery data (for any BMC Discovery/ADDM version) to the staging database, and is schema-
aware for the upgraded staging database.

The Adapter Executable

BMC Discovery supports two ways of extracting inventory data it has collected:
« Using export mapping sets
» Using a web API.

While the former is more commonly used, the BMC Discovery adapter for FlexNet Manager Suite uses the latter, for the
following reasons:

» It avoids the need to deploy and maintain export mapping sets on every BMC Discovery instance in your enterprise.

» Performance of data collection can be 100 times faster using the web API. For example, data extraction that can
take over 24 hours using mapping sets can be completed in 20 minutes with the web API. This is because the export
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feature in BMC Discovery is designed for more complex export capabilities and can therefore be slow to perform
simple queries. FlexNet Manager Suite requires only simple queries to be executed on BMC Discovery, and these are
performed far more efficiently using the web API.

The tool to query the web API consists of two parts:

o FnmpADDMStage.exe — A .NET 4.5 console program capable of querying the XML API of BMC Discovery and writing
the results into an SQL Server database, and optionally to XML files on the local file system. This program supports
command line arguments, available using FnmpADDMStage -h

e FnmpADDMSettings.xml — The self-documenting configuration file for FnmpADDMStage . exe which contains the
queries executed against BMC Discovery (in the BMC Discovery query language), and can include connection
settings for BMC Discovery and SQL Server.

In operation, the executable, FnmpADDMStage . exe, extracts the inventory data from BMC Discovery and saves it for
further processing. There are different ways that it can save the data, based on the following values of its method
parameter:

o Stage — Summary: BMC Discovery to XML. Inventory gathered from BMC Discovery is saved to a series of XML files
on the staging server. It is not imported into the staging database. The XML files allow for review of the gathered
data, but the inventory is not imported into FlexNet Manager Suite from these files.

.I{-'..
' Tip: The XML file option also allows for disconnected scenarios, where inventory collected from an BMC Discovery

server that is out of reach of the staging server can be written to XML, manually copied and transferred to another
staging server, and the upload process resumed. See also the Prestaged method below.

e Staged — Summary: BMC Discovery to XML/SQL. Inventory gathered from BMC Discovery is first written to the
XML files on disk (for example for review), and then copied into the staging database where it can be imported into
FlexNet Manager Suite for use in compliance calculations.

e Prestaged — Summary: XML to SQL. In this mode, inventory is not gathered from BMC Discovery. Instead, the
XML files present on the disk from a previous inventory collection (and perhaps reviewed and approved by a
human agent in this format) are now copied into the staging database where it can be imported into FlexNet
Manager Suite for use in compliance calculations.

e Stream— Summary: BMC Discovery to SQL. Inventory is gathered from BMC Discovery, and loaded into the
staging database where it can be imported into FlexNet Manager Suite for use in compliance calculations. In this
method, inventory is not recorded in XML files on the staging server.

Default values for the method and all other parameters are set in the companion FnmpADDMSettings.xml file, and
these are the values used when the executable is triggered (or run) without other command-line options. The settings
file is self-documented, and the matching command-line options are available using FnmpADDMStage -h

When the executable writes XML files to (or reads them from) the local disk on the staging server, the files include the
following (details are available in FnmpADDMSettings.xml):

Filename Content

Cluster.xml Details for each cluster.
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Filename Content

ClusterHost.xml Computers (host nodes) that are members of a cluster, including a key to
the Cluster node to identify that cluster.

CPUInformationDetail.xml Details of computer processors.

DiscoveredPackages.xml Raw installer evidence gathered by BMC Discovery from the installer
technologies supported by each operating system.

DiscoveredService.xml A report of particular services, used to help identify capabilities of hosts.
This includes the VMMS service used to identify Windows machines with
the Hyper-V role enabled.

DiscoveredVirtualMachine.xml Raw results from BMC Discovery querying the list of virtual machines on
avirtualization host.

FileEvidenceDetail.xml File evidence produced by the

Flexera.FNMP.InventoryRawData.FileEvidence pattern, covering

software tag files and Windows executables.

FileSystem.xml Name and size of all local file systems, used to approximate the total
disks and storage of host.

HardwareEvidenceDetail.xml Hardware details produced by the
Flexera.FNMP.InventoryRawData.UnixHardwareEvidence
pattern, using information gathered by the FlexNet inventory agent.

Host.xml Details of all hosts known by BMC Discovery including their host name,
operating system details, unique identification, processor, memory, and
other hardware details.

HostInfo.xml Raw host details not represented in a Host node, mainly the raw LPAR
information from an IBM AIX LPAR environment.

HostContainerProcessorInfo.xml Processor details for systems that are a container for hosts. For example,
a container is a device partitioned into a number of logical hosts.

InstallerEvidenceDetail.xml Installation evidence gathered using the patterns in the BMC Discovery
adaptor, including evidence from installations by Install Anywhere and
InstallShield Multi-platform.

LastLoggedOnUserDetail.xml Details of the last logged-on user for Windows systems. (There is no
equivalent data available for UNIX-like systems.)

NetworkInterface.xml The IP and MAC addresses of each network interface, used to build a list
of these addresses for each host.

D Note: ADDM 9.0 introduced the IPAddress nodes which cover both
IPv4 and IPvé. Prior to that, the IPv4 IP address was in the
NetworkInterface node. This query checks both of these sources.
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Filename Content

SoftwareInstance.xml Software installations identified by BMC Discovery's pattern language.
BMC Discovery queries various properties such as processes and files of a
host to determine which software is installed and its version.

SoftwareInstanceVirtual These SoftwareInstance nodes are used to represent virtual
Machine.xml machines on a host. These records are typically only created when the
virtual machine is running.

Conditions for Use

Use of this executable, FnmpADDMStage . exe, imposes the following conditions:

e Within BMC Discovery, the XML-based APl must be enabled (by default, it is enabled). BMC documentation for the
XML APl is available at https://docs.bmc.com/docs/display/DISCO111/XML+API.

o There must be HTTP or HTTPS communication available between the staging server, on which this executable
runs, and the server hosting BMC Discovery.

» The staging server requires the .NET 4.5 (minimum) runtime environment.

o The staging tool must be configured with credentials that provide read access to the BMC Discovery instance.
These credentials may either be configured in FnmpADDMSettings.xml or supplied on the command line for
FnmpADDMStage . exe (for details see Account Configuration). For Discovery 11.1 and later, you need to grant the
APl access permission (api-access group), or update group permissions to include the api/access permission for
the user that is specified in the FnmpADDMSettings.xml, who requires access to the XML Web APIs.

« For linking upstream to the staging database, you can either

o Use a trusted connection to the SQL server and run the executable under an account that has read/write access
to the staging database; or

o Use service account credentials for SQL through a connection string, which may either be configured in
FnmpADDMSettings.xml or supplied on the command line for FNMPAddmStage . exe (see Creating the
Staging Database Tables for details).

I} Important: It is critical that the FnmpADDMStage . exe tool is not run simultaneously with the
ComplianceReader tool that uploads from the staging database to the compliance server. The adapter
executable commences its writing activity with a truncate of the staging database to clear old results, an action
which (if it occurred in the middle of an upload to the compliance server) could clearly corrupt the imported
dataset. While CompLianceReader is blocked until FnmpADDMStage . exe finishes, you must adjust your
schedules to prevent starting FnmpADDMStage . exe while the ComplianceReader is running.
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Installation and Configuration

For on-premises implementations, files are included in your product installation archive for the application server. As
well, the latest version of the adapter is available for download from the Flexera Customer Community knowledge base.
For cloud implementations of FlexNet Manager Suite, you also require this download: although you do not need to make
changes to your central application server, there are additional components you require in the download.

You need credentials supplied by Flexera to access this download. Details of the download are included in Download the
Adapter.

o The BMC Discovery adapter suits FlexNet Manager Suite releases 9.2.3, and 2014 and later for on-premises delivery.

o The build number for this adapter is 12.0 (or higher). You can identify this number by right-clicking on
FNMPADDMStage . exe, selecting Properties and looking at the Details tab.

Full details of setting up the BMC Discovery adapter are included in the following sections.

Choosing a Staging Server

The FlexNet adapter for BMC Discovery requires a ‘staging server’ that supports installation of the adapter’s executable
and configuration file. Optionally, this server may also support the staging database, or at least has fast network access
to the database server providing the staging database. Several configurations are possible. The staging server may be
installed on:

¢ Adedicated stand-alone server (or virtual machine)

* Any other suitable machine in your enterprise, such as a print server

« Aninventory beacon

o The central application server where FlexNet Manager Suite is installed (for on-premises installations).
The requirements for a suitable server include:

* AWindows-based operating system

» Access to an installation of Microsoft Microsoft SQL Server 2012 or later, in any edition, where the staging database
may be implemented (it may be on the staging server, or on a separate database server)

e The.NET 4.5 runtime environment installed
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« Network access to the central application server (when not co-installed there)

« Efficient network access to each BMC Discovery server in your enterprise, using the HTTP or HTTPS protocols.

ﬂ Note: Disconnected scenarios are also possible, using the intermediate XML files saved to disk to allow manual
intervention. For more information, see The Adapter Executable.

Download the Adapter

The download includes the executable for the adapter, its configuration file for you to customize, a script to create the
staging database, some optimized patterns for BMC Discovery, and so on. All these resources are included in a master
downloadable archive for all adapters.

=
[_] To download the adapter and resources:

1. Download the Adapter Tools for FlexNet Manager Suite 2020 R1.zip archive. One path is through the

Flexera Community:

;
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand Other Resources and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Platform,click LET'S GO! (and

subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.

e. Inthe Latest Versions tab, click FlexNet Manager Suite 2020 R1.
A EULA page may appear. If so, accept the license, as this grants access to the list of Downloads.

f. Inthe list of available Downloads, in the File Name column, click Adapter Tools for FlexNet Manager
Suite2020 R1.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2020 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the downloaded zip archive, and choose Extract All..., saving the files in your working location.

The path of interest in the unzipped archiveis Tier 1 Adapter Tools\BMC ADDM - Atrium Discovery
and Dependency Mapping Tools, which contains three folders:

¢ FnmpADDMStage
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« patterns

« SQL.

You will access the extracted archive in the following procedures, setting up and configuring the adapter and
supporting infrastructure.

Creating the Staging Database Tables

Once you have selected your staging server, and it can access an operating implementation of Microsoft SQL Server
running a database instance you intend to use for the staging database, you should use the script provided to create the
staging database and set up the appropriate database tables within it. This can be done from SQL Server Management
Studio, or from the command line as described in the following procedure.

-
[_] To create staging database tables from the command line:

1.

Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2020 R1.zip>BMC
Atrium Discovery and Dependency Mapping Tools >SQL.

If necessary, copy the script ADDM_staging.sql from the \SQL folder of your unzipped adapter archive to a
temporary folder on your staging server.

. Open a command prompt on the staging server, and navigate to the folder containing the script.

In the command prompt window, execute the following command, as amended:
sqlcmd -S ServerName\InstanceName -i TemporaryPath\ADDM_staging.sql

where:

« ServerName is the name of the database server hosting the staging database, or its IP address, or “.” (dot) if

you are running the staging script on the same server as the database instance

e InstanceName is the name of the instance to use for the database staging tables (this parameter may be

omitted if the instance is the default instance)
o TemporaryPath is the location where you saved the SQL procedure.
Example:

sqlcmd -S 192.100.0.20\Development -i C:\temp\ADDM_staging.sql

The database ADDM_Staging is created with all necessary tables, indices, and so on.

Ensure that the account under which the adapter executable will run has read/write/execute permissions on this
database instance.

-
= Tip: Configuration of the account is done through SQL Server Management Studio.

Authentication may be through Windows NT authentication or SQL Server authentication. Using Windows NT
authentication:

o The default account is the username running the FnmpADDMStage . exe adapter
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o The SQL connection is specified as a standard connection string, which you may supply in
FnmpADDMSettings.xml, or override with the - c option on the command line.

The staging database is now ready for operation.

Installing and Configuring the Staging Tool

This procedure includes some separate sub-processes to complete the set-up of the adapter executable on your staging
server, and arrange for regular upload of staged data.

—
[_] To install and configure the staging tool:
1. Install the adapter executable along with its configuration file.
a. Create afolder (suggested: ADDMAdapter) to contain the adapter executable and its configuration file.

Location is not critical: a suggested path is under C: \Program Files\Flexera Software (this path

already exists if you have chosen to use an inventory beacon as your staging server).

b. From the FnmpADDMStage\ folder within your unzipped archive, copy both FnmpADDMStage . exe and
FnmpADDMSettings.xml to your newly created folder (such as C: \Program Files\Flexera
Software\ADDMAdapter). Both files must be in the same folder.

2. Update the configuration file (at the very minimum, correct the IP address of your BMC Discovery server).

a. Open your copy of FnmpADDMSettings.xml in a text editor of choice, and review the self-documenting
comments within that file.

b. BMC has changed the permission required to access the XML API. You need to grant the new APl access
permission (api-access group), or update group permissions to include the api-access permission for
users who require access to the XML web API.

I:i:; Important: Existing integrations will fail if you do not add the permission.

c. Update values in the first element describing the downstream connection to the BMC Discovery server,
including the IP address, the account name and password for access.

Keep a record of the account name and password for registering with BMC Discovery (see Account
Configuration). The default values are:

<server protocol="http" address="10.200.20.138" username="exportuser"
password="Pa$$word" timeout="3600"/>

F

= Tip: If you do not wish to record the password in the plain text configuration file, you can use a script to
retrieve the password from an encrypted store, and supply it as a command-line option when starting
the FnmpADDMStage . exe tool.

d. Update the second element for the connection to the staging database.

The default values are:
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<database
connection-string="Server=.;Database=ADDM_Staging;Trusted_Connection=yes;"/>

This default assumes that the database is running on this same staging server (represented with the dot
character). If not, modify to suit your situation, using either of the server name or its IP address.

e. Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from BMC Discovery.

The default value stores any XML files below the location of the executable (but turns off storage anyway):

<staging path="." method="stream"/>

You may wish to redirect the path setting for easier access for human inspection. The method parameter
may have any of the values stage, staged (these are two distinct values), prestaged, or stream (for
details, look back to The Adapter Executable).

f. Save your modified settings file.

3. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task
Scheduler, and create a basic task to run the adapter.

The command line for the scheduled task (assuming that you have saved your preferred settings, as described
above) is simply to invoke the executable. Any parameters not specified on the command line are taken from the
settings file in the same folder as the executable.

|_¢' Important: It is critical that you schedule the adapter to run at times which cannot overlap with the inventory
beacon uploading the results to the central compliance server. Check the schedule for the compliance reader
on the compliance server, and avoid this time slot.

By default, the inventory import is triggered around 2am. Therefore you might consider scheduling this task for
some time such as 10pm daily. Remember to allow sufficient time for inventory collection from BMC Discovery,
followed by extraction from the staging database, and upload to the central application server.

4. Select aninventory beacon with a good network connection to the server hosting your staging database, and
configure data extraction and upload.

a. Loginto the FlexNet Beacon interface as an administrator, and navigate to the Scheduling page.

b. Eitheridentify, or create, a schedule appropriate for data uploads from the staging database to the central
application server.

For details about creating a schedule on the inventory beacon, see FlexNet Manager Suite Help > Inventory
Beacons > Scheduling Page > Creating a Data Gathering Schedule.

c. Inthe navigation pane on the left, select the Inventory systems page.

d. Click New... (choosing the SQL Server option if you opened the drop-down) to open the Create SQL
Source Connection dialog.

e. Add a Connection Name that is easily recognized within the first few characters (for when it is later
displayed in narrow columns).

f. For Source type, choose BMC Atrium Discovery and Dependency Mapping.

g. Enter the Server name (or IP address) where the staging database is running. (If it is running on this
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inventory beacon, use the special value (1localhost) including the parentheses.)

7
= Tip: If the database instance you need is not the default one on the server you identify, add the
instance name, separated with a backslash character. Example:

(localhost)\myInstance

h. Choose the authentication method, and if required add the Username and Password for accessing the
database.

i. Enter (or choose) the Database name.

j. Click Test Connection. For more information, see the online help for this page.

i Tip: Your batch server (or, in a single-server implementation, your application server) also requires files to help the
inventory reader process the data uploaded from the staging database. There are at least 10 XML files, and a reader
configuration file. However, you do not need to do any set-up or configuration for these files, as they are installed as
part of the standard implementation of your batch (or application) server. You can validate the existence of these files
atC:\ProgramData\Flexera Software\Compliance\ ImportProcedures\Inventory\Reader\ onthat

server.

This completes the configuration of the adapter executable itself, and of the upload from the staging database to the
central application server. Now we can turn our attention downstream, first to possible installations on target UNIX-
based machines, and then to enhancements to BMC Discovery itself.

Installing the FlexNet inventory agent

If you have chosen to install any of the UNIX-related collection patterns to enhance the inventory collection available
through BMC Discovery, the FlexNet inventory agent must be copied either:

« Onto each UNIX-based machine that is a target for enhanced inventory collection; or
o To a pre-configured NFS share that is accessible from each of the target UNIX-based machines.
In the following procedure, your choice of either of the above two locations is referred to as the ‘target location’.

(For background information about the FlexNet inventory agent, see The FlexNet inventory agent. For choosing
between the collection patterns, see Optional Patterns. Further information about deploying the FlexNet inventory
agent is available in the separate PDF file Gathering FlexNet Inventory.)

To install the FlexNet inventory agent for UNIX collection patterns:

1. Usingtheinstallations of either FlexNet Beacon, or application server, locate the subdirectory that contains the
ndtrack files. The default location is C: \Program Files\Flexera Software\Inventory Beacon\
RemoteExecution\Public\Inventory.

2. From this folder, copy the two files ndtrack.sh and ndtrack. ini to the target location you selected above
(that is, either to a pre-configured NFS file share, or to each target UNIX-based machine). The default location pre-
configured in the template file is /opt/flexera/, but you may modify this as required.
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I} Important: The file path on all individual UNIX-based machines must be identical.

3. Note the file path used (whether a file share, or the identical path used across all target devices) for entry into
ADDM when you are enabling the optional collection patterns (see next section).

Configuring BMC Discovery

There are three customizations needed for BMC Discovery:
« Installing any of the optional patterns needed for the adapter in your environment (see below)

« Ensuring that BMC Discovery applies these patterns to the appropriate target computers (see Rediscovering Affected

Computers)

« Ensuring that the account running the adapter has access to BMC Discovery (see Account Configuration).

Installing Optional Patterns

For information about choosing which patterns to use, see Optional Patterns. For details about enabling each of the
patterns, and modifying their behavior, see Appendix A: Details of Patterns. All these patterns are contained in a single
template (Flexera.FNMP.InventoryRawData.tpl), which must be installed first. Thereafter, individual patterns

can be enabled, disabled, and modified.
1. Login tothe BMC Discovery interface, and select the Discovery tab.

2. Select the Knowledge Management button in ADDM version 10, or BMC Discovery version 11 or later (in earlier
versions of ADDM, select the Pattern Management button).

Figure 2: The workspace in ADDM 10
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3. Click on Upload (orin earlier versions, Upload New Package).

Figure 3: Choose the file from your unzipped archive
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4. Click on Choose File, and in your unzipped archive of the adapter, select the FlexNet Manager Platform\
Installers\BMC Atrium Discovery and Dependency Mapping Tools\patterns\
Flexera.FNMP.InventoryRawData.tpl file.

5. If you are using ADDM version 8:
a. Optionally modify (or accept) the default name of the package as Flexera.FNMP.InventoryRawData.
b. Optionally, set the description to something you will find helpful, such as FNMP export patterns.

6. Click Upload (orin earlier versions, Upload & Activate).

Ensure that the message The Requested Changes were Successful isdisplayed. The
Flexera.FNMP.InventoryRawData patternis now inthe Active state. For further fine tuning, jump ahead

to step 4 in the following procedure.

= Tip: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, if you are using data
imported through the BMC Discovery adapter to manage points-based licenses for IBM and Oracle, there is an
additional optional pattern that collect further details about processors available on request from Flexera. Notice
that for BMC Discovery release 11.1 or later, the additional pattern is deprecated. BMC Discovery 11.1 (and later) has
improved processor information collection which makes this additional pattern unnecessary.

Enabling Optional Patterns

By default, after installation some patterns are enabled and others disabled (see Optional Patterns). The following
procedure allows you to turn individual patterns on and off as required, as well as enabling (or disabling) the entire
module.

—
[_] To enable optional patterns within BMC Discovery:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that the
Flexera.FNMP.InventoryRawData item is enabled, and selectit. (The module must be enabled before any of

its member patterns can operate.)
3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.
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Several closed groups are displayed, one for each optional pattern and another for configuration of the FlexNet
inventory agent on UNIX platforms.

5. Foreach group that you want to modify, select Edit Configuration to the right of the group. The group opens,
and configurable controls are displayed. Select the True radio button to turn on a pattern, and the False radio
button to turn off a pattern.

More details about configuration are included in Appendix A: Details of Patterns.
6. Click Apply.

The modified settings are displayed.

(4

= Tip: If you later use the Edit Module button to modify the module, be sure to activate, validate, and then commit
your changes.

Rediscovering Affected Computers

Where (as is common) you are adding these patterns to an operational BMC Discovery instance that has already taken
inventory of computers in your estate, you must rediscover any computers that are to be targeted through these new
patterns, so that BMC Discovery applies to patterns to the rediscovered computers. To achieve this, you may either:

¢ Create (or wait for) a scheduled scan
« Initiate a Snapshot discovery scan
« Manually execute each pattern for suitably grouped targets, as summarized in the following procedure.

For more information about these options, see the BMC Discovery documentation available at
http://discovery.bmc.com/confluence/display/90/Documentation.

To manually execute the new patterns:

1. Inthe BMC Discovery interface, select target computers (hosts or other nodes) by adding them to a group,
creating separate groups to receive distinct types of patterns (for example, one group for Windows-related
patterns, and another group for UNIX-related patterns). Create your groups using either of these approaches:

« From aview node (including host) page, select Groups from the Actions list and add the node to a group.

» From areport or other search result, select the required target computers. Then, select Groups from the
Actions list and add the target machines to a group.

2. From the Discovery tab, click Pattern Management.

3. Selectthe Flexera.FNMP.InventoryRawData pattern from the package list.
4. Click the Pattern Modules link.

5. Selectthe Pattern Module containing the pattern that you want to run.

6. Click the Pattern link in the heading table.

7. From the Actions list, select Run Pattern.

8. Inthe Run against Group list, select the group containing your target machines for the current pattern(s).

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 39



Installation and Configuration

9. Setthe Expand and Execution Logging preferences forthe run.

10. Set Additional Discovery to Get all new discovery data. This forces a new discovery.

More details about this procedure are available from http://discovery.bmc.com/confluence/display/90/
Manual+pattern+execution.

Account Configuration

The user name and password that the adapter needs to access the BMC Discovery API are defined in
FnmpADDMSettings.xml (see Installing and Configuring the Staging Tool). Here we grant that account adequate

rights.

s
[_] To configure rights for the account calling the API:

1.

2,

40

In the BMC Discovery interface, select the Administration tab.

In the Security section of the Administration page, click the Users icon.

. From the Users page, click Add at the bottom of the page.

L
= Tip: If the account has already been registered in BMC Discovery, you can select it from the list of users and

review its settings.

Configure the adapter account, which can be a member of the readonly group. Ensure that the user name and
password are exactly same values that you configured in FnmpADDMSettings.xml. For BMC Discovery 11.1 and
later, the permission required to access the XML API has changed. You need to grant the new APl access
permission (api-access group), or update group permissions to include the api-access permission for users who
require access to the XML Web APIs. Existing integrations will fail if you do not add the permission.
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Figure 4: Sample settings for a adapter account to access BMC Discovery
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Validation and Operation

Normal operation relies on the following sequence of events:

1. BMC Discovery gathers inventory using the enhanced patterns you have enabled (details: Installing Optional
Patterns, and Rediscovering Affected Computers).

2. Atthe time you scheduled (Installing and Configuring the Staging Tool), the adapter reads the current content of
the BMC Discovery database and stages the new data in the staging database (previous data is first removed with a
single truncate statement). The resulting status is flagged within the database.
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3. Following the schedule on the central compliance server, and provided that the staging status is Success, the
import reader uploads this content to the inventory database.

4. The nextinventory import brings the final data set into the compliance database, where it is automatically taken
into account for compliance calculations. As always, the inventory records must be recognized by the Application
Recognition Library, and you must have the resulting application records linked to the appropriate license, for
compliance calculations to proceed.

To validate operation of the adapter:

1. Wait until BMC Discovery collects new inventory, so that the enhanced collection patterns are exercised. For
further details, see the BMC Discovery documentation.

2. Manually trigger the adapter executable.

By specifying a different method parameter, you have a one-time override of the default you set in the settings
XML file. For example:

C:\Program Files\Flexera Software\ADDMAdapter\FnmpADDMStage.exe
-f "C:\temp" -m staged

This will write XML files under your C: \temp directory for review. As well, it writes data into the staging
database.

3. Inspect the saved XML files to validate the inventory gathered.

4. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the
StagingState property in the ADDMStagingDatabaseConfiguration table in the staging database. Possible
values are Running, Failed, or Success. This value must be Success before the BMC Discovery data can be
uploaded from the staging database to the central inventory database.

5. Wait (for example, overnight) until the next inventory import and calculations have run.

6. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been
recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
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Known Issues

The following issue has been identified:

o UNIX-based devices that have the same host name and no detected serial number in BMC Discovery are merged into a
single computer record in FlexNet Manager Suite.
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Appendix A: Details of Patterns

While the BMC Discovery discovery tool is a state-of-the-art tool to support ITAM, the out-of-the-box collection of
inventory does not capture all of the data elements required by FlexNet Manager Suite to perform an accurate software
license calculation. The optional patterns in this appendix extend those data capture capacities.

Overview of Patterns

The BMC Discovery Adapter available for FlexNet Manager Suite includes six additional patterns that can be
incorporated into BMC Discovery to capture these additional data attributes.

Pattern name FlexNet inventory agent Default
dependency
FileEvidence No dependency. Tag files (all platforms):
Enabled

Executables (Windows
only): Disabled

InstallAnywhereEvidence None Enabled
InstallShieldMultiplatformEvidence None Enabled
UnixHardwareData Required Disabled
WindowsLastLoggedOnUser None Enabled

The patterns are written in the BMC Discovery Pattern Language (TPL), for which documentation is available at
http://discovery.bmc.com/confluence/display/90/The+Pattern+Language+TPL.

For a summary of the patterns to help decide which ones to enable or disable for your enterprise, see Optional
Patterns. The following sections go into more detail about each of the patterns.

D Note: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, the optional patterns
listed above do not provide enough detail about processors to allow management of points-based licenses for IBM
and Oracle based on data collected through BMC Discovery. If you need this capability through BMC ADDM (up to
release 11.0), ask your Flexera consultant to request additional optional patterns for you. Notice that for BMC Atrium
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Discovery and Dependency Mapping release 11.1 or later, the additional pattern is deprecated. BMC Discovery 11.1
(and later) has improved processor information collection which makes this additional pattern unnecessary.

FileEvidence

Some applications cannot be recognized by installer package information alone. It is sometimes necessary to examine
files that form part of the software installation, for either of two reasons:

« Some files are intended to provide identification details about an application, sometimes in human-readable

formats

» Examining executable files installed with the application may help with identification, even though this is not their

primary purpose.

Of the first class, identification files may take various forms. For example, many IBM applications are correctly
identified by specific files that IBM installs for this purpose. Oracle and Adobe are among other publishers using specific
files to identify some applications. Thus the Application Recognition Library (ARL) requires this file information to
correctly identify such applications. ISO/IEC 19770-2 SWID tags are also increasingly available, and these ID tags are
another useful form of identification file. The BMC Discovery Inventory Agent by default does not capture the complete
set of identity files.

Secondly, in addition to gathering those specific files that identify an application (and have no other function in the
application), it is sometimes necessary to identify installed executable files that are part of the application. These may
be the only way to identify an application, such as a particular edition or version of a product. A standard
implementation of BMC Discovery does not track executable files.

With this pattern, the functionality of BMC Discovery is extended to gather identification (tag) files on all platforms, and
executable file evidence on Windows platforms. Note that the pattern does not search network shares or NFS mounts;
nor does it follow symlinks (because of the risk of self-referencing loops). It also skips any files or folders that are
inaccessible. Within these constraints, it provides details of files matching the specification and found within the
defined paths on the local file system.

|_b Important: Enabling and configuring the tracking of executables within this pattern should be handled with skill and
care, for two reasons:

« Tracking Windows executables using BMC Discovery is slow. It may be unacceptably slow to use for a wide range of
directories, and you may require very targeted inventory gathering using this facility.

 Tracking executable files can produce a very large data set. Across large Windows server farms, the number of
installation records can quickly run even into the millions, which may comprise a stress test for BMC Discovery
implementations and concentrators, and (to a slightly lesser extent) for your FlexNet Manager Suite

implementation.

=

I== Note: In FlexNet Manager Suite, you can use file evidence to track the usage of an application (perhaps with a view to
reclaiming under-used licenses). While that functionality requires you to identify a watch-list of at least one
executable file for each tracked application, file evidence alone is not sufficient for usage tracking: it also requires
additional FlexNet agents on the managed device, and an upload path through inventory beacons that preserve the

additional usage data. File evidence gathered through the BMC Discovery adaptor is not sufficient for usage tracking.
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Results

The file evidence gathered on Windows servers is somewhat richer than on UNIX-based servers.

« On both platforms, the pattern first collects the target directories from the pattern configuration file (under
Flexera.FNMP.InventoryRawData.FileEvidenceConfigs).

« Inthe specified folders and their subfolders, the pattern retrieves:

o Allfiles with extensions listed under File extensions to report as tag files (assuming that Report software tag
files has its default value of true). For each matching file found, BMC Discovery creates a Detail node linked to

the host record. This happens for both Windows and UNIX-based systems.

o On Windows only, and only when the setting for Report executable files on Windows platforms has been
changed to true, files with a . exe extension from the same paths. For each executable file found, by default a WMI
query is used to retrieve the file’s name, version, and manufacturer. ADiscoveredWMI node in BMC Discovery is
created for each WMI query (essentially for each file). However, because DiscoveredWMI nodes are ephemeral
(may not survive future inventory gathering), the information is duplicated into a Detail node under the host

server for each file discovered there.

By the appropriate means, then, aDetail node is created for each file evidence record, with the following properties
dependent on the collection method:

Property Value Notes

name File path and name

type FNMP_FileEvidence

size File size

key A unique key for this file, combining the values of

name/type/host. key

version The release number of the file Available only on Windows servers when
executables are tracked.

company The publisher of the application of which this file Available only on Windows servers when
forms a part executables are tracked.
Configuration

Inthe FileEvidence pattern, you may:

o Separately enable or disable collection of:
o Identity tag files
o Executable files (remember to consider the potential volume of data for this option)
« Identify the file name extensions for tag files (but there is no need to identify executable file name extensions)

« Separately for Windows and UNIX-like hosts, specify the starting point(s) in the file systems for inventory scanning to
begin (searches recurse through local subdirectories).
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R' Important: The BMC Discovery inventory agent stops scanning at partition boundaries, even those on the local file

system. This has important implications on systems, such as IBM AlX, that typically mount key paths like /opt on
separate partitions. You must specify a search starting point within each target partition on the file system. For
example, the default values of /opt, /var, and /usr are well suited for inventory gathering with BMC Discovery.

All configuration items are covered in the following procedure.

To configure the FileEvidence pattern

10.

. Inthe user interface for BMC Discovery, select the Discovery tab.

. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of

its member patterns can operate.)

From the Pattern Package properties, select the link for the Pattern Module.

. Scroll down to the Pattern Configuration area.

. Inthe FileEvidence group, click Edit Configuration.

Select the appropriate true/false radio button for Report software tag files. If you are turning off the collection
of tag files, skip the next step.

Adjust the list of File extensions to report as tag files, if necessary deleting values or adding new ones that you
have identified. Each extension must stand alone on its own line.

Select the appropriate true/false radio button for Report executable files. Review the discussion before this
procedure while considering the data quantities implied by enabling this option.

If you have now turned off both options, so that both options now have False selected, you have completed the
process, and may skip the next step. If either option has True selected, continue to define the paths for the
inventory gathering.

The configuration changes are saved.

For both types of operating system, customize the ...scan these file paths for evidence list.
« Each file path must stand alone on its own line, and must be absolute (starting from root).
o For Windows, the path must include the drive letter with its colon delimiter.

o These same paths are scanned for identity (tag) files and for executable files.

Click Apply (at the bottom of this group).

The configuration changes are saved.

InstallAnywhereEvidence

InstallAnywhere is a package installation solution developed by Flexera. Packages track their installation status in an
XML file, which is interrogated by this pattern.
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After collection of the inventory data, a Detail node is linked to the host computer for each package installed on the

computer:
name The name of the application as identified by InstallAnywhere.
type FNMP_InstallerEvidence
vendor The publisher of the application
version The release number of the application.
install_date The date that the application was installed on this host computer.
evidence IA (fixed string literal).
key A unique key for this installation record, combining (with the different literal text

separators shown) the values of name : version/type:evidence/host. key

To configure the InstallAnywhereEvidence pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item isenabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

I{r Tip: The Instal LAnywhereEvidence pattern is enabled by default when the pattern collection is initially
enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. Inthe InstallAnywhereEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallAnywhere.

7. Click Apply (at the bottom of this group).

InstallShieldMultiplatformEvidence

InstallShield Multiplatform is an older packaging solution from Flexera, in use by many software publishers.
InstallShield stores software information in “vital product data” (VPD) collections, which were originally stored in flat
files and subsequently in SQL scripts.

This pattern locates either format of VPD storage (which may exist in a range of locations across different platforms),
extracts the data, and creates a Detail node for the software installation linked to the host computer:

Property Value

name The name of the application as identified by InstallShield.
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type FNMP_InstallerEvidence
vendor The publisher of the application
version The release number of the application.

install_date The date thatthe application was installed on this host computer.
evidence ISMP (fixed string literal).
product_code The product identification code recorded (usually) by the publisher for the particular application.

This is not standardized and may be used as the publisher desires.

key A unique key for this installation record, combining (with the different literal text separators shown)
the values of name : version/type:evidence/host. key
To configure the InstallShieldMultiplatformEvidence pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData itemisenabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

i
W Tip: The InstallShieldMutiplatformEvidence pattern is enabled by default when the pattern

collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this
procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the InstallShieldMultiplatformEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallShield Multiplatform.

7. Click Apply (at the bottom of this group).

UnixHardwareData

Especially for managing the corporate Data Centre, it is critical for FlexNet Manager Suite to have accurate hardware
inventory for capacity-based license metrics (Processor, Core, IBM PVU, and so on). While BMC Discovery can capture
this information for a Windows server, it may not consistently capture it for servers running UNIX or Linux. For example,
BMC Discovery does not currently report:

e CPUs and cores on Linux, nor cores on virtual machines
¢ LPARs on IBM AIX (correctly)
» Solaris resource pools.

This pattern retrieves hardware data on UNIX-based systems using the FlexNet inventory agent.
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D Note: The pattern must be configured with the installed location of the agent. The agent may be installed either in
the same location on the file system of each target UNIX server, or on a file share accessible to all target devices. This
is included in the configuration process described below.

It executes the inventory agent, which writes the collected data to a file in the /var/tmp/flexera/addm/ folder on
the host server. BMC Discovery then reads this output, and for each installed file, creates a Detail node linked to the

host record:

Name FNMP hardware evidence for %host.name%
Type FNMP_HardwareEvidence
Key %type%/%host.key%
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Property Value

(Additional Each records one of the following hardware properties:
properties)

o Disksize

« IPAddress

» MAC Address

« Model

o Number of cores

o Number of disks

o Number of logical processors

e Number of processors

« OS

e Processor speed

* Processor type

¢ RAM (total physical memory)

» Vendor.

If the machine is found to be a virtual machine, the following additional properties are
collected:

« Node capacity

» Node capacity in cores

» Node capacity in threads

» Physical shared pool capacity
o Physical shared pool capacity in cores
» Physical shared pool ID

o Shared pool capacity

» Shared pool capacity in cores
» Shared pool ID

* VM capacity

» VM capacity in cores

* VM entitlement

« VMID
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Property Value

e VMis capped
» VMisshared type
e VMname

¢ VMtype

To configure the UnixHardware pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData itemisenabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.

5. In the Flexera.FNMP.InventoryRawData.CommonFlexeralnventoryAgentConfigs group, click Edit
Configuration.

6. Enter the path (only, not including the file name) to the inventory agent executable. (For details about installing
the FlexNet inventory agent, see Installing the FlexNet inventory agent.)

7. Click Apply (at the bottom of this group).
8. Inthe UnixHardware group, click Edit Configuration.
9. Select the True radio button for Report UNIX hardware properties.

10. Click Apply (at the bottom of this group).

WindowsLastLoggedOnUser

For a Windows-based computer, standard BMC Discovery collection does not capture any inventory related to the
Windows Logon. User identification is important for FlexNet Manager Suite to accurately calculate license consumption
for user-based licensed, such as a Named User license. (There is no equivalent data for UNIX-like systems available
through the BMC Discovery adapter.)

This pattern queries the registry at HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Authentication\
LogonUI\LastLoggedOnUser to find the last logged-on user (for legacy Windows platforms before Vista, it queries
WMI for the value of UserName from Win32_ComputerSystem). If the query is successful, a
DiscoveredRegistryValue node is created for the host computer:

Property Value

Name The user name.

Type FNMP_LastLoggedOnUser
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Property Value

Key %type%/%host.key%

To configure the WindowsLastLoggedOnUser pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of

its member patterns can operate.)

I:- Tip: The WindowsLastLoggedOnUser pattern is enabled by default when the pattern collection is initially
enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. Inthe WindowsLastLoggedOnUser group, click Edit Configuration.

6. Select the True radio button for Report Windows last logged-on user.

7. Click Apply (at the bottom of this group).
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Appendix B: Data Mappings

This appendix maps the data transformations from BMC Discovery to FlexNet Manager Suite in two stages:

« From the source nodes in BMC Discovery datastore to the staging database (suggested: ADDM_Stage). The data
constructs within this database are mirrored in the XML files that may be saved on the staging server for your
inspection. For this reason, this section may also be used as a guide to understanding the sources of data within BMC

Discovery that populate the various XML entities.

« From the staging database (suggested: ADDM_Stage) to the final destination within the web interface of FlexNet
Manager Suite. This is not a simple and direct path: the ComplianceReader component first loads the data from the
staging database to various compliance database tables with names starting with Imported, where the data waits
until the next "data import" (usually associated with a full license consumption calculation, by default scheduled
overnight). In effect, the data first moves from remote staging tables to local staging tables. Thereafter the data is
normalized and loaded into a range of compliance database tables, for the most part arrayed around the
ComplianceComputer table. Since navigating these tables is not straight-forward, we here present the data in its
more visible form, within the web interface. Serious devotees of database structures can find all compliance database
tables documented in the FlexNet Manager Suite Schema Reference PDF file, available through the title page of online

help.

In both parts, each destination has its own topic, so that you can jump to destination names using the table of contents
of this PDF (in the first of these sections, the destinations are table names within the staging database; and in the
second, the destinations are "object" names presented in the web interface).

Because an individual node in BMC Discovery may link to multiple staging tables, it's not quite so easy to find the
original nodes in BMC Discovery. One way is to do a search in the PDF file for "SEARCH nodeName", since each staging
database topic begins with the Query Language statements used to extract the related data from BMC Discovery.

Source to Staging

This section provides:

» The Query Language queries exercised against BMC Discovery to extract data

« Thetables in the staging database, and within each table the individual properties (database columns), where the
data is staged.
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For each table topic, the following details are included:

o The source alias (usually identical to the following)
o The property/column name in the staging table
» The data typein the staging table

« For string types, the maximum number of characters (except as noted, excess string length is truncated).

Each topic also notes the name of the XML file that may be saved on the staging server (depending on the command

line given to the staging tool).

[ L3 L3
ADDMVersion_ci (Staging Table)
Data in this staging table may also be saved in ADDMVersion.xml on the staging server.

BMC Discovery query

This query extracts the version information for BMC Discovery, saving the details in the table below:

LOOKUP Version

Mapping into ADDMVersion_ci

Source alias ADDMVersion_ci property Type Max
Version Version varchar 32
Release Release varchar 32
Release Name Release Name varchar 32

Cluster_ci (Staging Table)

Data in this staging table may also be saved in Cluster.xml on the staging server.

BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for

properties referenced in the table below:

SEARCH Cluster

SHOW

key AS 'ClusterKey',

type AS 'ClusterType',

(type = 'vCenter Cluster' AND
(single(#ManagedElement:Management:Manager:SoftwareInstance.instance)

+ "|" + id)

OR NONE) AS 'Internalldentifier',
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(cluster_name OR name) AS 'InternalName',

single(#HostContainer:HostContainment:ContainedHost:Host.domain)
AS 'Domain’,

formatTime(modified(#), "%FT%T") AS 'LastUpdate’

Mapping into Cluster_ci

Source alias Cluster_ci property Type Max
ClusterKey ClusterKey nvarchar 400
ClusterType ClusterType nvarchar 255
Domain Domain nvarchar 512

Internalldentifier Internalldentifier nvarchar 512
InternalName InternalName nvarchar 512

LastUpdate LastUpdate datetime

ClusterHost_ci (Staging Table)

Data in this staging table may also be saved in ClusterHost.xml on the staging server.

BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Cluster
WHERE (NODECOUNT
(TRAVERSE HostContainer:HostContainment:ContainedHost:Host) > @)
SHOW
key AS 'ClusterKey',
EXPLODE #HostContainer:HostContainment:ContainedHost:Host.key
AS 'HostKey'

Mapping into ClusterHost_ci

Source alias ClusterHost_ci property Type Max
ClusterKey ClusterKey nvarchar 400
HostKey HostKey varchar 64
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CPUinformationDetail_ci (Staging Table)

Data in this staging table may also be saved in CPUInformationDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below.
.
= Tip: This data relies on a custom CPU pattern available through your Flexera consultant. Be aware that from BMC
Discovery release 11.1, BMC provided improved data gathering with new ProcessorInfo functionality. However,

this does not gather the full dataset enabled through the custom pattern, and it remains best practice to combine
the data gathered by BMC Discovery with additional data available through the custom pattern.

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)
AND (type = 'CPU Information')
SHOW
host_partitioning_type AS ‘'HostType',
(
(host_partitioning type = 'physical' AND total_logical cpus
OR allocated_threads) OR none
) AS 'LogicalProcessors',
(
(host_partitioning type = 'physical' AND total_cpu_cores
OR involved_cores) OR none
) AS 'Cores’,
(
(host_partitioning_type = 'physical' AND total_cpu_sockets
OR involved_sockets) OR none
) AS 'Processors',
(total_logical cpus OR none) AS 'PhysicallogicalProcessors’,
(total_cpu_cores OR none) AS 'PhysicalCores’,
(total_cpu_sockets OR none) AS 'PhysicalProcessors’,
zone_pool name AS 'ZonePoolName',
lpar_id_to_partition AS 'LPARIdToPartition’,
lpar_id_to_system AS 'LPARIdToSystem',
(
(lpar_partition_number <> '-' AND lpar_partition_number) OR none
) AS 'LPARPartitionNumber’,
lpar_partition_name AS 'LPARPartitionName’,
lpar_type AS 'LPARType',
lpar_mode AS 'LPARMode’,
(lpar_active_physical_cpus_in_system OR none)
AS 'LPARActivePhysicalCpusInSystem',
(lpar_shared_physical cpus_in_system OR none)
AS 'LPARSharedPhysicalCpusInSystem',
((1lpar_shared_pool_id <> '-' AND lpar_shared_pool _id) OR none)
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AS 'LPARSharedPoolID',
(lpar_active_cpus_in_pool OR none) AS 'LPARActiveCpusInPool’,
(lpar_entitled_capacity OR none) AS 'LPAREntitledCapacity’,

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into CPUInformationDetail_ci

Source alias CPUlInformationDetail_ci property Type

Cores Cores int

HostKey HostKey varchar 64
HostType HostType varchar 32
LogicalProcessors LogicalProcessors int
LPARActiveCpusInPool LPARActiveCpusInPool int
LPARActivePhysical LPARActivePhysical int

CpusInSystem CpusInSystem

LPAREntitledCapacity LPAREntitledCapacity float
LPARIdToPartition LPARIdToPartition nvarchar 200
LPARIdToSystem LPARIdToSystem nvarchar 200
LPARMode LPARMode nvarchar 255
LPARPartitionName LPARPartitionName nvarchar 255
LPARPartitionNumber LPARPartitionNumber int
LPARSharedPhysical LPARSharedPhysical int

CpusInSystem CpusInSystem

LPARSharedPoolID LPARSharedPoolID int

LPARType LPARType nvarchar 255
PhysicalCores PhysicalCores int
PhysicallLogicalProcessors PhysicallogicalProcessors int
PhysicalProcessors PhysicalProcessors int

Processors Processors int

ZonePoolName ZonePoolName nvarchar 200

DiscoveredPackages_ci (Staging Table)

Data in this staging table may also be saved in DiscoveredPackages.xml on the staging server.
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BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Host
STEP IN Host:HostedSoftware:InstalledSoftware:Package
SHOW
#:InstalledSoftware:Package.name AS 'Name',
#:InstalledSoftware:Package.version AS 'Version',
#:InstalledSoftware:Package.vendor AS 'Vendor',
#:Host:Host.key as 'HostKey'

Mapping into DiscoveredPackages_ci

Source alias DiscoveredPackages_ci property Type

HostKey HostKey varchar 64
Name Package nvarchar 255
Vendor Vendor nvarchar 255
Version Version nvarchar 255

DiscoveredService_ci (Staging Table)

Data in this staging table may also be saved in DiscoveredService.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Host
TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess
WHERE end_state = 'GoodAccess'
TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:Servicelist
TRAVERSE List:List:Member:DiscoveredService
WHERE name = 'vmms' AND display _name = 'Hyper-V Virtual Machine Management'
SHOW
name AS ‘Name',
#Member:List:List:Servicelist.#DiscoveryResult:DiscoveryAccessResult:
DiscoveryAccess:DiscoveryAccess.#Associate:Inference:
InferredElement:Host.key AS 'HostKey'

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 59



Appendix B: Data Mappings

Mapping into DiscoveredService_ci

Source alias DiscoveredService_ci property Type Max
HostKey HostKey varchar 64
Name Name nvarchar 255

DiscoveredVirtualMachine_ci (Staging Table)

Data in this staging table may also be saved in DiscoveredVirtualMachine.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Host
TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess
WHERE end_state = 'GoodAccess'
TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:VirtualMachinelist
WHERE access_method IS DEFINED
TRAVERSE List:List:Member:DiscoveredVirtualMachine
SHOW
name AS 'Name',
uuid AS 'UUID',
config _os_full AS 'ConfigOSFull’,
power_state AS 'PowerState’,
vsphere_id AS 'vSpherelD',
#Member:List:List:VirtualMachinelList.access_method AS 'AccessMethod',
formatTime(modified(#), "%FT%T") AS 'LastUpdate',
#Member:List:List:VirtualMachinelList.#DiscoveryResult:DiscoveryAccessResult:
DiscoveryAccess:DiscoveryAccess.#Associate:
Inference:InferredElement:Host.key AS 'HostKey'

Mapping into DiscoveredVirtualMachine_ci

Source alias DiscoveredVirtualMachine_ci

property
AccessMethod AccessMethod nvarchar 255
ConfigOSFull ConfigOSFull nvarchar 512
HostKey HostKey varchar 64
LastUpdate LastUpdate datetime
Name Name nvarchar 512
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Source alias DiscoveredVirtualMachine_ci

property
PowerState PowerState nvarchar 255
uuIiD Uuib nvarchar 255
vSphereID vSphereID nvarchar 255

FileEvidenceDetail_ci (Staging Table)

Data in this staging table may also be saved in FileEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)
AND (type = 'FNMP_FileEvidence')

SHOW name AS 'FileName',

size AS 'FileSize',

description AS 'Description’,

company AS 'Company’,

version AS 'FileVersion',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into FileEvidenceDetail_ci

Source alias FileEvidenceDetail_ci property Type Max
Company Company nvarchar 255
Description Description nvarchar 255
FileName FileName nvarchar 800
FileSize FileSize bigint
FileVersion FileVersion nvarchar 255
HostKey HostKey varchar 64

FileSystem_ci (Staging Table)

Data in this staging table may also be saved in FileSystem.xml on the staging server.
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BMC Discovery query

This query extracts data from the FileSystem node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH FileSystem
WHERE (NODECOUNT
(TRAVERSE MountedFileSystem:FileSystemMount:Mounter:Host) > 0)

AND fs_kind = 'LOCAL'

AND size IS DEFINED

AND size > @

AND fs_type <> 'tmpfs'

AND fs_type <> 'devtmpfs'

AND fs_type <> 'DevFS'

SHOW

fs_name AS ‘'Name’,

size AS 'Size’,
#MountedFileSystem:FileSystemMount:Mounter:Host.key AS 'HostKey'

Mapping into FileSystem_ci

Source alias FileSystem_ci property Type Max
HostKey HostKey varchar 64
Name Name nvarchar 255
Size Size bigint

HardwareEvidenceDetail_ci (Staging Table)

Data in this staging table may also be saved in HardwareEvidenceDetail.xml on the staging server.

This data is generated through use of the optional UnixHardwareData pattern, which triggers the Flexera inventory
component ndtrack ("the tracker"). Before staging, the information is visible in the Detail node of BMC Discovery,
with a type of FNMP_HardwareEvidence.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > ©)
AND (type = 'FNMP_HardwareEvidence')
SHOW
os AS '0S',
num_processors AS 'Processors’',
num_cores AS 'Cores',

62 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Appendix B: Data Mappings

num_logical processors AS ‘'LogicalProcessors’,
processor_type AS 'ProcessorType’,
processor_speed AS 'ProcessorSpeed’,
ram AS 'RAM',
vendor AS 'Vendor',
model AS 'Model’,
ip_address AS 'IPAddress',
mac_address AS 'MACAddress’,
num_disks AS ‘NumDisks',
disk_size AS 'DiskSize',
vm_type AS 'VMType',
node_capacity AS 'NodeCapacity’,
node_capacity_in_cores AS 'NodeCapacityInCores’,
node_capacity_in_threads AS 'NodeCapacityInThreads’,
physical shared_pool_capacity AS 'PhysicalSharedPoolCapacity"’,
physical_shared_pool capacity_in_cores

AS 'PhysicalSharedPoolCapacityInCores’,
physical_shared_pool_id AS 'PhysicalSharedPoolID’,
shared_pool_capacity AS 'SharedPoolCapacity’,
shared_pool capacity_in_cores AS 'SharedPoolCapacityInCores’,
shared_pool_id AS 'SharedPoolID’,
vm_capacity AS 'VMCapacity',
vm_capacity in_cores AS 'VMCapacityInCores',
vm_entitlement AS 'VMEntitlement',
vm_id AS 'VMID',
vm_is_capped AS 'VMIsCapped',
vm_is_shared_type AS 'VMIsSharedType',
vm_name AS 'VMName',
partition_id AS 'PartitionID',
partition_number AS 'PartitionNumber',
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into HardwareEvidenceDetail_ci

HardwareEvidenceDetail_ci

Source alias

property

Cores Cores smallint

DiskSize DiskSize bigint

HostKey HostKey varchar 64
IPAddress IP nvarchar 512
LogicalProcessors LogicalProcessors smallint
MACAddress MAC nvarchar 512
Model Model nvarchar 512
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Source alias

NodeCapacity
NodeCapacityInCores
NodeCapacityInThreads
NumDisks

0s

PartitionID
PartitionNumber

PhysicalShared
PoolCapacity

PhysicalSharedPool
CapacityInCores

PhysicalSharedPoolID
Processors

ProcessorSpeed
PhysicallogicalProcessors
ProcessorType

RAM

SharedPoolCapacity
SharedPoolCapacityInCores
SharedPoolID

Vendor

VMCapacity
VMCapacityInCores
VMEntitlement

VMID

VMIsCapped
VMIsSharedType

VMName

VMType

64

HardwareEvidenceDetail_ci

property

NodeCapacity
NodeCapacityInCores
NodeCapacityInThreads
NumDisks

0s

PartitionID
PartitionNumber

PhysicalShared
PoolCapacity

PhysicalSharedPool
CapacityInCores

PhysicalSharedPoolID
Processors

ProcessorSpeed
PhysicallogicalProcessors
ProcessorType

RAM

SharedPoolCapacity
SharedPoolCapacityInCores
SharedPoolID

Vendor

VMCapacity
VMCapacityInCores
VMEntitlement

VMID

VMIsCapped

VMIsSharedType

VMName

VMType
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smallint
smallint
smallint
int

nvarchar
nvarchar
int

smallint

smallint

nvarchar
smallint
int

int
nvarchar
bigint
smallint
smallint
nvarchar
nvarchar
float
float
float
nvarchar
bit

bit
nvarchar

nvarchar

256

512

255

128

255

255

255

512

128



Host_ci (Staging Table)

Data in this staging table may also be saved in Host . xml on the staging server.

BMC Discovery query

Appendix B: Data Mappings

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below.

-
= Tip: The following properties are recent additions to BMC Discovery:

e num_cores is available from BMC Discovery release 11.0

e zone_pool_name is available from BMC Discovery release 11.1.

SEARCH Host

SHOW

hostname AS 'Hostname',

(dns_domain OR domain) AS 'Domain‘',
os AS '0S',

os_type AS 'OSType',

os_class AS 'OSClass’,

service_pack AS 'ServicePack',

uuid AS 'UUID',

(

num_processors

OR nodecount(traverse Host:Detail:Hardware:ProcessorInfo)

) AS 'Processors’,
(
num_cores
OR ((num_processors > © AND cores_per_processor > 0)
AND (num_processors * cores_per_processor))

OR ((num_logical_processors > © AND threads_per_core > 0)

AND (num_logical_processors/threads_per_core))
OR none
) AS 'Cores’,
num_logical processors AS ‘'LogicalProcessors’,
processor_type AS 'ProcessorType’,
processor_speed AS 'ProcessorSpeed’,
ram AS 'RAM',
vendor AS 'Vendor',
model AS 'Model’,
serial AS 'Serial’,
hostid AS 'HostID',
partition_id AS 'PartitionID’,
1par_name AS 'LPARName',
lpar_partition_number AS 'LPARNumber',
wparid AS 'WPARID',
npar_partition_number AS 'NPARNumber’,
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vpar_partition_number AS 'VPARNumber',
ldom_name AS 'LDOMName’,
ldom_role AS 'LDOMRole’,
zonename AS 'Zonename',
zone_uuid AS 'ZoneUUID',
(zone_pool name OR none) AS 'ZonePoolName',

formatTime(modified(#), "%FT%T") as 'ModifiedDate’,
key AS 'HostKey

Mapping into Host_ci

Source alias
Cores
Domain
HostID
HostKey
Hostname
LDOMName

LDOMRole

LogicalProcessors

LPARName
LPARNumber
Model
ModifiedDate
NPARNumber

0s

0SClass
OSType
PartitionID
Processors
ProcessorSpeed
ProcessorType
RAM

Serial

66

Host_ci property
Cores

Domain

HostID
HostKey
Hostname
LDOMName

LDOMRole

LogicalProcessors

LPARName
LPARNumber
Model
ModifiedDate
NPARNumber

0s

0SClass
OSType
PartitionID
Processors
ProcessorSpeed
ProcessorType
RAM

Serial

Type
smallint
nvarchar
nvarchar
varchar
nvarchar
nvarchar
nvarchar
smallint
nvarchar
int
nvarchar
datetime
nvarchar
nvarchar
nvarchar
nvarchar
nvarchar
smallint
int
nvarchar
bigint

nvarchar

Max

255

255

64

255

255

255

255

512

64

1024

64

255

255

128

255
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Source alias Host_ci property Type Max
ServicePack ServicePack nvarchar 128
uuID UuIiD nvarchar 255
Vendor Vendor nvarchar 255
VPARNumber VPARNumber nvarchar 64
WPARID WPARID int

Zonename Zonename nvarchar 255
ZonePoolName ZonePoolName nvarchar 255
ZoneUUID ZoneUUID nvarchar 255

HostContainerProcessorinfo_ci (Staging Table)

This data is available only from ADDM 11.0 and later releases.

Data in this staging table may also be saved in HostContainerProcessorInfo.xml on the staging server.

BMC Discovery query

This query extracts data from the ProcessorInfo node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH ProcessorInfo
WHERE NODECOUNT (TRAVERSE Hardware:Detail:HostContainer:HostContainer) > ©
SHOW

#Hardware:Detail:HostContainer:HostContainer.num_logical_processors
AS ‘'LogicalProcessors’,

#Hardware:Detail :HostContainer:HostContainer.num_cores AS 'Cores’,

#Hardware:Detail :HostContainer:HostContainer.num_processors
AS 'Processors',

EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:
HostContainment:ContainedHost:Host.#InferredElement:Inference:Associate:
DiscoveryAccess.#DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:
HostInfo.systemid AS 'SystemID',

EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:
HostContainment:ContainedHost:Host.hostid AS 'HostID',

#Hardware:Detail:HostContainer:HostContainer.#HostContainer:HostContainment:
ContainedHost:Host.vendor AS 'Vendor'
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Mapping into HostContainerProcessorinfo_ci

Source alias HostContainerProcessorinfo_ci
property

Cores Cores smallint

HostID HostID nvarchar 255
LogicalProcessors LogicalProcessors smallint
Processors Processors smallint

SystemID SystemID nvarchar 255
Vendor Vendor nvarchar 255

HostDetail_ci (Staging Table)

This data is available only from BMC Discovery 11.1 and later releases. The latest Technology Knowledge Update must
be applied to the BMC Discovery 11.1 release.

Data in this staging table may also be saved in HostDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE type = 'LPAR Resource’
SHOW
id_to_partition as 'LPARIdToPartition',
id_to_system as 'LPARIdToSystem',
#Detail:Detail:ElementWithDetail:Host.key as 'HostKey'

Mapping into HostDetail_ci

Source alias HostDetail_ci property Type Max
HostKey HostKey varchar 64
LPARIdToPartition LPARIdToPartition nvarchar 200

LPARIdToSystem LPARIdToSystem nvarchar 200

Hostinfo_ci (Staging Table)

Data in this staging table may also be saved in HostInfo.xml on the staging server.
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BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Host

TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:HostInfo

WHERE NODECOUNT (TRAVERSE Primary:Inference:InferredElement:Host) > @

SHOW

systemid AS 'SystemID',

lpar_partition_number AS 'LPARPartitionNumber',

lpar_partition_name AS 'LPARPartitionName’,

lpar_type AS 'LPARType',

lpar_mode AS 'LPARMode’,

lpar_active_physical cpus_in_system AS 'LPARActivePhysicalCpusInSystem®,

lpar_shared_physical cpus_in_system AS 'LPARSharedPhysicalCpusInSystem',

lpar_shared_pool_id AS 'LPARSharedPoolID’,

lpar_active_cpus_in_pool AS 'LPARActiveCpusInPool’,

lpar_entitled_capacity AS 'LPAREntitledCapacity’,

formatTime (#DiscoveryResult:DiscoveryAccessResult:DiscoveryAccess:
DiscoveryAccess.starttime, "%FT%T") as 'InventoryDate',

#Primary:Inference:InferredElement:Host.key AS 'HostKey'

Mapping into HostInfo_ci

Source alias HostInfo_ci property Type Max
HostKey HostKey varchar 64
InventoryDate InventoryDate datetime

LPARActiveCpusInPool LPARActiveCpusInPool int

LPARActivePhysical LPARActivePhysical int
CpusInSystem CpusInSystem

LPAREntitledCapacity LPAREntitledCapacity float

LPARMode LPARMode nvarchar 255
LPARPartitionName LPARPartitionName nvarchar 255
LPARPartitionNumber  LPARPartitionNumber int

LPARSharedPhysical LPARSharedPhysical int

CpusInSystem CpusInSystem
LPARSharedPoolID LPARSharedPoolID int
LPARType LPARType nvarchar 255
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Source alias HostInfo_ci property Type Max

SystemID SystemID nvarchar 255

InstallerEvidenceDetail_ci (Staging Table)

Data in this staging table may also be saved in InstallerEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 9)
AND (type = 'FNMP_InstallerEvidence')
SHOW name AS ‘Name',
version AS 'Version',
vendor AS 'Vendor',
install_date AS 'InstallDate',
evidence AS 'Evidence',
product_code AS 'ProductCode’,
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into InstallerEvidenceDetail_ci

Source alias InstallerEvidenceDetail_ci
property

Evidence Evidence nvarchar 64

HostKey HostKey varchar 64

InstallDate InstallDate nvarchar 255
Name Name nvarchar 512
ProductCode ProductCode nvarchar 110
Vendor Vendor nvarchar 400
Version Version nvarchar 144

LastLoggedOnUserDetail_ci (Staging Table)

Data in this staging table may also be saved in LastLoggedOnUserDetail.xml on the staging server.
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BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > ©)
AND (type = 'FNMP_LastLoggedOnUser")
SHOW name AS 'UserName',
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into LastLoggedOnUserDetail_ci

Source alias LastLoggedOnUserDetail_ci

property
HostKey HostKey varchar 64
UserName UserName nvarchar 255

Networkinterface_ci (Staging Table)

Data in this staging table may also be saved in NetworkInterface.xml on the staging server.

BMC Discovery query

This query extracts data from the NetworkInterface nodein the BMC Discovery datastore, and provides the aliases

for properties referenced in the table below:

SEARCH NetworkInterface
WHERE (NODECOUNT
(TRAVERSE InterfaceOfDevice:DevicelInterface:
DeviceWithInterface:Host) > 9)
SHOW
(ip_addr
OR (NODECOUNT(TRAVERSE InterfaceWithAddress:InterfaceAddress:
IPv4Address:IPAddress) > ©
AND fmt("%.510s", join(#InterfaceWithAddress:InterfaceAddress:
IPv4Address:IPAddress.ip_addr, ', ')))
OR "'
) AS 'IP',
mac_addr AS 'MAC',
#InterfaceOfDevice:DeviceInterface:DeviceWithInterface:Host.key
AS 'HostKey'
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Mapping into Networkinterface_ci

Source alias NetworklInterface_ci property Type Max
HostKey HostKey varchar 64

IpP IpP nvarchar 512
MAC MAC nvarchar 512

Softwarelnstance_ci (Staging Table)

Data in this staging table may also be saved in SoftwareInstance.xml on the staging server.

BMC Discovery query

This query extracts data from the SoftwareInstance node in the BMC Discovery datastore, and provides the aliases
for properties referenced in the table below:

SEARCH SoftwareInstance

WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > @)
AND vm_type IS NOT DEFINED
SHOW

type + (edition AND (' ' + edition) OR '') AS 'Name',

product_version AS 'Version',

(publisher OR single(#Element:Maintainer:Pattern:Pattern.publishers))

AS 'Publisher',
EXPLODE #RunningSoftware:HostedSoftware:Host:Host.key AS 'HostKey'

Mapping into Softwarelnstance_ci

Source alias Softwarelnstance_ci property Type Max
HostKey HostKey varchar 64

Name Name nvarchar 255
Version Version nvarchar 255
Publisher Publisher nvarchar 255

SoftwarelnstanceVirtualMachine_ci (Staging Table)

Data in this staging table may also be saved in SoftwareInstanceVirtualMachine.xml on the staging server.
BMC Discovery query

This query extracts data from the SoftwareInstance nodein the BMC Discovery datastore, and provides the aliases
for properties referenced in the table below (note that the regex is wrapped for printing, and should appear all on
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one line):

SEARCH SoftwareInstance

WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > 0)
AND vm_type IS DEFINED
SHOW

vm_type AS 'VMType',

(zone_uuid OR vm_bios_serial) AS 'VMSerial',

(zonename OR vm_name) AS 'VMName',

(zoneid OR

(vm_type = 'VMware Virtual Machine'

AND extract(vm_uuid, regex "~(..) (..) (..) (..) (..) (..) (..)
-G G G Ga G )
(oo) (oo)B™s

regex "\1\2\3\4-\5\6-\7\8-\9\10-\11\12\13\14\15\16")
OR vm_uuid
)
) AS VMID,
vm_guest_os AS 'GuestFullName',
zonepath AS 'VMPath',
formatTime(last_update_success, "%FT%T") as 'LastUpdateSuccess’,
single(#HostContainer:HostContainment:ContainedHost:Host.key)
AS 'GuestHostKey"',
single(#RunningSoftware:HostedSoftware:Host:Host.key) AS 'HostKey'

Mapping into SoftwarelnstanceVirtualMachine_ci

Source alias SoftwarelnstanceVirtualMachine_ci Type
property

GuestFullName GuestFullName nvarchar 512
GuestHostKey GuestHostKey varchar 64
HostKey HostKey varchar 64
LastUpdateSuccess LastUpdateSuccess datetime

VMID VMID nvarchar 255
VMName VMName nvarchar 512
VMPath VMPath nvarchar 512
VMSerial VMSerial nvarchar 255
VMType VMType nvarchar 255

Staging to FlexNet Manager Suite

This section provides the mapping from the staging database to the final presentation in the web interface for FlexNet
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Manager Suite.

This section is organized alphabetically by object names in FlexNet Manager Suite (for example, 'computers' are known
as 'inventory devices'). This is useful when you are starting from data displayed in FlexNet Manager Suite, tracing it
back to the staging database, and then using the preceding section to see the source of that data point in BMC
Discovery.

If you are coming the other direction, it is easiest to use your PDF search tool to find the staging database table name, a
dot separator, and the property name. For example, to find out where the Hostname property from the Host_ci table
of the staging database ends up, search for Host_ci.Hostname. You will find it listed against the Name property in the
All Inventory page (and other similar listings) of the web interface .

For each object-based topic, the following details are included:

o Whether the import of new data that was not previously in the compliance database creates new records on import.

« Whether the import of changed data for records with matching key values is allowed to update the compliance
database.

¢ Whether the absence of records previously imported from only the BMC Discovery source causes the old records to
be removed from the compliance database.

o The source table and property (in dot-separated format) from the staging database. Look back to the previous
section to check data types and maximum string sizes in the staging database.

o The property name in the destination page of the web interface. Each listing is sorted alphabetically on this property
name. Where a property forms part of a compound key identifying records in the underlying compliance database, it
is appropriately marked as a partial key ("p/key").

o The data type of the property.

o For string values, the maximum length allowed in the web interface (which is also normally the maximum string
length available in compliance database). If this is less than the string length allowed in the staging database, the
string is normally truncated to length (except as noted in the comments for an individual property).

* Any general notes.

Inventory Device (Computer)

Inventory devices are (in the main) computers that have been found in imported inventory; and in the current context,
they are found in data imported from BMC Discovery. (Keep in mind that it is possible for a device to be reported in
more than one inventory source, which becomes important when you are assessing automatic deletion of records no
longer appearing in the source inventory.)

FlexNet Manager Suite correlates data from several points within BMC Discovery to create inventory device records.
For example, the main sources from lowest to highest priority are:

1. TheHostInfo node, by default populated during the discovery phrase of data gathering by BMC Discovery.
Current data is staged in the HostInfo_ci staging table; but if BMC Discovery does not inventory the target
device regularly, its information may be cleaned up and lost from this node.

2. TheHost node, which by default BMC Discovery populates with data from the HostInfo node.

3. Data (of type CPU Information) visible in the Detail node of BMC Discovery, and staged into the
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CPUInformationDetail_ci stagingtable.

l'lf-.'l
W Tip: This data depends on a custom CPU pattern available only by request (see CPUInformationDetail_ci
(Staging Table) for details).

4. The optional UnixHardwareData pattern (delivered as part of the BMC Discovery adapter). Data from this
source is also visible in the Detail node of BMC Discovery (with the type FNMP_HardwareEvidence), and is
staged in the HardwareEvidenceDetail_ci table.

Generally, after import into FlexNet Manager Suite, inventory devices are stored in the ComplianceComputer table of
the underlying compliance database.

Because inventory devices have so many properties, the following tables group their properties into smaller subsets.
Within each subset, the tables are sorted alphabetically by the Display property column.

o Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — Yes.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes.

Inventory device: Computer (general properties)

All these properties are available in listings such as the All Inventory page; and within the properties of an individual
inventory device, these all appear on the General tab.

Source table.property Display property Type Max Notes

Host_ci.Domain Domain name (p/key) String 100

Host_ci.Serial Firmware serial String 100 Visible in the General tab of the
number inventory device properties. Identifies

the firmware on the inventory device.

NetworkInterface_ci. IP address String 256

IpP

NetworkInterface_ci. MAC address String 256

MAC

Host_ci.Vendor Manufacturer String 128

Host_ci.Model Model String 128

Host_ci.Hostname Name (p/key) String 256

Host.Serial Serial number String 100 Aduplicate of Host_ci.Serial, this

time taken from the Host database

view.
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Inventory device: Hardware properties

Except as noted, these properties are available in listings such as the All Inventory page; and within the properties of
an individual inventory device, these mostly appear on the Hardware tab (where several values may be manually

overridden if the collected inventory data is inaccurate).

Source table.property Display property Type
Host_ci.ProcessorSpeed Clock speed
(MHz)
Host_ci.Cores (or Cores
CPUInformationDetail_
ci.Cores for ADDM 11.0 or earlier); or,
when the optional UnixHardwareData
pattern has been used,
HardwareEvidenceDetail ci.Cores
FileSystem_ci.Size (summed) Disk (GB)

Not applicable Display adapters

FileSystem ci. Hard drives
COUNT (HostKey)
Not applicable Inventory chassis
type
76

Max Notes

The maximum clock speed of
the fastest processor in the
computer in megahertz.

Integer

The number of cores in the
device (or, for a virtual machine,
the number of cores assigned to
the VM).

Integer

Integer AllFileSystem_ci records
with an identical HostKey are
selected from the staging
database, and their Size values
are summed and the result

converted to GB for display.

The number of display adapters
is not returned by BMC
Discovery.

Integer

Integer

String 128  After import from BMC
Discovery, this value is always
Unknown (although some
inventory tools can return the
chassis type, BMC Discovery is
not among them). The result is
only available in the property
sheet for an inventory device
(and its linked asset, if any), and
not in device listings. There is
also an Assigned chassis type
where you can correct inventory

data if required.
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Source table.property Display property Type Max Notes

NetworkInterface_ci. Network cards Integer The number of network cards in
IpP the device is not returned by BMC
(counted) Discovery. Instead, the count of

distinct IP-enabled interfaces
sharing a common HostKey is

used.
Host_ci.LogicalProcessors (or Threads Integer Saved in the
CPUInformationDetail_ci. ComplianceComputer tablein
LogicalProcessors for ADDM 11.0 or the compliance database, and
earlier); or, when the optional generally represented in the web
UnixHardwareData pattern has been interface as Threads for virtual
used, machines.
HardwareEvidenceDetail ci.Cores
Host_ci.0S Operating system String 128
Host_ci.Processors (or Processors Integer The number of processors
CPUInformationDetail_ reported in the inventory device.
ci.Processors
(for ADDM 11.0 or earlier); or, when the
optional UnixHardwareData pattern has
been used,
HardwareEvidenceDetail ci.Cores
Host_ci.ProcessorType Processor type String 256
Host_ci.RAM RAM (GB) String 128  Theimported value (in bytes) is
converted to GB for display.
Host_ci.ServicePack Service pack String 128
n/a Sockets Integer The number of sockets — a value
that is not reported by BMC
Discovery.

Inventory device: Last inventory details

These properties are available in listings such as the All Inventory page; and within the properties of an individual
inventory device, these appear on the General tab.

Source table.property Display property Type Max Notes
HostInfo_ci. Last inventory date  Date For virtual hosts, the most recent
InventoryDate inventory date for any guest system

may update this value.
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Source table.property Display property Type Max Notes
BMC Atrium Discovery and Lastinventory String 128 The string literal "BMC Atrium
Dependency Mapping source Discovery and Dependency Mapping"

is always inserted as the source value
when using this adapter.

Inventory device: User details
These properties are available in listings such as the All Inventory page; and within the properties of an individual

inventory device, these appear on the Ownership tab.

Source table.property Display property Type Max Notes

n/a Assigned user String 512 This value is set manually by an
operator in FlexNet Manager Suite.

n/a Calculated user String 512 Set automatically as the logged-on
user seen most frequently in the last 10
inventory imports.

LastLoggedOnUser Last logged onuser  String 512 This information is available only for
Detail_ci.Username (when Windows platforms, and only when
the optional pattern WindowsLastLoggedOnUser has
WindowsLastLoggedOnUser been used. On data import, if the
has been used) username cannot be matched in the

ComplianceUser table of the
compliance database, a new record is
created, and appropriately linked to
the ComplianceComputer record.

Installer Evidence

Installer evidence is a record of software installation on an inventory device. 'Normalized' installer evidence (meaning
installer evidence that includes standard string values as noted below) allows the automatic matching of the evidence
to the application that it represents, using the Application Recognition Library (ARL), frequently updated by Flexera.

« Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — No.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes (records linking
applications to inventory devices are deleted under these conditions).

Installer evidence mapping

Most of these properties are available in listings such as the Installer evidence tab of the All Evidence page; and
within the properties of an individual installer evidence record, these appear on the General tab.
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Source table.property

Host_ci.HostKey

DiscoveredPackages_
ci.Name

DiscoveredPackages_
ci.Publisher

ADDM (string literal)

DiscoveredPackages_
ci.Version

File Evidence

Display property

Not displayed. (p/key)

Name (p/key)

Publisher (p/key)

Type

Version (p/key)

Appendix B: Data Mappings

Type Max Notes

n/a

String

String

String

String

256

200

32

T2

Identifies the inventory device on
which the installer evidence was
found. This value is not displayed in
listings of, nor properties for, installer
evidence (because in those contexts,
the installer evidence may be relevant
to many different devices). However,
the link from the installer evidence to
the application, plus this link to an
individual device where the installer
evidence has been found, allows the
list of installed applications to appear
on the Applications tab of the
inventory device properties.

For recognition using the standard ARL
to work reliably, this value must be the
Display Name from Add/Remove

Programs on Windows (or equivalent).

For recognition using the standard ARL
to work reliably, this value must be the
Publisher from Add/Remove

Programs on Windows (or equivalent).

The string literal "ADDM" is supplied as
the installer evidence type for this
adapter.

For recognition using the standard ARL
to work reliably, this value must be the
Display Version from Add/Remove
Programs on Windows (or
equivalent).

File evidence consists of files found on the disk of an inventory device. 'Normalized' file evidence (meaning file
evidence that includes standard string values as noted below) allows the automatic matching of the file evidence to

the application of which it forms part, using the Application Recognition Library (ARL), frequently updated by Flexera.

« Are new records created by imports from the staging database table? — Yes.

» Can records with matching compound keys be updated by these imports? — No.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that

the staging database for BMC Discovery data is the last/only source for these records)? — Yes.
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File evidence mapping

Most of these properties are available in listings such as the File evidence tab of the All Evidence page; and within the
properties of an individual file evidence record, these appear on the General tab. (This listing is alphabetical by
Display property values.)

Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/key) n/a Identifies the inventory device on
which the file evidence was found. This
value is not displayed in listings of, nor
properties for, file evidence (because
in those contexts, the file evidence
may be relevant to many different
devices). However, once the file
evidence is linked to an application,
this link to an individual device where
the file evidence has been found may
affect the list of installed applications
that appears on the Applications tab
of the inventory device properties.

FileEvidenceDetail Company (p/key) String 100 For recognition using the standard ARL

ci.Company to work reliably, this value must be the
Company WinPE header property from
Windows executables.

FileEvidenceDetail_ Description (p/key) String 200 For recognition using the standard ARL

ci.Description to work reliably, this value must be the
Description WinPE header property
from Windows executables.

FileEvidenceDetail_ Name (in listings) or ~ String 256 For recognition using the standard ARL
ci.FileName File name (in file to work reliably, this value must be:

ewience properties) « On Windows, the file name without

e
(p/key) path
e On UNIX-like platforms, the full
absolute file path.

FileEvidenceDetail_ Size Integer
ci.FileSize
FileEvidenceDetail_ Version (p/key) String 100 For recognition using the standard ARL
ci.FileVersion to work reliably, this value must be the

File Version WinPE header
property from Windows executables.

The following extended properties of file evidence records are not populated in an BMC Discovery import:

« File path
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¢ Language
¢ Product name

« Product version.

WMI Evidence

Windows Management Instrumentation (WMI) evidence is most often customized to help recognize operating systems,
and (when the FlexNet inventory agent is in use) to help recognize aspects of special applications like Microsoft SQL
Server. 'Normalized' WMI evidence (meaning WMI evidence that includes standard string values as noted below)
allows the automatic matching of the WMI evidence to the application to which it relates, using the Application
Recognition Library (ARL), frequently updated by Flexera.

* Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — No.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes.

WMI evidence mapping

In the web interface for FlexNet Manager Suite, there is no separate listing of WMI evidence. It is only possible to see
these properties using the search facility in the WMI section of the Evidence tab of application properties. (This listing
is alphabetical by Display property values.)

Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/key) n/a Identifies the inventory device on
which the WMI evidence was found.
This value is not displayed in the
application properties Evidence tab.
However, once the WMI evidence is
linked to an application, this link to an
individual device where the WMI
evidence has been found may affect
the list of installed applications that
appears on the Applications tab of the
inventory device properties.

Caption (string literal) Property name (p/ String 50 The string literal "Caption" is inserted
key) for all WMI evidence records from BMC
Discovery.
Host_ci.OS (left-most 256 Property value (p/ String 256 For OS recognition using the standard
characters) key) ARL to work reliably, this value must be

the equivalent of the
Win32_OperatingSystem.Name
WMI property.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

81



Appendix B: Data Mappings

Source table.property Display property Type Max Notes
Host_ci.0SType converted as WMI class (p/key) String 50 The BMC Discovery data converts to
per notes. standard class types used by FlexNet

Manager Suite as follows:
e Windows becomes

Win32_OperatingSystem

e Either of VMMware ESXorVMware
ESXi becomes
VMWARE_OperatingSystem

o Any other value is replaced by
MGS_OperatingSystem.
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Microsoft App-V (full name Microsoft Application Virtualization) is an application virtualization and application streaming
solution. It allows access to applications in three different ways:

o Users may stream applications directly from a central App-V Management Server to their client computers, executing
the code locally in light virtual machines that provide a protective 'bubble' around the executing software.

o The applications may be deployed using Microsoft System Center Configuration Manager (SCCM).

» Applications may be deployed in 'stand alone' mode, such as manual delivery through file shares or on a USB stick,
without the use of any server infrastructure.

Applications delivered in any of these ways require licensing, and you can manage the appropriate licenses using FlexNet

Manager Suite:

o Applications streamed from the App-V Publishing Server(s) are monitored using the App-V server adapter supplied as a
standard part of FlexNet Manager Suite, and (for App-V release 5.0 and later) the AppVMgmtSvr. ps1 PowerShell script
installed on the App-V Management Server. Both the App-V server adapter and the AppVMgmtSvr.ps1 PowerShell

script are documented in this chapter.

o Applications deployed using Microsoft SCCM are recorded automatically as part of the standard inventory import from
SCCM.

o Applications deployed manually can be recorded manually in FlexNet Manager Suite. Manual deployment is not a
recommended best practice because of the inherent difficulties in management and demonstrating compliance, and
there is no automation possible through FlexNet direct inventory gathering to cover manual deployment.

Supported versions

The App-V server adapter supports the current version of FlexNet Manager Suite, and releases 4.6, 5.0, and 5.1 of Microsoft
Application Virtualization.

Because of significant architectural change between release 4.6 and release 5.0 of App-V, there are matching significant
differences in the App-V server adapter for the different versions. It is important to read this document carefully, noting
the differences that apply to "release 4.6" and "release 5.0 and later".
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Architecture, Components, and
Prerequisites

Following the changes that Microsoft made in the architecture of App-V between release 4.6 and release 5.0, the App-V
server adapter is also significantly different when interfacing to the different App-V releases. There are separate chapters
for each different architecture. Identify the release of Microsoft App-V in use in your enterprise, and focus on the
architecture that is appropriate to that release.

Architecture and Operation for App-V 4.6

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-
point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead
of this adapter.)

In its streaming implementation, Microsoft App-V release 4.6 has three main kinds of components:

* Adatabase (referred to here as the App-V Management Server database), which may be on a separate server

» One or more Management Servers that access the App-V Management Server database and provide a user interface
for system control

« One or more streaming servers that may directly deliver application packages.

Of these, only the App-V Management Server database is relevant to the App-V server adapter for FlexNet Manager
Suite.

Prerequisites
Operation requires that you have:
« Asupported version of Microsoft App-V (see App-V Server Adapter).

» Anoperational App-V Management Server database.

o AFlexNet inventory beacon that has network access to your App-V Management Server database, and is also able to
upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of
inventory beacons).
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e Aninventory beacon importing Active Directory data from the same domain where the App-V server resides. (This

may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

v

= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that
the Active Directory import runs against all applicable domains in your environment. The simplest approach may
well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals
from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite
imports only from each individually specified Active Directory domain; so you need to ensure that all applicable

domains are specified. As an example of multiple domains being affected:

o Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from

Domain-B.

o In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the

parent-child relationship between the groups).

o This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

o Insuch a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B.

When you have many domains, the simplest path is just to run an Active Directory import from every domain.

» Operators who can identify the applications represented by the App-V packages, and link those applications to the

appropriate licenses.

3

= Tip: You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single App-V
Management Server database. This requires only one connection from the FlexNet Manager Suite App-V server
adapter, because this connects only to the database. However, if you have multiple App-V Management Server
databases in your estate, configure a separate connection to each of them on appropriate inventory beacons. Where
helpful, you may configure multiple such connections (each separately scheduled as you choose) on one inventory

beacon.

In operation

The following diagram shows the operational architecture for the App-V server adapter for App-V release 4.6.
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The numbers here refer to the numbers shown in the diagram above:

1. Theinventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs,
are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)

o These are immediately uploaded to the central application server for FlexNet Manager Suite.
« Assoon as the upload is completed, the data is imported into the compliance database.

2. Onthe schedule you specify on the inventory beacon, the App-V adapter:
« Connects to the App-V Management Server database
o Imports a list of the App-V packages from the database, and the access control lists (ACLs) that determine which

Active Directory groups and users have access to the applications inside the packages. The latter are identified
by their security identifiers (SIDs).

« Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for
some reason, there is a catch-up upload task that by default is scheduled overnight.)

« The data waits in the staging area on the central application server for the next scheduled inventory import and
compliance calculation (by default, scheduled overnight).

3. When information about a new App-V package is first imported, an operator must identify the package and link it
(like installer evidence) to an application record. This work must be done manually because (in release 4.6) App-V
packages are opaque about the applications they contain. As well, for any meaningful calculations of
consumption, the application must be linked to a suitable license. This linking effort is required only for the first
import of each new package.

Once the links are established, each subsequent compliance calculation assigns consumption by the correct users and
computers to the appropriate (linked) license. This consumption information is then available both in the management
views and in reports.

Architecture and Operation for App-V 5 and
Later

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-
point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead
of this adapter.)

In its streaming implementation, Microsoft App-V release 5.0 (and later) has the following components, apart from the
App-V clients:

« Adatabase (referred to here as the App-V Management Server database), which may be on a separate server

« Aseparate reporting database (referred to here as the App-V reporting database), which may also be on a separate
server (importantly, this database stores application usage information)

« One or more Management Servers that access the App-V Management Server database and provide a user interface
for system control

« One or more Reporting Servers that access the App-V reporting database and provide operational reports to help
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manage the App-V infrastructure
« One or more streaming servers (called App-V Publishing Servers) that may directly deliver application packages.

Of these, for App-V 5.0 and later, only the App-V reporting database and an App-V Management Server are relevant to
the App-V server adapter for FlexNet Manager Suite. (If you are familiar with the adapter for release 4.6 of App-V, notice
that we have switched databases, and added the Management Server — the architecture is completely different.)

Prerequisites
Operation requires that you have:

» Asupported version of Microsoft App-V (see App-V Server Adapter).
» An operational App-V reporting database.
» Anoperational AppV Management Server.

e The AppVMgmtSvr.ps1 PowerShell script installed, configured and scheduled on your AppV Management Server
(see Obtaining (and Deploying) the Adapter Components for details). This is one of the significant changes since the
previous adapter.

« AFlexNet inventory beacon that has network access to your App-V reporting database, and is also able to upload
gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of inventory

beacons).

« Aninventory beacon importing Active Directory data from the same domain where the App-V server resides. (This
may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

¥
= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that

the Active Directory import runs against all applicable domains in your environment. The simplest approach may
well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals
from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite
imports only from each individually specified Active Directory domain; so you need to ensure that all applicable
domains are specified. As an example of multiple domains being affected:

o Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from
Domain-B.

o In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the
parent-child relationship between the groups).

o This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

o Insuch a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B.
When you have many domains, the simplest path is just to run an Active Directory import from every domain.

» Operators who can link the applications identified in the App-V packages to the appropriate licenses.

¥
= Tip: You need only one connection from the FlexNet Manager Suite App-V server adapter (on an inventory beacon) to

the App-V reporting database. This single App-V reporting database may support multiple App-V Management
Servers, and multiple Publishing Servers; but only a single connection to the database is required.
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Limitation

For App-V release 5.0 and later, the system supports installation of the AppvMgmtSvr. ps1 PowerShell script on only
one App-V Management Server. This single Management Server may support multiple Publishing Servers (if necessary
spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may report to
multiple Reporting Servers (independent of the source from which the App-V packages were downloaded). Different
App-V Management Servers do not self-identify in the . raa inventory file, and the App-V reporting database does not
identify which application usage information is associated with which App-V Management Server. For these reasons,
only a single App-V Management Server (for release 5.0 and later) is supported.

If your App-V (release 5.0 or later) environment has multiple Management Servers, choose one as the data source for
App-V packages and the applications they contain. For example, if you have Production, Dev, and Test servers, place
the AppVMgmtSvr.psl1 PowerShell script on the Production App-V Management Server. Also ensure that the App-V
server adapter (on an inventory beacon) connects to the matching Production App-V reporting database.

In operation

The following diagram shows the operational architecture for the App-V server adapter for release 5.0 and later.
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The numbers here refer to the numbers shown in the diagram above:

1. Theinventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs,
are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)

o These are immediately uploaded to the central application server for FlexNet Manager Suite.
« Assoon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the App-V Management Server, the AppVMgmtSvr. ps1 PowerShell script:

« Uses the API to gather a list of the available App-V packages

« Imports from the database, and the access control lists (ACLs) that determine which Active Directory groups
and users have access to the applications inside the packages. The latter are identified by their security
identifiers (SIDs)
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o Uploads the collected data in a remote application access (. raa) file to its configured inventory beacon, which

in turn uploads the file to the central application server for FlexNet Manager Suite.

« The data waits in the staging area on the central application server for the next scheduled inventory import and
compliance calculation (by default, scheduled overnight).

3. Onthe schedule you specify on the inventory beacon, the App-V adapter:

« Connects to the App-V reporting database

» Imports App-V package usage by users and computers. These are all identified by their security identifiers
(SIDs).

« Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for
some reason, there is a catch-up upload task that by default is scheduled overnight.)

o The .raafile collected by the PowerShell script is uploaded and immediately resolved into staging tables in
the database.

L
= Tip: If you manually copy an . raa file to your application server, you can import it with the following

command:

> mgsimport -t remoteApplication

o The data waits in the staging area on the central application server for the next scheduled inventory import and
compliance calculation (by default, scheduled overnight).

4. When the compliance calculation is run, FlexNet Manager Suite uses the uploaded SIDs to correlate the various
data elements:

o App-V packages are shown as installer evidence (based on the MSI information uploaded by the
AppVMgmtSvr.psl PowerShell script).

« If an appropriate application record exists (either in the Application Recognition Library or as a locally-created
record) with a suitable installer evidence rule, the installed evidence (package) is automatically matched with
the application.

o Allusers with access to an App-V package are shown as having an installation of the related application on
every computer for which the user is either the assigned or calculated user.

o All computers with access to an App-V package are shown as having an installation of the related application.

o Ifthe application is linked to a license, consumption is shown for the correct users and computers on that
license (or, if it is linked to multiple licenses, on the highest priority license still having unconsumed
entitlements). This consumption information is then available both in the management views and in reports. (If
this is the first import to reveal an application in an App-V package, an operator needs to link the application
record to an appropriate license.)
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Set Up and Operations

This chapter covers the configuration of the adapter, and the work needed to enable application recognition from the
imported inventory.

Keep clearly in mind the distinctions required for App-V release 4.6, and release 5.0 and later. For example, Obtaining
(and Deploying) the Adapter Components documents processes needed only for release 5.0 and later; and Configuring
the Adapter requires a distinct database connection in each of the cases.

Obtaining (and Deploying) the Adapter
Components

oy
U To download the adapters archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2020 R1.zip archive. One path is through the
Flexera Community:

7
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand Other Resources and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Platform,click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.

e. Inthe Latest Versions tab, click FlexNet Manager Suite 2020 R1.
A EULA page may appear. If so, accept the license, as this grants access to the list of Downloads.

f. Inthe list of available Downloads, in the File Name column, click Adapter Tools for FlexNet Manager
Suite2020 R1.
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A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2020 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....
3. Inthe extracted archive, navigate to Adapter Tools\App-V Management Server Agent\

AppVManagementServer5.

i
= Tip: As an alternative to downloading the archive again, if you still have access to the 'CD image' you

downloaded to install FlexNet Manager Suite itself on your application server(s), you can also find these files in
the unzipped installation archive under FlexNet Manager Suite\Installers\App-V Management

Server Agent\AppVManagementServers.

4. Use your preferred method to deploy the AppVMgmtSvr. ps1 PowerShell script to your App-V Management
Server.

You may install the script in your preferred folder.
5. Use your preferred task scheduling technology to schedule data collection by the PowerShell script.

Typically you want the . raa file uploaded to the central FlexNet Manager Suite operations databases before the
system import and license calculations take place. By default, this occurs daily at 2am central server time. As a
two-hour upload buffer should be more than adequate, this suggests (within a single time zone) a data collection
trigger at around midnight.

These example steps are for Windows Server 2012. Adjust as necessary for your server operating system, or your
chosen scheduling tool.

a. In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools, and
double-click Task Scheduler.

The Task Scheduler window appears.

b. Inthe navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the right,
click New Folder....

Adialog appears for entering the folder name.
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A suggested value is FlexNet Manager Suite.

. Click OK, and select the new folder in the navigation tree.

. Select Action > Create Task....

The Create Task dialog appears.

. Enter an appropriate Name, such as FlexNet Manager Agent for App-V 5.x,andaddany

Description to help future maintenance of this task.

Your description may be something like Collects App-V data from the Management Server
and uploads to an inventory beacon.

. Click Change User or Group....

The Select User, Service Account, or Group dialog appears.

. Enter the account name that is to run the scheduled task, and click OK.

An appropriate account:

e Can run a Windows scheduled task on the App-V Management Server
o Can execute the PowerShell script
« Isan App-V Management Server administrator

« May conveniently be a domain account that can upload the results (using HTTP PUT) to the inventory
beacon, although a separate account and password can be configured in the command line (required
only where that inventory beacon is using Basic Authentication — if the inventory beacon uses
anonymous authentication, ignore this requirement).

. Further down in the Security options group, select Run whether user is logged in or not.

. Switch to the Triggers tab, and click New....

The New Trigger dialog appears.

Ensure that the default setting Begin the task On a schedule is selected, set the parameters for the
schedule, and from the Advanced settings group, be sure that Enabled is selected.

The suggested schedule is daily at or before midnight local time, but be sure that this suits the upload
procedures for your enterprise.
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k. Switch to the Action tab, and click New....
The New Action dialog appears.

l. Ensure that the default Action, Start a program, is selected, and browse to your local copy of
AppVMgmtSvr.psl.

m. In the Add arguments (optional) field, specify all the command-line arguments you need for the agent.
All command line arguments are documented in Command Line for PowerShell Script. For common

implementations, you need to define only the URL to the inventory beacon.

This example uploads the . raa file to the fLexnetbeacon inventory beacon, using the credentials of the
account running the scheduled task.

. \AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon

¥
= Tip: You need to specify only the basis server in the URL, Internally, the FlexNet Beacon service

briefly saves the uploaded file to 5CommonAppData%\FlLexera Software\Incoming\
RemoteApplications before uploading the file to its parent. (If security within your enterprise
prevents the PowerShell script uploading the . raa file to a inventory beacon, you can arrange an
alternative method to save the . raa file to this folder on a convenient inventory beacon, and it is
automatically uploaded and processed from this point.)

n. Click OK.

o. Optionally, make any preferred adjustments to the Conditions or Settings tabs (normally the defaults are
acceptable).

p. Click OKto close the Create Task dialog.

The new task appears in the list of scheduled tasks for this server.
g. Right-click the new task, and click Run in the context menu.

This checks that the scheduled task completes successfully.
r. Validate operations in the following ways:

o Review the log file (by default, AppVMgmtSvr. log in the same folder as the PowerShell script) for any

errors or warning messages.

» Review the content of the output file (by default, FNMS_AppV. raa in the same folder as the
PowerShell script). This file contains the results of the most recent execution of the PowerShell script,
and is replaced at each invocation of the script. For more details of the file format, see File Format for

.raa.

o If uploaded to the inventory beacon, check for the presence of the FNMS_AppV. raa outputfile in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications on theinventory
beacon. Remember that you have only a brief time window to check this before it is uploaded to the
central application server and removed (by default, around 10 minutes).

The AppVMgmtSvr.ps1 PowerShell script is now configured on your App-V release 5.0 or later Management Server. You
can now configure the adapter itself that runs on the inventory beacon (see Configuring the Adapter).
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Command Line for PowerShell Script

The AppVMgmtSvr.ps1 PowerShell script is required only when importing inventory from Microsoft App-V release 5.0
or later. (It is not required if you are using App-V release 4.6.)

For applicable releases, AppVMgmtSvr. ps1 isinstalled on the App-V Management Server, where, on a schedule that
you determine, it collects details of the available App-V packages, and the users and computers that have access to
the packages. (Separately, usage information is collected by the App-V server adapter, with its separate configuration
described in Configuring the Adapter.)

The following options are supported, both for running AppVMgmtSvr. ps1 manually and for executing it from a
scheduled task or other scheduling tool. None of the options is mandatory, although some are required for normal
operation.

Syntax

Syntax:
AppVMgmtSvr.ps1l [options...]

Options

-beaconUrl validURL
-logFilePath Llog file
-outputFilePath output_file
-password password
-upload $true | $false
-username account

where

-beaconUrl validURL  The URL to the appropriate inventory beacon to which the script should upload the
generated . raa file. Include the protocol (HTTP or HTTPS), and if your inventory
beacon uses a non-default port, include the port number in the standard way.

=t
i ] Note: Include only the basic URL of the server. No internal paths are needed, as
these details are added automatically by AppVMgmtSvr. ps1.

There is no default value for beaconuUr1l, so that in production use (when -upload
$true), avalue must be supplied. It can be omitted for local testing on the server
when uploading is not required. If -upload $true and beaconUrl isnot set,
obviously the upload must fail.

Example values:

http://flexnetbeacon.example.com
https://flexnetbeacon.example.com:499
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-logFilePath Afile path (either absolute, or relative to the folder in which the script is executing)

log file and file name for the log file generated by AppVMgmtSvr.ps1. Enclose the pathin
double quotation marks. A file with consistent name and path over time is replaced
at each execution, containing only the results of the last execution, thus preventing
unmanaged storage requirements. When this option is not specified, the default
value is AppVMgmtSvr. log, saved in the folder where the script is executing.

-outputFilePath Afile path (either absolute, or relative to the folder in which the script is executing)

output_file and file name for the output remote application access (. raa) file generated by
AppVMgmtSvr.ps1l. Enclose the path in double quotation marks. If the same name
and path is used, the file is overwritten at each run of the script. When the option is
not specified, the default value is FNMS_AppV. raa, saved in the folder where the
script is executing.

-password "password" The password (in plain text) for the account specified in username. Omitted when
that option is not required. If specified, enclose the value in double quotation marks.
When required and not specified, the script uses details of the account running the

process.
-upload $true | A Boolean that determines whether to attempt uploading the output file to an
$false inventory beacon identified in beaconUrl. When not specified, the default is true,

requiring that beaconUr1 is specified so that the upload can succeed.

-username "account"  The account name used to upload the generated . raa file to the inventory beacon
identified in beaconUr1. This is not required for inventory beacons using
anonymous authentication. It may be specified for inventory beacons using
Windows Basic Authentication. If specified, enclose the value in double quotation
marks. When it is specified, the matching password must be provided in the
-password option. When required and not specified, the script uses details of the
account running the process.

Examples

(Examples here may be line-wrapped for convenient presentation; but should be entered on a single command line.)
Collect the inventory from the App-V Management Server, saving the file locally for inspection:

.\AppVMgmtSvr.psl -upload $false

Similarly, collect the inventory, saving the output and logs to temporary locations to avoid overwriting the normal
output:

.\AppVMgmtSvr.psl -outputFilePath "C:\temp\FNMS_AppV.raa"
-logFilePath "C:\temp\AppVMgmtSvr.log"
-upload $false

Collect the inventory, and upload it to the specified inventory beacon, using the username and password for the
account currently running the script:

.\AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon.example.com
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Upload the collected inventory to the specified inventory beacon, using the testdomain\administrator account:

.\AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon.example.com

-username "testdomain\administrator"
-password "somepassword"

File Format for .raa

The AppVMgmtSvr.ps1 PowerShell script interrogates the App-V Management Server, and saves the resulting data in

a remote application access file (filename extension . raa), by default called FNMS_AppV.raa. This is an XML file that

encapsulates data about each application's App-V package, and the MSl installer information known to App-V.

Here is an excerpt from an FNMS_AppV. raa file (here line-wrapped for presentation):

<remoteApplications accessModeID="2">

96

<app farmName=

<msiData farmName=

<app farmName=

<msiData farmName=

appID="9b0@9bcOd-9634-4838-bOba-8c256ef4710d"
appName="Blender"

appFileName=

appFileVersion=

appFilePublisher=

appFileDesc=

userSid=

serverName=
serverDomainName=""

isStreamingProfile="1" />
appID="9b09bcOd-9634-4838-bOba-8c256ef4710d"
msiDisplayName="Blender"
msiPublisher="Blender"

msiVersion="1.0"

msiProductCode="{DFFFEOC6-3E9A-44E9-9EC1-B5C92DCEE4AF}" />

appID="5d80bef6-deda-44f6-b4f8-9aa6a657880e"
appName="Filezilla 3.2.4.1 win32-setup"

appFileName=

appFileVersion=
appFilePublisher=

appFileDesc=
userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=
serverDomainName=""

isStreamingProfile="1" />
appID="5d80bef6-deda-44f6-b4f8-92a6a657880e"
msiDisplayName="Filezilla Client 3.2.4.1"
msiPublisher=""

msiVersion="3.2.4.1"
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msiProductCode="filezilla client" />
<app farmName=""

appID="02787044-d434-4e7d-8770-cda46c988de8"
appName="AdobeReader9"
appFileName=""
appFileVersion=
appFilePublisher=
appFileDesc=""
userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=

serverDomainName=
isStreamingProfile="1" />

<msiData farmName=
appID="02787044-d434-4e7d-8770-cda46c988de8"
msiDisplayName="Adobe Reader 9.1"
msiPublisher="Adobe Systems Incorporated"
msiVersion="9.1.0"
msiProductCode="{ac76ba86-7ad7-1033-7b44-a91000000001}" />

</remoteApplications>

Some points of interest to note:

o The complete set of MSI attributes needed for FlexNet Manager Suite makes use of Asset Intelligence on the App-V
release 5.0+ system, which saves a series of AssetIntelligenceProperties in the manifest file. From these

properties, AppVMgmtSvr. ps1 extracts the fourmsi. .. properties shown for the applications above.

« Not all applications deployed through App-V use MSI, as some applications use third-party installers. App-V
packages using third-party installers cannot include the Asset Intelligence properties available through MSI. For
such cases, the AppVMgmtSvr.ps1 PowerShell script interrogates the App-V application registry to get complete
installer evidence, populating the same attributes in the . raa file. (Thus the presence of
AssetIntelligenceProperties in the manifest file does not necessarily mean that Asset Intelligence was

available; but does mean that equivalent data has been obtained.)

o ThemsiDisplayName becomesthe Name property of the installer evidence record, the msiPublisher maps to
Publisher, msiVersion maps to Version. As with all installer evidence, the resulting record is matched against
installer evidence "rules" (previously-recorded installer evidence records, most often generalized with judicious use
of wild card % characters), and when matched, adds an installation count to the application linked to the rule. This
means that in listings of installer evidence, the visible entry remains the generalized rule that matched our
individual piece of installer evidence. However, the individual installer evidence record is visible by drilling down
into the properties of the inventory device on which the inventory evidence was found.

o For aworked example of how the installer evidence for the FileZilla application in the extract above is matched
against an installer evidence rule, see Investigating Issues.
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Configuring the Adapter

The (core) App-V server adapter is set up on an inventory beacon. Only two tasks are required for configuring this built-
in adapter:

« Specifying the connection to the appropriate database. There are distinct databases in the two versions:

o For App-V release 4.6, the App-V server adapter connects to the Microsoft App-V Management Server database
o For App-V release 5.0 and later, the App-V server adapter connects to the Microsoft App-V reporting database.

o Scheduling the imports.

Both tasks are summarized here. Further details are available in the inventory beacon help.

3
[_] To configure the App-V server adapter (summary):
1. Onthe appropriate inventory beacon, start the FlexNet Beacon interface.

An appropriate inventory beacon has network access to the appropriate database as described above; and it can
upload to the central FlexNet Manager Suite server, either directly or through a hierarchy of inventory beacons.

7
' Tip: Remember that logging into an inventory beacon requires an account with administrator privileges.

2. Select the Inventory systems page in the FlexNet Beacon interface.
3. Atthe bottom of the page, click New....
The Create SQL Source Connection dialog opens.

4. Complete the values required in this dialog:

Connection name A descriptive name for this connection that you will recognize later in lists.

Source Type Select App-V Standalone. (Use this same value whether you are connecting to App-V
release 4.6, or release 5.0 or later.)
-
= Tip: 'Standalone' means that you are using the adapter to connect directly to the
appropriate App-V database, rather than collecting inventory through another
source such as Microsoft SCCM.

Server Type the server name or IP address. If the database instance you need is not the

default one on the server you identify, add the instance name, separated with a
backslash character.
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Authentication Select one of:

» Windows Authentication — Select this option to use standard Windows
authentication to access the database server. The credentials of the account (on
the inventory beacon) running the scheduled task for importing inventory are used
to access the SQL Server database. This account must be added to an Active
Directory security group that has access to the database.

» Windows (specific account) — Use the following two fields (enabled when you
make this choice) to specify an account on the inventory beacon that can make a
connection to the SQL database.

» SQL Authentication — Use the following two fields to specify an account and
password registered as a user with database access on SQL Server . This account is
used to access the database, regardless of the local account running the scheduled
task on the inventory beacon server.

(i
= Tip: The account used needs read-only privileges.

Username The account name used for SQL authentication, or Windows (specific account). (Not
required for Windows Authentication.)

Password The password for the account name required for SQL authentication, or Windows
(specific account). (Not required for Windows Authentication.)

Database Enter the name of the database, or use the pull-down list to select from database
names automatically detected on your specified server.

Connectionisintest  Ensure that this check box is clear for production use. (For more details, see Managing
mode (do notimport  Microsoft SQL Server Database Connections in the online help for FlexNet Manager
results) Suite, in the section covering the inventory beacon.)

(i
= Tip: When using App-V release 4.6, you cannot complete configuration for operation

of this adapter (specifically, you cannot map the App-V packages to real
applications) until you have run an import in production mode, with this check box
clear.
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Overlapping
Inventory Filter

If you use more than one inventory source, it is possible to get overlapping inventory
(records about the same endpoint device from multiple inventory tools). Because of
differences between inventory tools, the overlapping inventory records may contain
slightly different data. In the compliance browser (in FlexNet Manager Suite), you may
nominate one inventory source as Primary, which gives its collected data priority for
hardware properties imported from target inventory devices. The choices here give
another, separate axis of control, based on whether or not the data from this
particular source is to be considered "stale". This is different from the Primary setting
in the following ways:

« Itis assessed first (before the primary setting is taken into account), and so may
even modify the effect of your Primary setting. It is best practice to make sure that
your chosen primary inventory source is not marked as stale with the following
settings.

« It affects not only imported hardware properties, but also software inventory
(installer evidence, file evidence, and so on), as follows:

o With two inventory sources (when neither one is considered stale), the total
software inventory is a union (merging) of the results from both sources. This is
useful when two different inventory tools have different specializations for
software detection: the union means you are not blind-sided by a software
inventory tool that missed something you should have licensed. This is
considered the 'normal’ operational case in a stable environment using multiple
inventory sources.

o When one of the two available sources is declared "stale" (using either of the
first two choices below), all of its overlapping software inventory is excluded
from the possible union of data sources (hardware inventory too, but here we're
considering software). This behavior is valuable, for instance, when a target
inventory device has migrated from one inventory source to another (perhaps
by moving offices), but has not yet been obsoleted from this first source.
Imagine that, as part of the office move, the MyApp application had also been
uninstalled from the inventory device. You do not want the old and stale record
from this source insisting there's an installation of MyApp when in fact it's no
longer on the device. Of course, best practice is to obsolete the device from this
stale source so that it is no longer reported in this inventory source; but these
first two settings allow a quick control of all the overlapping data from this
source, rather than having to obsolete devices one by one in the source tool.
Another common scenario is when you are migrating over time from an old
version of your chosen inventory tool to a newer version (on a new connection),
and during transition both systems are still running. Declaring the old version's
connection as "stale" means that as soon as a record appears in the new
version's inventory for a particular device, the old device import is automatically
superseded, and updates rely entirely on the new version of your inventory tool.

Each of the following settings only takes affect when FlexNet Manager Suite is
comparing the inventory dates of a device from this current inventory source and an
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overlapping record from another inventory source:

« Ignore the device’s inventory from this data source — When you have more recent
inventory from another source for the same target inventory device, the record from
this source is completely ignored. (Technically, the device record is deleted from the
staging table in the database, and so can never be imported.)

« Ignore this device’s inventory if older than nn days — If you select this option,
overlapping inventory collected by this source more than the set number of days
before the import is ignored. Fresher overlapping data is still imported and
considered for data merging.

(4
= Tip: In the interests of keeping inventory current, this control has a maximum

value of 60 days.

o Import the inventory from this source for possible merging — Choose this option
(the default) to declare that overlapping inventory collected from this connection is
never considered stale. This is the normal operating setting when you are not trying
to manage transitions from one inventory source to another. With this setting,
overlapping records are merged in this way:

a. If a data point exists in the Primary inventory source, it is used

b. If two equal-priority sources have different inventory dates, the data point is
taken from the most recent inventory

c. As atie-breaker, the connection ID for this source recorded in the database is
used (normally meaning that the earliest-created inventory source has
priority).

5. Click Test Connection.

« Ifthe inventory beacon can successfully connect to the nominated database using the details supplied, a
Database connection succeeded message displays. Click OK to close the message. Click Save to

complete the addition. The connection is added to (or updated in) the list.

« Ifthe inventory beacon cannot connect, aDatabase connection failed message is displayed, with
information about why that connection could not be made. Click OK to close the message. Edit the
connection details and retest the connection.

You cannot save the connection details if the connection test fails. If you cannot get the connection test to
succeed, click Cancel to cancel the addition of these connection details.

6. If you do not already have a schedule specified that can be used to run the adapter for this connection, create one
now (see Creating a Data Gathering Schedule in the online help).

7. With the connection for this adapter selected in the Inventory systems page, click Schedule....
The Select Schedule dialog opens.

8. From the drop-down list, select the schedule you wish to apply.
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.
= Tip: As you select each schedule from the list, the area below displays a summary of the schedule settings and
the expected Next run time for this schedule.
9. Click OK to apply the selected schedule.

10. Click Save to store these details.

The list of connections is updated, and the Next run column for your selected connection shows the projected run
time from the schedule you just attached.

11. With the connection for this adapter still selected in the Inventory systems page, click Execute now.

The adapter collects information from the appropriate database (App-V Management Server database for App-V
release 4.6, and App-V reporting database for App-V release 5.0 and later), packages it, and uploads it to the
central FlexNet Manager Suite (or, if it uploads to a parent inventory beacon, the file is briefly saved in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications on the parentinventory beacon).

Allow time for this process to complete before continuing with the next setup procedure.

Import Evidence and Recognize
Applications

Because your App-V package naming may be unique to your enterprise, you may need to identify the applications they

contain.

If you have many App-V packages, setting up application recognition may be a significant effort on the first import from
your App-V server adapter. Once the initial work is done, it is a simpler task to maintain recognition as new App-V
packages are put into production.

This procedure continues from the work just completed at the inventory beacon where the adapter runs. Move now to
the web interface for FlexNet Manager Suite.

-
[_] To import evidence for application recognition:
1. Ensure that the upload of data from the App-V server adapter is complete:

a. Inthe Management view, navigate to the system menu (# ¥ in the top right corner) and select Data
Inputs.

The Data Inputs page displays.
b. Select the Inventory Data tab, and select the Show details check box near to top.

¢. Find the App-V server adapter listed for the appropriate inventory beacon, and check its Last import date,
Duration, Validation issues, and Status.

When these are appropriate (in particular, Status is Successful on the appropriate Last import date),
continue this procedure. Until then, you need either to remediate any upload problems, or simply wait
until the upload is completed.

-
=" Tip: This page does not dynamically update results, but shows the status when the page was opened.
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Therefore, if you are waiting for an upload to finish, refresh the page (F5) from time to time to see
updated information.

For App-V 5.0 and later, the upload of the . raa file saves the contents into staging tables in the compliance
database, awaiting the arrival of usage information. For both App-V 4.6 and 5.0 (and later), the upload of the
datafile from the App-V server adapter (on an inventory beacon) queues a job with the batch scheduler. When this
job can next be processed, the adapter data (which, for App-V 5.0 and later, is combined in this process with the
installer evidence from the . raa file) is imported into the compliance database. Thereafter, either of two results

applies:

« Recognized installer evidence is linked to the application, and shows an installation count for each device on
which the evidence was found (and can be further examined on the properties for each of those devices).

(4

= Tip: The next step, showing consumption against an appropriate license, requires both that the application
is linked to the license, and that a reconcile has been run, either automatically on schedule or manually.

« Theinstaller evidence that was successfully imported but not matched to an application record needs your
attention to map it to the correct application. (This is more common with the adapter for release 4.6.) To do
that, continue with this process.

2. Identify newly-imported evidence (the App-V packages) that requires a link to application records:
a. Navigate to License Compliance > Discovered Evidence (in the Evidence group).
The Discovered Evidence page displays. Ensure that the default Installer evidence tab is selected.
b. Near the top of the tab, click Add filter, and from the drop-down list select Type.
A second drop-down list appears, listing the possible values of the evidence type.
c. Select App-V.

d. Click Add filter again, and from the pull-down drop-down list select Assigned, then choose the value No.
With botbh filters defined, click the blue check mark (tick) to apply this filter.

The list is redrawn to show only evidence of type App-V (the list of App-V packages discovered through the
adapter) that have not been matched (manually or automatically) to an application.

(d

= Tip: You may have no results when these filters are applied. This is a healthy state, meaning that all
your App-V evidence is successfully matched to applications. When you have no records here, and want
further validation of success, you can drill down into the properties of devices that have a record of
installation for the appropriate application.

3. Use your special knowledge of the App-V packages to link each piece of unassigned evidence to an application
record. You may do this either by:

« Clicking the Name of the evidence, which opens the property sheet for this evidence where you can work on
the Applications tab

 Following these guidelines to edit locally, still on the Discovered Evidence page:
a. Click anywhere else in a row (other than on the Name) to select that App-V package from the list.

The action buttons above the list become active.
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4.
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b. Click Assign.

Ablue editor Assign evidence to an application appears above the tabs.

. Click in the search field, optionally enter a few characters from the application name, and click Search.

The editing area expands to include a list of application results matching your search. These applications
include any previously created in your enterprise, together with all matching applications from the
Application Recognition Library regularly updated by Flexera.

. Select your chosen application from the list, and (above the list) click Add.

The search field is updated to show the name of the application you selected.

(d

= Tip: If you cannot find the correct application in the search results, you may create a new application
record by clicking Create an application, and completing the details in the application properties (the
App-V package is automatically listed in the Evidence tab of the application properties).

e. Click Assign.

e Theblue editing area closes.

« The App-V package is linked to the application you chose (the App-V package now functions like
installer evidence to show consumption against any license linked to the application).

« Inthe list of evidence, the Assigned column is updated to Yes, showing that this package has been
linked (or assigned) to an application. (If you currently have a filter on the Assigned column to show
only rows with a No value, the evidence you just assigned must disappear from the list.)

(4
= Tip: This links the evidence to the application as an exact match across publisher, name, and version

records. To protect against future upgrades of the App-V package, you may wish to generalize the
version number with a % wild-card. For example, if the original version was 1.6, manually editing the
Version property of the installer evidence to 1.% means the link to the application remains valid
through all the minor upgrades of this package.

If the selected application is not yet linked to a license, you can:

a. Double-click the App-V package in the evidence list (or, while it is selected, click Open).

The evidence property sheet opens.

. Select the Applications tab.

. Inthe list of applications, click the name of the one you have just assigned to the App-V package (or

double-click elsewhere in the row; or select the row and click Open).

The application property sheet opens.

. Select the Licenses tab in the application properties.

. Optionally enter a few characters of a license name (where you know it); click Search.

The search area expands to show the list of available licenses (matching any characters you entered).

. Select the appropriate license from those offered, and click Add license.

Where a suitable license does not already exist, you may instead create one (for example, navigate to
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License Compliance > Create a license (in the Licenses column).

¥
= Tip: Don't forget to link some purchase records to the license to provide your entitlement count.
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° . °
Issues and Limitations
Diagnosis is covered in this chapter, along with limitations and known issues.

Limitations

The following limitations apply to the current releases of the App-V server adapter:

« Inthe unlikely event that App-V packages have been shared to non-persistent Citrix Virtual Desktops (formerly
XenDesktop) VDI devices (instead of users), and FlexNet Manager Suite is linked to a Citrix Virtual Desktops broker, no
license consumption occurs for those non-persistent devices (because non-persistent VDI devices are not modeled
within FlexNet Manager Suite when Citrix Virtual Desktops broker information is available).

 License consumption calculations depend on the integration of data both from Active Directory, and from the
appropriate App-V database (App-V Management Server database for release 4.6, or reporting database for release
5.0 and later) and the AppVMgmtSvr. ps1 PowerShell script. As linking of this data occurs when the App-V server
adapter data is imported, current users, computers, and groups must be imported from Active Directory first, before
the latest App-V server adapter import occurs. From FlexNet Manager Suite 2014 R2, this ordering is automatic, since
Active Directory data is imported to the central database as soon as it is uploaded from an inventory beacon.

¥
= Tip: You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single App-

V Management Server database. This requires only one connection from the FlexNet Manager Suite App-V server
adapter, because this connects only to the database. However, if you have multiple App-V Management Server
databases in your estate, configure a separate connection to each of them on appropriate inventory beacons.
Where helpful, you may configure multiple such connections (each separately scheduled as you choose) on one
inventory beacon.

o The quality of installer evidence recovered from App-V release 4.6 is not high. You should expect to do remedial work
both to generalize the evidence found (for example, using the % wild card to generalize version numbering), and to

link the evidence to appropriate applications.

e ForApp-V release 5.0 and later, the system supports installation of the AppvMgmtSvr. ps1 PowerShell script on only
one App-V Management Server. This single Management Server may support multiple Publishing Servers (if
necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may
report to multiple Reporting Servers (independent of the source from which the App-V packages were downloaded).
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Different App-V Management Servers do not self-identify in the . raa inventory file, and the App-V reporting
database does not identify which application usage information is associated with which App-V Management Server.
For these reasons, only a single App-V Management Server (for release 5.0 and later) is supported.

Investigating Issues

Proof that the App-V server adapter is operational, and the data upload is also successful, can be seen in either or both
of two ways:

« Installation records for the appropriate applications against expected inventory devices (possibly including Remote

devices for which no hardware inventory is available)

» The presence of any newly-discovered inventory of type App-V in the Discovered Inventory list, typically with an
Assigned value of No.

If neither of these is the case, the issues could be with:

o Imports from the App-V server adapter on an inventory beacon (for both App-V release 4.6, and App-V release 5.0 or
later)

o Imports of the . raa file from your App-V Management Server (only for App-V release 5.0 or later)

» Missing links between the installer evidence (representing App-V packages) and the applications in the packages

» Missing consumption on an appropriate license.

Each of these is covered in turn below.

No data imports from adapter on inventory beacon
Check the following to identify the problem with imports from the App-V server adapter:

1. Areyou sure that there should be new records? Have new packages been brought into production since the last
time inventory was collected and fully processed?

2. Check the Status of the latest upload (navigate to the system menu (#° ¥ in the top right corner), select Data
Inputs, choose the Inventory Data tab and select Show details). Also validate that the Last import date is as
expected, so that the upload occurred after new App-V packages were brought into production.

3. If uploads are not happening, move to the inventory beacon where the adapter runs, and check the status of the
App-V connection. Use the Test connection button to ensure it can connect to the appropriate database (App-V
Management Server database for App-V release 4.6, and the App-V reporting database for release 5.0 and later).
Details about setting the connection are in Configuring the Adapter.

4. Onthe sameinventory beacon, test its connection to the central application server for FlexNet Manager Suite,
using the Parent connection page and the Test connection button there. (If this inventory beacon is part of a
hierarchy, check the connections all the way up the hierarchy to prove that uploads can reach the central server.)

5. Check for stalled uploads by looking for an App-V inventory file in the CommonAppData%\Flexera Software\
Beacon\IntermediateData directory on the inventory beacon (or, in a hierarchy, in the chain of inventory
beacons). (Notice that the folder for files from the App-V server adapter is separate from the folder for . raa files
from the PowerShell scripts used with release 5.0 and later.) App-V data files are named in part for the connection
you established (see Configuring the Adapter). Once an inventory file of this type is successfully uploaded, it is
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removed from this intermediate data location on the inventory beacon; so any file in this folder on any server in
the hierarchy has not yet been uploaded to the parent server. Upload failures may occur for temporary reasons,
such as a network timeout; but there is a catch-up task run overnight to re-attempt uploads of any stalled files.

6. Has a reconciliation calculation occurred since the upload? Until this occurs (normally overnight), new App-V
inventory cannot be displayed in the web interface for FlexNet Manager Suite. Check the date and time on the
System Health page (= ¥ > System Health), in the License reconciliation card. The last import and
reconciliation must be after the latest upload from the inventory beacon.

7. If you are using App-V release 5.0 or later, a failure to upload and save . raa files may also prevent presentation of
results, even when the application usage information is successfully imported from the App-V server adapter.
Issues with . raa files are covered in the next section.

No data imports from the PowerShell script for App-V release 5.0 and later
If uploads of . raa files do not appear to be working:

1. Ensure that a new upload is required: that is, that the AppVMgmtSvr. ps1 script has executed successfully since
the last inventory import and license consumption calculation (the most recent file is always saved on the App-V
Management Server for checking, and is only replaced the next time that the script executes):

o Check your scheduling for the script's execution, in particular that the command line options are correct (see
Obtaining (and Deploying) the Adapter Components).

o Check the log file for the last run (you may have renamed or relocated the log file, as described in Command
Line for PowerShell Script). In particular, ensure that there were no problems with the file upload to the

inventory beacon.

2. Move to that inventory beacon, and check for stalled uploads by looking for an . raa file in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications (this file path is different from the
one used for files uploaded by the App-V server adapter). If you have a hierarchy of inventory beacons, check each
inturn.

3. Iffile uploads are happening successfully, has there been a reconcile since the last . raa file was uploaded? Check
the date and time on the System Health page (=’ ¥ > System Health), in the License reconciliation card. The
last import and reconciliation must be after the latest upload from the inventory beacon. If not, you may (as an
administrator) manually trigger a reconcile (navigate to License Compliance > Reconcile ).

Missing application recognition

For App-V release 4.6, data imported from the App-V server adapter includes only the App-V package name and the
Active Directory groups (or individuals) that may access the package, according to the Access Control Lists (ACL).
Specifically, this imported information cannot recognize what application is hidden within the App-V package.
Application recognition requires a separate step. Even for App-V release 5.0 and later, where much better installer
evidence allows automatic matching of the evidence rules for the appropriate application, there may be cases where
the installer evidence needs manual attention. This will be the case when:

o Thereis no matching application available within FlexNet Manager Suite, either in application records that you have
created locally, or in the Application Recognition Library

o Thereis an appropriate application, but the values returned from App-V do not match with the existing inventory
rules for the application record.
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In cases where installer evidence from App-V is unmatched, you can check as follows:

1. First be sure that data uploads and imports are happening, as validated in the previous sections.

2. Navigate to License Compliance > Evidence column > Discovered Evidence > Installer evidence tab, filter for
Type=App-V, and check the Assigned column. If it displays No, you need to link this package to an application, as
described in Import Evidence and Recognize Applications.) For App-V release 4.6, newly imported evidence is
always unassigned, and requires you to manually associate the evidence (or App-V package) with an application.

3. ForApp-Vrelease 5.0 (and later), when installer evidence appears in the above listing, it may be worth checking
why the data from the App-V installer evidence did not match existing evidence rules for the appropriate
application (assuming the application is already present locally or in the Application Recognition Library). To do
this, navigate to the Evidence tab of the application's properties, where all existing evidence "rules" are listed
(making sure that Installer is the selected subtab). Compare the data displayed there with content in your .raa
file (see sample . raa file in File Format for .raa). Here is a worked example of successful matching using the
Filezilla 3 application:

App-V element's attribute Application's installer evidence property

msiDisplayName="FileZilla Client 3.2.4.1" NameFilezZilla Client 3.2.%

msiPublisher="" Publisher (blank)
msiVersion="3.2.4.1" Version3.2.%
accessModeID="2" (produces the evidence type Type Any

App-V)

Thus the . raa entry produces installer evidence that is immediately matched by the existing installer evidence
rule for the application, and produces an installation count against that application. But looking ahead (in
imagination) to the day when the . raa entry covers a version of 4.2.3.1, the App-V package data in the . raafile
would no longer match this evidence rule. At that time, if a new rule was yet to be published in the Application
Recognition Library, the installer evidence created from the . raa file would appear in the Discovered Evidence
listing, and you could link it to the application, preferably generalizing it (similarly to the example above) to create
a rule that would match several minor releases.

Missing consumption
Showing consumption of license entitlements for App-V packages (and the applications they contain) requires:

o The adapter gathers data from the App-V server and uploads and imports it into FlexNet Manager Suite (see first
section above for more details).

o For App-V release 5.0 or later, the . raa file is uploaded from your App-V Management Server

» The application is recognized, either automatically, or because you have linked the App-V package to an application
record (see previous section)

o The application is linked to a license (and in turn the license should be linked to purchase records to show your legal

entitlements) — here, this is left as an exercise for the reader.

» Active Directory imports are current, allowing mapping of the groups and users from the ACLs in the App-V
Management Server database to user records in FlexNet Manager Suite.
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These notes address the last stage, enabling Active Directory to map from the ACL lists to user records. This process is
automatic, provided that all the necessary data is available.

1. Onthe appropriate inventory beacon, open the Active Directory page (from the Connections group), and
validate that a connection is both established and scheduled. (For details, see Importing from Active Directory in
the online help.) Review the Last run time to see when data was last collected, uploaded, and imported. You may
also choose Execute Now if imports have been disrupted.

2. Once sufficient time has passed for Active Directory data collection, upload, and import (normally, 30 minutes
should be more than adequate), review the list of All Users to establish that the expected user names are all
available (navigate to Enterprise > All Users).

i
= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure

that the Active Directory import runs against all applicable domains in your environment. The simplest
approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign
security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages.
FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to
ensure that all applicable domains are specified. As an example of multiple domains being affected:

« Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from
Domain-B.

« Inthis case, granting access to an App-V package to Group-A also grants access to Group-B (because of the
parent-child relationship between the groups).

« This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

« Insuch a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B.
When you have many domains, the simplest path is just to run an Active Directory import from every domain.

=2

I=| Note: You cannot review Active Directory group memberships within FlexNet Manager Suite. Only the resulting
list of users is available (along with computers, sites, and subnets).

Known Issues

The following issues relate primarily to the stability of data available for collection from the App-V server.

Renaming packages

App-V allows you to rename packages (without necessarily changing their contents). When a package is renamed, the
App-V application record no longer links to usage records within the appropriate App-V database. This means that the
App-V server adapter (and, for App-V release 5.0 and later, the AppVMgmtSvr. ps1 PowerShell script) cannot import
meaningful data for license consumption calculations. As well, the installer evidence generated from the App-V import
now has a different name, which may not match evidence rules for the appropriate application. If that is the case, the
consumption calculations for any license linked to an application that was linked to the previous installer evidence
from App-V drops to zero (from this import connection).

For this reason, it is strongly recommended that you do not change the name of existing App-V packages in the App-V
Management Server interface. Where renaming is unavoidable, remember that you may need to link the new package
(represented as installer evidence in FlexNet Manager Suite) to the application to restore consumption calculations
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(especially for App-V release 4.6).

Updating package versions

Typical "rules" for applying installer evidence to identify applications use the publisher, the application, and the
version recorded in the installer evidence. If you use a version number for your App-V packages (such as 1.0), and link
exactly this App-V 'installer' evidence to the application record in FlexNet Manager Suite, then updating the version
number of the package on your App-V Server (say, to 1.1) may break the link to the application, and the linked license
loses its consumption as a result.

You can avoid this problem (at least for minor version changes) by using wild-cards in the linking of evidence to
applications. To do this, after you have linked the App-V evidence to the application:

1. Navigate to the Installer Evidence Properties page.
2. Select the General tab.

3. Edit the Version property, using a wild-card percentage sign (%) to generalize the match across multiple versions.
For example:

» Theoriginal (say 9. 2) is an exact match for only one version number.
o Avalue of 9.% matches all the minor releases of version 9.

» Avalue of % matches all versions of the App-V package with the same name and publisher.
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Data mapping

This chapter covers the relationships between the data fields in the source App-V data and the final locations of the data
inside the FlexNet Manager Suite database.

App-V Release 4.6 Data Transfers

This table lists the data extracted from App-V release 4.6, and where it is stored the compliance database in FlexNet
Manager Suite. Imported data is stored in temporary staging tables for data manipulation, and then moved into their
final destination tables as noted below. These columns in the compliance database are available for use in custom

reports, and the like.

App-V (Table)/Column

(REPORTING_CLIENT_INFORMATION)
host_name

(REPORTING_CLIENT_INFORMATION)
host_name

112

FNMS (Table)/Column

(ComplianceComputer)
ComputerName

(ComplianceComputer)
ComplianceDomainID

Notes

If the computer name already exists in the
ComplianceComputer table, this device is
identified as the consuming device.

If it does not already exist, the device is added
to the ComplianceComputer table with a
ComplianceComputerTypeID of 4, which
(through the ComplianceComputerType
table) indicates a remote device from which
inventory cannot be collected. All such created
records display their connection name (as the
Inventory Agent), are marked as incomplete
records, and are given a fictitious serial
number of 1.

The domain name is extracted from the host
record on the App-V server. If the domain does
not already exist in the compliance database, it
is added to the ComplianceDomain table, and
as required the ComplianceDomainID may be
updated in the ComplianceComputer table.
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App-V (Table)/Column FNMS (Table)/Column Notes

(APPLICATION_USAGE) (ComplianceComputer) The lastlogged on user for this computer.
username ComplianceUserID

(VW_APPLICATIONS) (InstallerEvidence) The name of the App-V package (which may
app_name DisplayName bear no resemblance to the application inside)

is used to identify the evidence record.

Note: It is possible for an App-V package to
contain more than one application. This
makes it impossible to link the App-V
evidence to a single application record. Best
practice is to make each package contain
exactly one licensable application.

(VW_APPLICATIONS) (InstallerEvidence) The version of the App-V package. Again, this

version Version bears no necessary relationship to the version
of the application inside the package, and is at
the whim of the person preparing the package
(for example, it may represent the number of
times the application package was modified).

String literal App-V (InstallerEvidence) All App-V evidence is given the publisher name
Publisher of App-V.

App-V Release 5.0 (and Later) Data
Transfers

This data is imported from Microsoft App-V release 5.0 and later. It is imported by the combination of the PowerShell
script installed on your App-v Management Server, and the App-V server adapter on an inventory beacon that can
access the App-V reporting database.

Several staging tables in the compliance database store information uploaded from the App-V reporting database and
the .raafiles. These include:

e ImportedComputer

e ImportedInstalledInstallerEvidenceUsage
e ImportedInstallerEvidence

e ImportedRemoteApplication

o ImportedRemoteApplicationAccess

o ImportedRemoteApplicationServer

e ImportedRemoteApplicationInstallerData.
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Data is held in these tables until the import from the App-V server adapter is complete, and then the resolvers are
triggered to combine the data from:

o The most recent Active Directory import(s) across all relevant domains

o The most recent imports of the . raa file from all App-V Management Server

o The App-V reporting database.

For this reason, it is important that the import from the App-V reporting database happens last.

The following table lists the elements and their attributes from the . raa file, and their final table and column in the

compliance database within FlexNet Manager Suite.

XML (Element) / Attribute FNMS (Table) / Column Notes

(app) appID n.a. Used as a key as required across the temporary tables
listed above.
(app) usersSid n.a. The group SID (from Active Directory) identifying the

users and computers with access to the package. This
drives the linking of inventory device and user records to
the application.

(msiData) (InstallerEvidence) Visible as the Name in Installer Evidence properties.
msiDisplayName DisplayName

(msiData) (InstallerEvidence) Visible as the Publisher in Installer Evidence properties.
msiPublisher Publisher

(msiData) msiVersion (InstallerEvidence) Visible as the Version in Installer Evidence properties.

Version
(msiData) (InstallerEvidence) Not visible in the web interface.
msiProductCode ProductCode

The following are the views used for source data from the App-V reporting database. It is not possible to give a simple
mapping of this source data to columns in particular database tables within FlexNet Manager Suite, because the data is
normalized and otherwise processed at each stage. For example, the usernamecolumn collected from
view_ApplicationUsage in the App-V reporting database is already subject to considerable validation and
processing before it is stored in the lastloggedonuser column in the staging tables (staging tables are listed above).
Thereafter, the user name is correlated with other inventory sources, resulting in further processing before it is used to
determine a link between the application and the user. For that reason, this table shows only the source content in the
App-V reporting database.
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dbo.view_ApplicationUsage .

dbo.view_ClientInformation

dbo.view_PackageInformation e
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app_name
app_version
end_time
host_id
start_time
username

version_guid

host_id

host_name

host_id
package_id

version_guid
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BMC Atrium and Remedy Integration

The BMC Atrium adapter is a mechanism for two-way information synchronization between an on-premises
implementation of FlexNet Manager Suite, and BMC Software's Atrium configuration management database (CMDB) and
Remedy IT Services Management product. Data flows in two directions, which in this document are described from the
viewpoint of FlexNet Manager Suite as export and import:

o The adapter exports computer system and recognized product information from FlexNet Manager Suite to the CMDB.
(Details of fields exported are available in Appendix 1: Export of Computers and Appendix 2: Export of Applications/
Products.)

» The adapter also imports Asset role, status and owner information from the CMDB and Remedy into FlexNet Manager
Suite. (Details of the imported data are available in Appendix 3: Import of Assets.)

=

|=| Note: This adapter is only available for on-premises implementations of FlexNet Manager Suite. Specifically, it cannot
be used with the cloud implementation.

This documentation (and the BMC Atrium adapter) assume that the Atrium server is running on a Microsoft Windows
operating system.

This documentation covers the following supported products:

» FlexNet Manager Suite Version 2020 R1

o BMC Atrium CMDB version 8.1 through 20.02 (together with Atrium Integrator version 8.1 through 9.1.10). The BMC
Atrium server must run a Microsoft Windows operating system.

e BMC Remedy ITSM Version 7.6.04 SP4-9.1
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Architecture, Operation, and
Prerequisites

This chapter provides a framework for your understanding of later, more detailed information.

Architecture and Operations

To facilitate the two-way exchange of data between FlexNet Manager Suite and BMC Atrium, components already
supplied with both systems are used, and additional elements are supplied with the downloaded adapter.

The following diagram combines the positioning of these elements on different servers, with the data flows for both
export and import (as defined in BMC Atrium and Remedy Integration). There are two determining factors in this
structural arrangement:

o The schedule for triggering both exports and imports is configured within Atrium, and the Atrium Integrator needs to
invoke the data export utility and the FlexNet Business Importer. For this reason, all three components (Atrium
Integrator, export utility, and Business Importer) are located on the same server.

o For performance, it is preferable that the intermediate database be on the same database server as your compliance
database for FlexNet Manager Suite. (Where you choose a different location, ensure there is a high-speed network
connection between the two servers, and a trust relationship for the accounts used during operations.)

The combination of these two determinants produces the following physical architecture. Net data flows are shown
here, with each process also shown separately below.
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FlexNet Manager BMC Atrium Server
Platform Server

Flexera =
Compllan ce Business Remedy
Importer DB

Atrium @
Integrator

Data =

Export CMDB
Tool

| ntermedlate

Adapter
components

Once the adapter components are installed and all systems are configured (as described in the chapter Installing the
Adapter), operation is fully automatic, triggered by schedules you set during configuration. The two directions of data
exchange function independently, and are summarized below.

Export of Computers and Products

In summary, the process for exporting computer and product information from FlexNet Manager Suite to BMC Atrium
(shown below in blue arrows) is as follows:

FlexNet Manager BMC Atrium Server
Platform Server

— Flexera =
Compliance Business Remedy
DB Importer DB
Atrium @
Integrator

I — o
= \ Data =

Intermediate Q Export CMDB
DB Tool
Adapter
components

1. The schedule for export fires in Atrium, and the Atrium Integrator calls the data export tool (installed as part of the
adapter).

2. The data export tool reads content from the compliance database for FlexNet Manager Suite, and writes the data
into the intermediate database. (It also creates entries in the log file, and sends alert emails if there any errors.)

3. On success, the Atrium Integrator reads the data from the intermediate database, maps it using the defined data
transforms to the fields required in Atrium
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Import of Assets

Architecture, Operation, and Prerequisites

In summary, the process for importing assets (and their ownership) from BMC Atrium into FlexNet Manager Suite
(shown below in green arrows) is as follows:

FlexNet Manager
Platform Server

BMC Atrium Server

Flexera

Compliance [~
DB

Intermediate
DB

e

Business
Importer

=\

.
)

Adapter

Remedy
DB

CMDB

components

1. The schedule for import fires in Atrium.

2. The Atrium Integrator reads data from both the Remedy database and the CMDB, and writes the results into the
Intermediate database. (It also sends alert emails if there are any errors.)

3. Onsuccess, the Atrium Integrator calls the FlexNet Business Importer.

4. The Business Importer reads the data from the intermediate database, transforms it as required, and writes the
results into the compliance database of FlexNet Manager Suite.

Prerequisites

The prerequisites for the BMC Atrium adapter include the following:

¢ On the server where the data utility is to be installed, .NET Framework 4.5 is required. (To validate, open Windows

Programs and Features, and search for .NET.)

» FlexNet Business Importer must be installed on the same server where the Atrium Integrator is installed. This is

installed as a part of the FlexNet Business Adapter Studio. Collecting the installer files is covered in Obtaining the

Adapter Components, and completing the installation and configuration is detailed in Install the Business Importer

and Link with Remedy.

» The adapter requires an intermediate database to be installed, conceptually between the compliance database for

FlexNet Manager Suite and the CMDB for BMC Remedy. In practice, this intermediate database may reside on the

same database server as the compliance database; or any other convenient server running at least Microsoft SQL

Server 2012 that is accessible from both your BMC Atrium server and your FlexNet Manager Suite database server.

Scripts to set up the database are included with the adapter, and the process is covered in Preparing the Databases.
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» FlexNet Manager Suite Version 2020 R1

o AFlexNet Manager Platform BMC Atrium CMDB Option license. To verify that you have this license term, navigate to
the system menu (%" ¥ in the top right corner) > FlexNet Manager Suite License, and look for this item in the list of
Licensed products. If not present, you can request the license term through the Contact us to renew or

upgrade email link on the same page.

o BMC Atrium CMDB version 8.1 through 20.02 (together with Atrium Integrator version 8.1 through 9.1.10). The BMC
Atrium server must run a Microsoft Windows operating system.

» BMC Remedy ITSM Version 7.6.04 SP4-9.1

Obtaining the Adapter Components

It is most convenient to collect the adapter, and the main elements it contains is to complete this procedure on the
computer where you will install the adapter (see Architecture and Operations).

3
[_] To download adapter components:
1. Use your browser to access the Flexera Customer Community.

a. On https://community.flexera.com/, use the account details emailed to you with your order confirmation
from Flexera to log in (using the Login link in the top right).
7
=" Tip: Access requires your Customer Community user name and password. If you do not have one, click
the Let's go! button on the login page to request one. Your credentials are configured for access to
content you have licensed.

b. Select Find My Product and choose FlexNet Manager from the top menu and then click the Download
Products and Licenses link in the Product Resources section.

Arouting page appears to let you Access Product and License Center,displaying lists of products
from Flexera.

c. Inthe lists of products, identify FlexNet Manager Platform,andimmediately below it, click LET'S GO.
The Product and License Center site displays.

d. IntheYour Downloads section of the Home page, click the link for FlexNet Manager Platform.

e. IntheDownload Packages page, click the link for FlexNet Manager Platform 2020 R1 to access the

downloads.

2. Selectthe Adapter Tools for FlexNet Manager Suite 2020 R1 archive (Adapter Tools for FlexNet
Manager Suite 2020 R1.zip), and save to a convenient location (such as C: \temp) on the server where Atrium
Integrator Spoon is installed.

3. Similarly, download Business Adapter Studio for FlexNet Manager Suite version.zip and save on the

same server.

Installation of the Business Adapter Studio is covered in Install the Business Importer and Link with Remedy.
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4. Unzip the adapter tools archive, navigate through Tier 1 Adapter Tools>BMCAtriumAdapter, and copy the
contentsinto C:\Program Files\Flexera\.

I} Important: This path is referenced in various steps in the Atrium jobs and transformations (see file list below).
If you do not use the same path, you must edit the Atrium Integrator Spoon jobs and transformations manually
to point the shell scripts to different location.

The archive includes the following key components:

o An SQL script to create the intermediate staging database (archive\BMCAtriumAdapter\scripts\

CreatelIntermediateDatabase.sql)

« Another SQL script to modify the database for FlexNet Manager Suite (archive\BMCAtriumAdapter\scripts\
FNMPDatabaseChanges.sql)

o The definition of Atrium Integrator jobs (. kjb) and transformations (. ktr):

o archive\BMCAtriumAdapter\BMCAtriumAdapter.kjb

o archive\BMCAtriumAdapter\FNMPExports\Execute FNMP Export Tool.kjb

o archive\BMCAtriumAdapter\FNMPExports\ExportComputerProductRelationshipsTransform.ktr
o archive\BMCAtriumAdapter\FNMPExports\ExportComputersTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\ExportProductsTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\ExportUpdateIntermediateDBTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

o archive\BMCAtriumAdapter\FNMPImports\Asset.ktr

o archive\BMCAtriumAdapter\FNMPImports\ImportUpdateIntermediateDBTransform.ktr

¢ The adapter's main executable (archive\BMCAtriumAdapter\FNMPExports\Utility
\FNMPDataExportUtility.exe), and its many dependencies, including:
o Query files (archive\BMCAtriumAdapter\FNMPExports\Utility\Queries\Computers.txt,
ProductIds.txt,Products.txt)

o Adapter configuration file (archive\BMCAtriumAdapter\FNMPExports\Utility\
FNMPDataExportUtility.exe.config)

¢ Business Importer adapter definition file (archive\BMCAtriumAdapter\FNMPImports\
FNMPImportDefinition\Asset.xml).
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Installing the Adapter

Integrating two sophisticated systems likes these involves a number of procedures, documented in the topics shown:

1.

2,

9.

Installing the new, intermediate DB used for data manipulation and transfer (see Preparing the Databases).

Modify the compliance database in FlexNet Manager Suite with a custom property for additional values (also in
Preparing the Databases).

. Installing and configuring the export utility that brings data out of FlexNet Manager Suite and into the intermediate

database (still in Preparing the Databases).

Declaring a dataset within Atrium for data exchange, and authorizing an account to use that dataset (see Reserving
an Atrium Dataset).

Importing the supplied Atrium jobs and data transforms into your Atrium system (see Importing Atrium Jobs and
Transforms).

Configuring the supplied Atrium jobs with appropriate settings for your environment (see Configure Atrium Jobs).

For the import of asset data from Atrium to FlexNet Manager Suite, installing the FlexNet Business Adapter Studio
(which brings with it the Business Importer), and integrating the Business Importer with BMC Remedy Mid-Tier (see
Install the Business Importer and Link with Remedy).

. Initially populating the CMBD with configuration items from FlexNet Manager Suite, and then adjusting settings to

allow for reuse for future imports (see Tuning Creation of Configuration Items).

Schedule regular operations of the adapter (see Scheduling the Adapter).

This chapter also includes details about Verifying Data Export to BMC Atrium.

If you are transferring large datasets, you should also prepare an environment variable as described in Preparing for
Large Datasets. (Other configuration options, including relocating or renaming the log file, are also documented in the
chapter Additional Customization of the Adapter.)

Preparing the Databases

You have a clear understanding of your physical architecture for the installation (see Architecture and Operations), and
have downloaded and unzipped the archive containing the adapter (see Obtaining the Adapter Components).
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oy
[_] To prepare the databases:

1. Determine where the intermediate database used by the adapter will reside, and log into that database server
using an account that has DB Owner privileges.

For details, refer back to Architecture and Operations.

7
= Tip: If the archive cannot be accessed from this database server, first copy the script (or both scripts for a

common DB server) from this folder to a location accessible from SQL Server Studio. If you use copies of the
scripts, modify the paths described below to suit.

2. On this server, in Microsoft SQL Server Studio, create the intermediate database (suggested name
AtriumIntermediateDB).

3. Open a query window that is connected to your new database, and execute
CreateIntermediateDatabase.sql (located in the unzipped archive, by defaultin C: \Program Files\
Flexera\BMCAtriumAdapter\scripts).

This SQL procedure creates the required tables and pre-populates some fixed values.

4. If the intermediate database is on another server separate from your compliance database for FlexNet Manager
Suite, switch over and log into the FlexNet Manager Suite database server, again using an account that has DB
Owner privileges.

You need access to the second SQL script here, so if necessary, copy the second script to this server before
continuing.

5. In Microsoft SQL Server Studio, navigate to and execute C: \Program Files\Flexera\BMCAtriumAdapter\
scripts\FNMPDatabaseChanges.sql.

This SQL script adds a custom property to the Details tab of computer properties in FlexNet Manager Suite where
the machine's Role can be imported from BMC Atrium.

6. On the server where the data extraction executable will run (likely, the Atrium server), open a command prompt,
and navigate to C: \ProgramFiles\Flexera\BMCAtriumAdapter\FNMPExports\Utility.

This executable requires .NET Framework 4.5 installed, a high-speed network access to the database(s), and an
account trusted to access both the compliance database and the intermediate database. It must be callable by
the Atrium Integrator. If need be, first copy the entire contents of the folder shown above (including
subdirectories) to a convenient location on the appropriate machine.

7
= Tip: To validate that the host in correctly configured with .NET Framework 4.5 or later, execute

FNMPDataExportUtility.exe /help

Alist of command-line options is displayed. If not, investigate the version of .NET installed.

7. Execute the following (on a single line):

FNMPDataExportUtility.exe
/Source "FNMP-DBConnectionString"
/Target "IntermediateDBConnectionString"
/Encrypt true
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where:

Parameter Notes

FNMP-DBConnectionString The connection string (enclosed in double quotation marks) for the export
utility to connection with the compliance database for FlexNet Manager Suite.
TheData Source value must be the fully-qualified domain name of the
database server. Where the compliance database is not in the default
instance on this server, add the instance name (separated by a slash).
An example connection string when the default name for the compliance
database is FNMSCompliance, is (all on one line):

Data Source=DBServer.example.com/myInstance;
Initial Catalog=FNMSCompliance;Integrated Security=SSPI;
Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

IntermediateDB The connection string (enclosed in double quotation marks) for the export

ConnectionString utility to connection with the intermediate database you recently created. An
example connection string when this is on the same server and instance as
the compliance database, and the default name for the intermediate database
is IntermediateDB, is (all on one line):

Data Source=DBServer.example.com/myInstance;
Initial Catalog=IntermediateDB;Integrated Security=SSPI;
Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

/Encrypt Required field. When set to true the connection strings are encrypted when
they are saved into the configuration file for the export utility. Use false
when not encrypting the connection strings. (The configuration file lives in the
same folder as the executable, and is called
FNMPDataExportUtility.exe.config).

8. Configure where the export utility sends email notifications about any export errors.

a. From the same folder, open FNMPDataExportUtility.exe.config in a flat text (or XML) editor.

b. Locate the following section and replace the values shown:

<appender name="SmtpAppender" type="logdnet.Appender.SmtpAppender">
<to value="toaddress@somedomain.com"></to>
<from value="fromaddress@somedomain.com"></from>
<subject value=" Atrium Integration Adapter Error"></subject>
<smtpHost value="smtp.somedomain.com"></smtpHost>

where:
Value Notes
toaddress Valid email address for the person who is to receive alerts when errors
@somedomain.com occur during export.
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Value Notes

fromaddress Valid email address for an account known on the specified SMTP host
@somedomain. com that is identified as the sender of the email when an error occurs.
smtp.somedomain.com The fully qualified domain name of the SMTP email server.

c. While here, you may want to customize the location of the log file for the export utility:

<log4dnet>
<appender name="RollingFileAppender"
type="1logdnet.Appender.RollingFileAppender">
<file value="C:\Log.txt" />

d. Save the edited file, and exit the editor.

Creating a View Only SQL User in FlexNet
Manager Suite

This task outlines how to create and configure accounts for the SQL user and to promote this user to a FlexNet Manager
Suite View only operator. These accounts are required to fetch data from FlexNet Manager Suite using BMC Atrium
Integrator Job and to populate the BMC Atrium CMDB Intermediate database.

|i| To prepare the view-only SQL user for FlexNet Manager Suite compliance database, begin by creating a user
(for example, fnmsintegrator) for the FNMSCompliance database that can log in using SQL Authentication as
follows:

1. Open the Microsoft SQL Server Management Studio.
2. Expand the Security folder (first-level child of the top SQL Server node) and right-click Logins.
3. Right-click fnmsintegrator user and select Properties from the context menu.
4. Configure the Login properties for fnmsintegrator user as follows:
a. Setthe Server Role as public to grant server-wide security privileges to the user.
b. Inthe User Mapping section, select FNMSCompliance database for this user.

c. Selectthe public and db_datareader role membership for this user against FNMSCompliance
database.

d. Selectdb_datawriter membership only if the fnmsintegrator user is used for populating data to
FNMSCompliance database from IntermediateDB.

5. Add the above user to the ComplianceOperator group for the FNMSCompliance database. For example, the
following SQL query can be used for adding a fnmsintegrator user:

Insert into ComplianceOperator(OperatorLogin,IsEnabled,GlobalOperator,Interactive)
values('fnmsintegrator',1,0,0)
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6. In FlexNet Manager Suite, navigate to the system menu (% ¥ in the top right corner) and choose Accounts.
7. GrantView Only permissions to the operator that you created in the above steps.

8. Connect to SQL Management Studio as the above user to validate that these read permissions have propagated
and run the following query.

select * from ComplianceComputerCurrentUser
9. Ifthe query does not return results, execute the SyncPreCalculatedAccessRightsForOperator stored
procedure for this ComplianceOperator as follows:
a. Open Microsoft SQL Server Management Studio.
b. Login to FNMSCompliance database as Administrator.

c. Execute the following against corresponding Tenant UID.

SetTenantUID '[Tenant UID]'

Declare @OutputBit BIT = 1

Declare @OperatorID INT = (select
ComplianceOperatorID from ComplianceOperator where OperatorLogin =

'fnmsintegrator ')
Exec SyncPreCalculatedAccessRightsForOperator

@OperatorID, @, @OutputBit

For example, the last line may be:

EXEC SyncPreCalculatedAccessRightsForOperator 2,0,1

10. Retry the SELECT on ComplianceComputerCurrentUser to ensure it works correctly.

11. Ensure that the exporter utility config file is using this SQL user in the connection string for the FNMSCompliance
database.

Reserving an Atrium Dataset

You must specify a dataset for information exchange, and ensure you have an account with write access to that dataset.
This procedure sets up a data area within Atrium reserved for data exchange with the FlexNet Manager Suite adapter.
Your Atrium Administrator may assist with an account that had permissions to access this dataset. You will reference
this dataset later in the installation of the adapter.

=
[_] To reserve the area in Atrium for data exchange:
1. Inthe BMC Remedy User application, open the CMDB console.
2. Select Reconciliation Manager > Create > Dataset.

A Dataset Information form appears.

126 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Installing the Adapter

3. Complete the following parameters:

Dataset name A friendly name for the dataset that you will recognize later in other listings.
Dataset ID The system identifier for the dataset.
=

= Tip: This value is needed when you configure your Atrium jobs.

Accessibility Use the drop-down list to set this to Writable.
DatasetType Use the drop-down list to set this to Regular.
4. Click Save.

The new dataset is created.

5. Consult with your Atrium Administrator about an account with write access to the created dataset. This account
must be used on the Atrium side to run the adapter.

For more information about creating the dataset, seeit! http://discovery.bmc.com/confluence/display/81/
Configuring+the+BMC+Atrium+Adapter.

Importing Atrium Jobs and Transforms

You need to get the supplied files into the Atrium repository, configured for your local connections. For this procedure,
you must be logged into your Atrium server with administrator privileges. This server needs access to the unzipped
archive for the adapter (in this procedure, shown as on the same server).

3
[_] To import jobs and transforms to Atrium:
1. Open the Atrium Integrator Spoon tool.

2. Select File > Open URL..., navigate to and open C: \Program Files\Flexera\BMCAtriumAdapter\
FNMPExports\istsExportComputersTransform.ktr.

3. Modify the connection strings for each of:
e Atrium_CMDB
¢ AR Server
e IntermediateDB.

4. Click File > Save.

Repeat this procedure for each of the following files in the order listed:

1. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\it#ExportProductsTransform.ktr

2. C:\Program Files\Flexera\BMCAtriumAdapter\
FNMPExports\stExportComputerProductRelationshipsTransform.ktr

3. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\stsExportUpdatelntermediateDBTransform.ktr
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4. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ Asset.ktr

5. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ ImportUpdatelntermediateDBTransform.ktr
6. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

7. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ Execute FNMP Export Tool.kjb

8. C:\Program Files\Flexera\BMCAtriumAdapter\BMCAtriumAdapter.kjb

Configure Atrium Jobs

Once you have completed the import of both tasks and jobs into the Atrium repository (as in Importing Atrium Jobs
and Transforms), you must configure the jobs, while still logged into Atrium Spoon, by linking them to transforms.

=
[_] To configure the jobs in Atrium:
1. Select File > Open..., and select FNMPExports . k3jb from the repository.

A map of the transformations required for the job is displayed.

ExpoProducts Transiom
L4
&
¥ E'T4
START ; 4 _w—"" Expenlpdesolntormediete DE Trersdom
o

x4

ExpanComputerFrod ctRelato nships Trandom

2. Right-click ExportComputersTransform,and from the context menu select Edit job entry.

The Job entry details for this transformation dialog appears. The transform name as recorded in the job entry
appears in the first field, Name of job entry.

3t Inb sntry debsl dor thin brasafermabnn: oN = |

Hame of job ety froparilip

Tran Farmstizn ipeciicshion . Adwinced | Legoing semnm | Aegumert | Bar

& Spatrty By nares and dmckary

3. Select the Specify by name and directory option.
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4. To provide a value in the associated field, browse the repository and select the transform name matching the first
field.

For example, when processing the job entry for ExportComputersTransform, select the transform of the same
name from the repository.

5. Click OK.
6. Repeat steps 2-5 for each of the remaining job entries in this chart:
e ExportProductsTransform.ktr
e ExportComputerProductRelationshipsTransform.ktr
« ExportUpdateIntermediateDBTransform.ktr.
7. Select File > Save.
8. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository.

A map of the job displays.
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Expcute Business Importer Import

9. Repeat steps 2-5 for the transform in this chart:
o Asset.ktr.
10. Double-click the FNMPExports job.

The Executing a job dialog appears. The Job entry name appears as the first field.
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%! Executing ajob ...

lob entry name:  FNMPExports

Job specification . Advanced Logging settings  Argument | Parameters

Job filename

[E=3 EE8 ==

@ Repository: specify by name FNMPExpnﬂsl

frmyserver BMC.TEST3

Repository: specify by reference

| 12| |2
B o& [

T

|[ Cancel ]

11. Select the Respository: specify by name option.

12. To provide a value in the associated field, browse the repository and select the job name matching the first field.

13. Click OK.

14. Repeat steps 10-13 for the remaining job in this chart:

« Execute FNMP Export Tool.kjb.

15. Select File > Save.

16. Either press Ctrl-3J; orright-click the BMCAtriumAdapter diagram background, and from the context menu

select Job settings.

The Job properties dialog opens.

17. Edit the following values:

130

COMPANYNAME

Enter the ID for the dataset tha
Atrium Dataset).

DATASETID

. lob properties

Job | Pararmeters - Settings | Log

Parareters :
w’ Parameter Default value Description
1 COMPANYMNAME TEST
2 COMPUTERQUERNID Computers
3 COMPUTERTABLEMAME ComputerSystern
4 DATASETID BRC TEST31
5 PRODUCTIDSQUERYID Productlds
£ PRODUCTQUERYID Products
7 PRODUCTTABLEMARE Product
8 TEMANTID 2

Enter your company name as it is recorded in the CMDB. (A match is required.)

t you created for the adapter (see Reserving an
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18. Select File > Save.

19. To configure email alerts for errors occurring on the Atrium side of the adapter:
a. Inthe BMCAtriumAdapter job, right-click on the Mail step in the center.
b. From the option menu, select Edit job entry.

The Job mail details dialog appears.
=1 Job mail detaila | I | T | 5|

Marme of misil job entrys Bail

Addrassas Zervar| ERAal Massage | Attached Filas
Crestination

Ciestination addrezs;  toaddrezzilizomedomain.com

e =
BiCc: =2
Sendear
Saridar narne | Marooa| ==
Sender address:  toaddress@somedormain.com &
Reply to e
Contact persan: &

Cartact phanel

c. Inthe Addresses tab, insert the following:
« Destination address — the person who is to receive the email alert for each error.
« Sender name — the value to appear on the emails as the sender.

« Sender address — The email address from which the email will appear to come. This must be a valid

email account known to the mail server (specified next).
d. Switch to the Server tab, and complete the SMTP Server details.
e. Click OK.

20. Select File > Save.

Install the Business Importer and Link with
Remedy

The Business Importer performs parts of the integration work, writing data from Remedy into the FlexNet Manager
Suite database. The Business Importer is installed as part of the Business Adapter Studio, a stand-alone environment
you can use to build business adapters. These 'adapt' the format of data from other business systems in your computer
estate for import into FlexNet Manager Suite, and are exercised by the Business Importer. You downloaded the installer
for the Business Adapter Studio in Obtaining the Adapter Components. To enable the business import process, you also
configure the reconciliation process to link with the Business Importer. Since the Atrium Integrator must trigger the
Business Importer, the normal architecture is to install the Business Adapter Studio on the Atrium server. In this
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location, the business adapter for importing asset records must also be amended to update its access to the

compliance database.

=
[_] To install the Business Importer and link with Remedy:

1.

2.

132

On the Atrium server, navigate to the downloaded archive, and extract the Business Adapter Studio folder.

Execute Business Adapter Studio\setup.exe.

The installation wizard for Business Adapter Studio opens.

. Complete the installation wizard using the default values it provides.

Use the Business Adapter Studio to update connection details for the asset business adapter for both output and

input:
a.

b.

On the Atrium server, launch the newly-installed Business Adapter Studio.
Do either of the following:

« Click the Open icon (IZ5) in the tool bar.

o From the File menu, click Open....

Navigate to the asset business adapter, by default located at C: \ProgramFiles\Flexera\
BMCAtriumAdapter\FNMPImports\FNMPImportDefinition\Asset.xml, and click Open.

In the navigation bar on the left, click the top-most node, labeled FlexNet Manager Platform

Database, to display the output connection properties for this adapter.

i
= Tip: This node is visible only when the Business Adapter Studio isrunning on a serverotherthan

an inventory beacon. (On an inventory beacon, the Business Adapter Studio takesthe
connection details from the inventory beacon, which already has them recorded.)

In the Database Connection panel, select Use the specific connection information below, and click the
ellipsis (...) at the right-hand end of the Connection String field to expose the Data Link Properties
dialog.

Edit the connection details so that they apply to your compliance database:
a. Forstep 1, enter the SQL Server instance name for your compliance database. Examples:
o IPv4address: 198.51.100.123
o The database server hostname: MyFNMSServer
» Anon-default database instance: 198.51.100.123\MSInst3
» Non-standard connection port: 198.51.100.123,5678

b. Supply the credentials for writing to the compliance database. If you are using an account specific
to your database server, choose Use a specific user name and password, and complete the
account name and password in the next two fields.

c. For Select the database on the server, use the drop-down to choose your compliance database
(the default name suggested during installation was FNMSCompliance).
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d. Click Test Connection, and rejoice at success (or remedy any issues until the connection succeeds).
g. Click OK to close the dialog.
h. In the left-hand navigation bar, click on the next row that names the adapter (Asset).

i. Inthe second panel, Connection and Query Properties, click the ellipsis (...) on the right end of the
Connection field to expose the relevant Data Link Properties dialog for the staging database.

j. Inthe Provider tab, select the database type (typically Microsoft OLE DB Provider for SQL
Server), and click Next.

k. Inthe same way as before, complete the details in the Connection tab, but this time for the staging
database, and validate your data with the Test Connection button.

L. Click OK to close the dialog, and save the updated adapter (Ctr1+S, or click the diskette icon in the
toolbar, or File > Save).

5. Login to BMC Remedy Mid-Tier using an account name and password provided by your BMC Administrator.

The IT Home page appears.
BMC REMEDY IT SERVICE MANAGEMENT
IT Home

Owerview Console

Shaw [Anngned Te Me =] Compary | ;]

™
o
)
g
§‘ Showing 0-0of 0
"

| Parent Request |0 | Request Type

Click here.

6. Click the Applications tab on the left boundary.

b

The Applications menu expands.
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BMC REMEDY IT SERVICE MANAGEMENT

IT Home

00

([20) G [« MHome

Guick Link=

;l Company L[

Atrium [ntegration Engine

suoneddy

AR System Administration
AR System Sample Application il | Request Type Surmmary

Administrator Consale

Change Management Dashboarnd

Contract Management

Data Management

Foundation Elements
T Click here.
[T R Y F——
Requester Console

Retumn on Invesiment

7. Select Atrium Core, and in the sub-menu select Atrium Core Console.

The BMC Atrium Core Console window opens.

BMC Atrium Core Console

L =
o©
=
3]
=
=
©
_
c
e,
=t
©
L
=
o
<T

Click here

8. Click the Application Launcher tab on the left edge, then select Applications from the menu, and in the sub-
menu select Reconciliation.

The Reconciliation tab opens.
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Iﬁnonciliation
B [l

MYSERVER - Jobs
Sort On

[Name

Click here

'rJ [] Ascending

Run Time:
Runs (Failed): 0 (0)
Activity Count: 1

Application Launcher

Source Dataset:

Target Dataset:

Atrium Explorer - Copy to Sandbox

Run Time:

Runs (Failed): 0 (0)
Activity Count: 2
Source Dataset:

Target Dataset:

Atrium Explorer - Identification and Merge

9. Click the new job icon in the toolbar.

The Job Editor page appears.
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Job Editor b4
MName # FNMP Aszet Recondlation ,‘_____‘-__ Status Active =
Sescrption 1 Fillin the name
Use standard rules for partiopating datasets |v]  Process normalzed CIs only ] Delete Tes on exit || Murriber of Job Runs to Retan in Logs =

Hew

Create new activity

Schedule

AL least one activity must be added to make this job maaningful.

Dissble Progress Bar in UT during Job Execution ]

10. In the Name field, provide a name for this job that you will recognize later.
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Suggested value: FNMP Asset Reconciliation.
11. In the Activities group, click New.

The Activities group changes to the Edit Activity area.

it Actity | Name the Activity | Uncheck

o # Aecon 1D Status | Active v Contrue: on Ermor

Hamespace Al Hamespaces - Type » Sedquanoe |50 =

Add the dataset Set the sequence
number
Gualification Additional Parameters.
Use ol dasses and instances |v] Production Dataset | B Asset v
Generate IDs ||
Exchude Subdasses ||

12. Complete the details for the first (Identify) activity:
a. Inthe Name field, provide a name you will recognize later.
Suggested value: Identify.
b. Ensure that the Continue on Error check box is clear.

Recall that the system is configured to send emails on any errors in exporting the assets to FlexNet
Manager Suite.

c. Setthe Sequence number to control ordering of activities in the job.
Recommendation: Number in hundreds to allow for later changes. Suggested value: 500.

d. Inthe Dataset Configuration area, click the first icon to add a new dataset, and select the one you created
for this exchange.

The suggested value was BMC. FNMS.
e. Click Done to save details of this activity.
The Activities group reappears, showing this first activity in the list.

13. Once again, in the Activities group, click New, and complete the details for a merge activity:
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Bt Activity Uncheck
Mame o |Merge ] States | Actwe v Contrue on Eror

1 s J -
Al \ - Type . Sequene

b
rn— Name the activity | e
R m 28 oty b
. 600 .
) BMCASS = BMC Asset ]
L] esc.ITSM,CLDATA "‘“\_ t. o)
L] B, Only select checkbox on [‘ 0| Select
] e “BMC.FNMS"” dataset | “BMC Asset” dataset J
=] =]
Qualfication Precedence Additional Parameters
Create a new precedence rule
= I"“"""""““""‘“"t’ﬂ‘fﬂl‘.”.FNI‘»‘1.'3,B|‘»'1[: AESEI:] [ Enchrle Lanchanged CTs
Frecedence Azsooabon ST Merge Ordeer
* | BC Defaudt Merge Precedence s |+ | @) ©) e | By class in separate bangactions | v

a. Add a Name for the activity.
Suggested value: Merge.

b. Ensure that the Continue on Error check box is clear.

c. Setthe Sequence number to a value higher than the identification step.
Suggested value: 600.

d. From the list of Source Datasets, select only the one identified in the previous activity.
The suggested value was BMC. FNMS.

e. From the list under Target Dataset, select the BUC Asset dataset.

f. Inthe Precedence group, click the +icon to add a new Precedence Association Set.
Suggested value: BMC. FNMS,BMC Asset.

g. Click Done to save details of this activity.

The Activities group reappears, showing your two activities.
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Job Editor x

Mame # FNMP Asset Recondliation Status M‘

Description

Use standard rules for particpating datasets (V]  Process normalized Cls only || Delete files on exit | | Murnber of Job Runs to RetaininLogs ||| = A
S seavence St

Identify Identify 500 Actve

Merge Merge 600 Active

W Disable Progress Bar in UT during Job Exeaution |1|"

(e |Gtlosed) (el

14. In the Schedule group, click New.
Set the values to suit your business processes, with a suggested frequency being once every 2-4 weeks.

15. At the bottom of the Job Editor, click Save to store your job details in the repository.

Tuning Creation of Configuration Items

Atrium requires an initial run to populate the database, and then customization for regular scheduled operations. In the
first run of the adapter, all the products and computers exported from FlexNet Manager Suite are inserted as
configuration items in the CMDB. Thereafter, matching records should be updated, and only new items inserted. We
therefore run the first pass with the default settings, and then modify the settings to schedule the regular data
exchange.

Fi] To configure the creation process for configuration items:
1. In BMC Atrium Integrator console, from the list of Jobs on the left, choose the BMCAtriumAdapter job.

2. Inthetoolbar, click the third icon (with the play button) to run the selected job once.
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Click this to run the job one time

BMC Atrium Integrator

[Beeld (=) (Al ¢ I

Integration Job Details

History

Show all Job Runs With Status | All

|

As there may be a large backlog of data to handle, and Spoon processes a line at a time, the first import can be
quite time-consuming. Wait for the first import to complete successfully before continuing with this procedure.

3. InAtrium Integrator, update the way Atrium receives the export of computers as follows:

a. Open the ExportComputersTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert Cls check box.

d. Select (turn on) the Only insert new Cls check box.

e. Click OKto close the CMDBoutput step, and click Save to store the changes to the transform.
4. Update the processing of the export of products:

a. Openthe ExportProductsTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert Cls check box.

d. Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.
Scheduling the Adapter
The adapter to exchange data between FlexNet Manager Suite and BMC Atrium is driven by a schedule set up in Atrium.

|j To configure the schedule for data exchange:
1. Ifyou are not already in the Atrium Integrator console:
a. Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.

b. Click the Applications tab on the left edge.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 139



Installing the Adapter

The Applications menu expands.
c. Select Atrium Integrator, and then click Atrium Integrator Console.

2. Inthe Jobs list on the left, select your BMCAtriumAdapter job.

el TR D e d

Integration Job Details

ob Runs With Status | Al w | AND StartDateBetween 05/
Source Typa:

Target Type:
Runs (Failed): 0 (0)
Average time: 00:00:00

BMCAtriumAdapter
Directory:
Source Type:
Target Type:
Runs (Failed):  0(0)
Average time:

First Select the Job on left
menu then click the tool bar
button on top to set the
schedule.

1 [

=L
3. Inthe tool bar, select the icon to manage the job schedule (l‘g).
4. Select Active.

5. Select the Create new schedule option.

The Schedules - "BMCAtriumAdapter" page appears.

Schedules - "BMCAtriumAdapter” x

(_) Edit Existing Schedule (=) Create New schedule Enter Schedule Name
(V] Active CarteServer | v Start Time T@ 5_@ M| v
Recurrence Type Recurrence Details
(») Once
() Daily
() Weekly

() Interval Based

Send faied

== JI Cancel || Delete || Help I

|

6. Complete the details for the regular operation of the adapter (this schedule controls data flow both ways, for
import and export):
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Give the schedule a meaningful name in the top right corner (Enter Schedule Name).

Use the Start Time spinners to dial up the time of day to start operation of the adapter.

7
=" Tip: This is local time on the BMC Remedy AR System server.

In the Recurrence Type area, specify how frequently you want the job to run.

Recommendation: The process is quite time-consuming. In a stable environment, consider a monthly
data exchange (Interval Based).

Depending on your choice, complete the Recurrence Details.

Click Save.

The integration between FlexNet Manager Suite and BMC Atrium is now operational.
However, before the next scheduled run, you should consider any further customization that may be necessary,

especially in relation to large data sets.

Verifying Data Export to BMC Atrium

This process confirms that data has been exported from FlexNet Manager Suite and successfully imported by Atrium.
This procedure uses the Atrium Core application (not Atrium Integrator).

3
[_] To verify successful data transfer into Atrium:

1. If you are not already in the Atrium Core console:

b.

C.

Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.
Click the Applications tab on the left edge.
The Applications menu expands.

Select Atrium Core, and then click Atrium Core Console.

A new window opens with the Application Launcher tab on the left edge.

2. Click the Application Launcher tab, and in the fly-out menu, click Applications.
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Click here
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3. Inthe sub-menu, click Explorer.

The Explorer tab opens, with multiple accordion folds. Ensure that the Find fold is open.
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4. Inthe Find area, use the drop-down list on the left below the tool icons to select the BMC. FNMS dataset.

5. Optionally choose an object type to search for, or expand the Quick search of all Cls.

6. Optionally, add data (or partial values) to the Name and Short Description fields (and controls for matching) to
narrow the search for particular configuration items, or leave the fields blank for a full listing of all results.

7. Click Search.

Alist of results (shown inset) displays. Validate that the data is as expected.
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Additional Customization of the
Adapter

The following notes help with minor changes to configuration, especially for future changes to configuration. The one

case that may be critical to your initial implementation is the first topic, covering preparations for large datasets.

Preparing for Large Datasets

Large numbers of data records require a customized environment variable. If your integration between FlexNet
Manager Suite and BMC Atrium will exchange large numbers of records (for example, 100,000 computer records or
more), you need to configure an environment variable on the Atrium server.

=
[_] To prepare for large datasets:

1.

Ensuring that you are logged onto the Atrium server with Administrator privileges, open the Windows start menu,
and right-click Computer.

. From the context menu, select Properties.

The Control Panel page of system properties appears.

. Inthe navigation bar, select Advanced system settings.

The System Properties dialog appears. Confirm that the Advanced tab is selected.

. Click Environment Variables....

The Environment Variables dialog appears.

. Inthe System Variables (lower) group, click New....

The New System Variable dialog appears.

. Insert the Variable name:

_JAVA_OPTIONS
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7. Insert the Variable value:

-Xms512m -Xmx15360m

This configures the Java heap size above 15GB.

8. Click OK three times to close the various dialogs, and you can close the Control Panel window.

Updating Connection Details

When system passwords change, you need to update the adapter's configuration file. Connection details are stored,
encrypted, in the adapter's configuration file (by default located at C: \Program Files\Flexera\
BMCAtriumAdapter\ FNMPExports\Utility\ FNMPDataExportUtility.exe.config on the Atrium server).
The encryption process happens the first time the adapter runs after the configuration file is edited. Once the process
has run, the connection strings are unreadable and not editable, something similar to the following:

<connectionStrings configProtectionProvider="DataProtectionConfigurationProvider">
<EncryptedData>
<CipherData>
<CipherValue>AQAAANCMNd8BFAERJjJHOAWE/Cl+sBAAAAeNhcGMAVKOUVGNTq
0g/WbQQAAAACAAAAAAADZgAAWAAAABAAAACTO9kpn6BptpLvsXExg1UBAAAAAASAAACEA
AAAEAAAAELCyiwz5AXZwIXZXTEPiAAAAgAAPIQYe+GOATScFMITYgAONDbAgZdRA9NBI1
DN42A1xjeCskUs9+KNjVU1PSFRV4ujta40evf3I0Zy50dyHsIrJRCKOOGdhDblwh4ISEk
pJk/QDna6LeCbbtXXsQK2LoAHQc/plz77UkQZxnxkL5E1PIGH16A0jEXT2F5NGJE1JIX6G
XbUXQDkNNDfi206XI/CDbX8gCuMonY1cTLYGe6+AQPpDgcY3rA®2ZF0s7/ZbocKOw7IoZ
dB6H80IvrC1SzgNkVBd3YfLhP/KOrkQFP8orqj54BIW74E1v3VUZntelESgLASMYb/FOA
h3M5x1i2Q6ITX0QMVRGESrivsdqrényGz5APx2yVBUEcoVhpOMYURbEbBSW+6/aydg8nY1l
DrcMzkP1XiZ0CQs4yZYHSWt3+bFEN3@Xxh6XKFH7Tpc8e5y9TqlBhwk+Kw6AFfZhcdewAp
JA4ZKkGAr4ixE6gNgWXnomk2puKNFImhIfqLLIuQx9TO0Uu2bjIoY+dUlrcuovl2hQX0Ch9
nqOdmeIQHPXgw8//eHYOzwy2TgMcq2M2LxXRbQqCTeWt1P1lucIVyctognI1lk2L3FSBNgM
ulCOmncR7MsGDBWoQMXnwC5+Y6P1GT45sP0edBQVIQITj7MCuzfgDD1R9c7wlge]jTGmrl
3Kmf33tGPMRYPV7CPNET3DUVOAGQUAAAAAIEkjyqfExrbeiYJIvG2usqYO3Nk=</CipherValue>
</CipherData>
</EncryptedData>
</connectionStrings>

o
U To replace connection strings and/or passwords:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the connectionStrings element (similar to that shown above), select it all, and delete it.

3. Copy the following example, paste into the same place in the configuration file, and replace the placeholder
values (including their containing brackets) as described below (you may also remove the white space from the
connection strings):

144 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Additional Customization of the Adapter

<connectionStrings>
<clear />
<add name="FNMPDBConnection"
connectionString="Data Source=[FNMPDBServerName];
Initial Catalog=FNMSCompliance;
User ID=[accountNamel];Password=[somePassword];
Integrated Security=false;
Connection Timeout=60;"/>
<add name="IntermediateDBConn"
connectionString="Data Source=[intermediateDBServerName];
Initial Catalog=IntermediateDB;
User ID=[accountName2];
Password=[anotherPassword];
Integrated Security=false;
Connection Timeout=60;"/>
</connectionStrings>

where:

Placeholder Notes

[FNMPDBServerName] The database server (and optionally, the database instance name) containing the
FlexNet Manager Suite compliance database. You may use:

¢ Adot (.) when the database is installed on the same server where the adapter

executable runs
¢ The flat name of the server
¢ The IP address of the server

¢ Where the database instance is not the default instance on that server, any of
the above with a slash (/) separator, and the database instance name.

FNMSCompliance This is the recommended database name for the compliance database. If you
used a different name, substitute the name you used.

[accountNamel] The user name that the executable uses to connect to the compliance database.
[ somePassword] The (newly current) password for the above account.

[intermediate The database server (and if necessary, instance) for the intermediate database.
DBServerName] The same formats are supported as described above for [ FNMPDBServerName].
[accountName2] The user name that the executable uses to connect to the intermediate database.
[anotherPassword] The password for [accountName2].

4. Save the edited configuration file.

The file is saved in plain text. The next time the adapter runs, this section of the configuration file is automatically
encrypted. If you are unhappy about leaving the file unencrypted until then, trigger an additional run of the
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adapter by adding a one-time schedule (see Scheduling the Adapter).

Updating Email Details

With data flows in both directions between FlexNet Manager Suite and BMC Atrium, errors may occur in either export or

import. The adapter sends emails to inform you when an error occurs. The emails for the two directions are defined

separately:

» For export from FlexNet Manager Suite, the data export utility generates the emails, with settings in its configuration
file. If the details of your email server are changed, you need to update the adapter's configuration file. It also
defines who receives the alerts, and the address from which alerts originate. You can modify any of those detail with

this procedure.

« Similarly, for imports from BMC, the email is generated by Atrium based on settings in that system. Those settings
are also summarized in this procedure, since it is likely that a change in your infrastructure or personnel affects both

kinds of email alerts equally.

We start with emails for exports from FlexNet Manager Suite; and then continue with those for imports to the same
system (that is, data is exported from BMC Atrium).

B To update email details:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the <appender> element for the SmtpAppender node in the file and update the settings marked here

with placeholders:

<appender name="SmtpAppender" type="logdnet.Appender.SmtpAppender">
<to value="toaddress@somedomain.com"></to>
<from value="fromaddress@somedomain.com"></from>
<subject value=" Atrium Integration Adapter Error"></subject>
<smtpHost value="smtp.somedomain.com"></smtpHost>

where:
Value Notes
toaddress Valid email address for the person who is to receive alerts when errors occur
@somedomain.com during export.
fromaddress Valid email address for an account known on the specified SMTP host that is
@somedomain. com identified as the sender of the email when an error occurs.
smtp.somedomain. com The fully qualified domain name of the SMTP email server.

3. Save the edited file.

4. Open the Atrium Integrator Spoon tool.
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5. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository.

A map of the job displays.

AN
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' == Setvariables Exscute FNMP Expiost Tool

START

i

FNIWPExports
]

]
= \. o B s

Expcute Business Importer Import

6. To configure email alerts for errors occurring on the Atrium side of the adapter:

a. Inthe BMCAtriumAdapter job, right-click on the Mail step in the center.

b. From the option menu, select Edit job entry.

The Job mail details dialog appears.

=1 Jab mail details P | I 5|
Mame of meil job entry: Mail
Addraszas Zarvar | ERail PMassage | Attachad Filas
Cimstination
Diestination address:  toaddressiisomedomain.com *
o >
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Zander narna | MNaral &
Sender address:  toaddress@sormedarmain.comm . o
Feply to &
Contact persomn: =

Cortact phonel

c. Inthe Addresses tab, insert the following:

« Destination address — the person who is to receive the email alert for each error.

« Sender name — the value to appear on the emails as the sender.

« Sender address — The email address from which the email will appear to come. This must be a valid

email account known to the mail server (specified next).

d. Switch to the Server tab, and complete the SMTP Server details.

e. Click OK.
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The revised email settings for data transfer in both directions take effect for the next run of the adapter.

Turning Off Email Alerts for Export Errors

You can disable email alerts for problems arising during export from FlexNet Manager Suite. This procedure provides a
quick way to temporarily disable emails sent by the data utility during data export from FlexNet Manager Suite for
transfer to BMC Atrium. This procedure turns the emails off without removing the settings details.

.r.'-'..
" Tip: For emails generated by BMC Atrium about data preparation for import to FlexNet Manager Suite, there is no
single "off switch". To stop those emails, re-do the settings to remove the email details (as described in Updating

Email Details).

E] To turn off email alerts:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the following section (towards the end of the configuration file):

<root>
<level value="ALL" />
<appender-ref ref="RollingFileAppender" />
<appender-ref ref="SmtpAppender" />
</root>

3. Comment out the appender-ref element for the SmtpAppender:
XML comments are surrounded by <! -- -->:

<root>
<level value="ALL" />
<appender-ref ref="RollingFileAppender" />
<!-- appender-ref ref="SmtpAppender" / -->
</root>

4. Save the amended file.

Email alerts for export errors are suspended until you reverse this process, re-editing the file to remove the comment
tags and restored the original value.

Changing the Log File

You can rename or relocate the log file generated by the adapter for exports from FlexNet Manager Suite.

By default, five copies of the log file, each capped at 10MB, rotate in the nominated folder (total disk space requirement
is therefore about 50MB for logging). You can customize the location and base name of the log file as follows:
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o
[_] To rename or relocate the log files:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the following section in the file:

<appender name="RollingFileAppender"
type="1logdnet.Appender.RollingFileAppender">
<file value="C:\Program Files\Flexera\BMC Atrium Adapter\Log.txt" />

</appender>

3. Editthe value attribute with the new path and file name.

7
= Tip: Keep in mind that the file name will be expanded with dating information to differentiate the various logs.

4. Save the modified file.
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Appendices

The following topics provide data mapping between attributes recorded in the FlexNet Manager Suite database and
those recorded in the BMC Atrium CMDB. In addition, some values are generated as part of the export and import
processes, and are included in the following listings.

Two separate data objects are exported from FlexNet Manager Suite: Computers, and Products. A much smaller
dataset is imported from Atrium into FlexNet Manager Suite, updating information about assets to show their role and
owner.

Appendix 1: Export of Computers

For optimal performance, exports are differential (that is, only data changed since the last export is included). The
following table shows:

o Columns from the ComplianceComputers table (and related tables) in FlexNet Manager Suite that are exported

o The equivalent column name in the ComputerSystemChanges table of the intermediate database (in case you wish

to inspect the dataset there)

o The matching column in the BUC_ComputerSystem table in the Atrium CMDB.

D Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double
quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC
Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so
on.
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Not applicable. GeneratedTokenID  TokenID
Compliance ComputerID CITag
ComputerID
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Comments

TokenID takes different formats for
different types of computers. In the
following examples, the placeholder X
represents any hexadecimal digit (0-9, A-
F).

o For physical hosts and computers, the
TokenIDis

hostname : DNSdomainName.

¢ For some virtual machines, TokenID
takes the form of a prefix, a colon, and
a UuID:

o ForVMware, VI-
UUID : XXXX-XX-XX-XX-XXXXXX

o For Hyper-V, HYPERV -
ID : XXXX-XX-XX-XX-XXXXXX

D Note: With Hyper-V, the UUID is
only available on the physical
machine, so TokenId is only set
for virtual machines that have
been successfully linked to their
hosting physical machines.

o For Xen (including Oracle VM), XEN-
ID : XXXX-XX-XX-XX-XXXXXX

o For KVM (including RedHat
Enterprise Virtualization), KVM-
ID : XXXX-XX-XX-XX-XXXXXX.

TokenID is generated dynamically,
checking the value in ComputerType.
For virtual machines, the value in
ComputerToVirtualMachine_
VMTypeID is used to determine the
prefix, and the UUID is attached from
ComputerToVirtualMachine UUID.

The identifier for the computer in the
FlexNet Manager Suite database, passed
to BMC as the configuration item tag.
(This is passed back again if Asset records
are imported by FlexNet Manager Suite.)
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ComputerName ComputerName

“DNS”

[ComplianceDomain] Domain
QualifiedName

[ComplianceDomain] FlatDomain
FlatName

152

HostName

Name Format

Domain

Domain
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Comments

The name of the computer, limited to 256
characters.

A fixed string value determining the data
type for Name.

The fully qualified domain name for the
domain where this computer exists.
Extracted from
ComplianceDomain.QualifiedName
using ComplianceComputers.
ComplianceDomainID as a foreign key.
Used when there is no value for
FlatDomain received from FlexNet
Manager Suite.

The unqualified name of the domain
containing the computer. Extracted from
ComplianceDomain.FlatName using
ComplianceComputers.
ComplianceDomainID as a foreign key.
Where this value is present, it is stored in
BMC_ComputerSystem.Domain; if not,
the qualified domain name is used
instead.
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Comments

[Compliance ComputerStatus (Not stored.) The current status of this computer within
ComputerStatus] the inventory records. Values include:

Defaultvalue  Neuw (this is the first appearance of this

computer in inventory)

« Ignored (an operator has marked this

computer to be ignored)

o Registered (thisinventory record is

linked to an asset record)

o Awaiting Inventory (adummy
computer record, allowing its
associated asset record to exist, which
will be removed when an operator
links the asset record to a real
inventory item)

Discarded.

These values are extracted from
ComplianceComputerStatus.
DefaultValue based on the foreign key
ComplianceComputers.
ComplianceComputerStatusID.

F

('a' Tip: The DefaultValue is the US
English representation of the values,
not localized.

The status is used to make sure that
computers that are Awaiting
Inventory,Discarded, or Ignored
are not transferred to BMC Atrium.

Not applicable. "Workstation" Capabilitylist Fixed literal string inserted in the BMC
Primary database.

Capability
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[Compliance ComputerType isVirtual The boolean isVirtual is set true
ComputerType] whenever the ComputerType in the
DefaultValue intermediate database is either VMHost

orVirtual Machine. Possible values
are extracted from
ComplianceComputerType.
DefaultValue based on the foreign key
ComplianceComputers.
ComplianceComputerTypelD.

InventoryDate InventoryDate (Not stored.) The date inventory was last collected
from this computer.

Manufacturer Manufacturer ManufacturerName Values from FlexNet Manager Suite are
provided to avoid data normalization by
the CMDB that may modify names.

SerialNo SerialNo SerialNumber The serial number of the computer.
[VirtualMachine] ComputerTo (Not stored.) Populated only for virtual machines. A
Compliance VirtualMachine_ foreign key that links records in the
ComputerID Compliance VirtualMachine table to the matching
ComputerID records in the ComputerCompliance
table. Used here in the calculation of
TokenID.
[VirtualMachine] ComputerTo (Not stored.) Populated only for virtual machines.
UUID VirtualMachine_ The UUID (Universally Unique Identifier)
uuIiD of the virtual machine. Used to match

virtual machine properties to their
associated ComplianceComputer.
Used here in the calculation of TokenID
for virtual machines.
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[VirtualMachine]
VMTypeID

Not applicable.

Compliance
Computer TypeID

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

ComputerToVirtual
Machine_ VMTypeID

UpdatedDate

Compliance
Computer TypeID

ViewID

TenantID

“BMC_

COMPUTERSYSTEM”

"CompanyName"

"DataSetID"

(Not stored.)

(Not stored.)

(Not stored.)

(Not stored.)

(Ignored.)

ClassID

Company

DataSetID

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

Appendices

Comments

Populated only for virtual machines. A
foreign key to the VMType table, which
identifies the kind of virtual machine,
including:

*« VMware

e Hyper-V

« LPAR

« WPAR

¢ nPar

e VvPar

*« SRP

e Zone

o Unknown.

Used here in the calculation of TokenID.

Used when identifying changed data for
differential exports to BMC Atrium.

This value is used to filter out remote
devices (those from which inventory
cannot be collected) and VDI templates,
which are not relevant to the CMDB.

Deprecated and not in use.

Always contains a zero value (a string of
16 zeroes) for an on-premises
implementation.

Fixed literal string inserted in these
records to identify the data class in the
data set.

A fixed value that must match the
company identifier embedded in the
Atrium CMDB.

Value attached to the dataset considered.
Must match the value embedded in the
Atrium CMDB.
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Appendix 2: Export of Applications/
Products

The term 'product’ is used in two slightly different ways in FlexNet Manager Suite and BMC Atrium.

« In FlexNet Manager Suite, the base unit of software is called an "application", which is specific to a particular release
(version) and edition. A 'product’ is the same software unit, but across multiple versions (and perhaps editions as
well). In our terms, then, FlexNet Manager Suite exports application records. To confuse things further, the
underlying database table is called SoftwareTitle.

e InAtrium, a "product"” is the base unit of software, and related to an individual installation. The CMDB also offers a
catalog of the products available for installation. In BMC terminology, Atrium imports product records, from which
the Product Catalog may also be updated.

The following table shows:

o Columns from the SoftwareTitle table (and related tables) in FlexNet Manager Suite that are exported

e The equivalent column name in the ProductChanges table of the intermediate database (in case you wish to

inspect the dataset there)

o The matching column in the BMC_Product in the Atrium CMDB. This indirectly populates the Product Catalog.

D Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double
quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC
Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so
on.

Not applicable. GeneratedTokenID ParentCITag The token ID generated for the
computer system on which this
product is installed is assigned to the
ParentCITag columnin BMC. For
details about the generated
TokenID, see Appendix 1: Export of
Computers.

SoftwareTitleID ApplicationID (Not stored.) Used internally in data management.
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FullName

[SoftwareTitle
Version]
VersionName

(Generated ID)

ApplicationName

ApplicationVersion

FlexeralD

ShortDescription

MarketVersion

TokenID

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

By default, the full name of the
application is the concatenation of
the product, version, and edition
fields (for example, “Microsoft
Office Professional 2010”).
However, an operator may
overwrite this with any preferred
value.

The marketing version number (such
as "2010"). Extracted from
SoftwareTitleVersion.

VersionName using
SoftwareTitle.
SoftwareTitleVersionID asa
foreign key.

FlexeralD is a unique identifier for
application records used for
unambiguous identification across
various Flexera solutions. The format
is either:

» Forapplications published in the
FlexNet ARL, arl://MGS-
APP-00000000000 (where the
11-digit number varies by
application)

o Forapplications defined locally,
app://serverGUID/LOCAL-
APP-SoftwareTitleID (where
serverGUID depends on the
identity of the central application
server, and SoftwareTitleIDis
the value of SoftwareTitleID

assigned to this application).

The result is presented as the
TokenID inthe BMC_Product table,

and as SignatureID inthe Product
Catalog.
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[SoftwareTitle
Publisher]
PublisherName

[Compliance
Computer]
ComputerName

ComputerID

[Compliance
Connection]
LastImportDate

CategoryID
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Publisher

ApplicationTo SystemName
Installation_

ComputerName

InstallationTo
Computer_

(Not stored.)

ComputerID

InstallationTo
Computer_

(Not stored.)

InventoryDate

InstallationTo
Application_

Category

Category
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ManufacturerName

Identifies the company that
produces the application/product
(for example, “Microsoft”).
Extracted from
SoftwareTitlePublisher.
PublisherName via
SoftwareTitleProduct.
SoftwareTitlePublisherID,
using SoftwareTitle.
SoftwareTitleProductIDasa
foreign key.

Name of the computing device
reported in inventory (such as
“vincent-ltp”). Extracted from
ComplianceComputer.
ComputerName using the foreign key
InstalledSoftware.
ComplianceComputerID. The view
InstalledSoftware isitself linked
to the application by the foreign key
SoftwareTitleID.

The computer identifier, extracted in
much the same way as described for
ComputerName. Used internally for

data management.

The date of the most recent
inventory collection that recorded
the installation of this application on
the current computer. When no other
value is available, this defaults to the
date of data export from FlexNet
Manager Suite. Used internally for
data management.

First level of application
categorization.

The full path of categorization is
extracted from the GroupEx table
using SoftwareTitle.
CategoryID as the foreign key. The
full path is then broken up on its /
separators, and the first level is
passed to Category in the
BMC_Product table.
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CategoryID

CategoryID

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

InstallationTo
Application_
Category

InstallationTo
Application_
Category

ViewID

TenantID

EvidenceVersion

“BMC_PRODUCT”

"CompanyName"

"DataSetID"

Ful LName:VersionName

“ProductName:
Version®

Ful LName on
ComputerName

“Deployed”

Calculated value

Type

Item

(Not stored.)

(Ignored.)

ClassID

Company

DataSetID

Name

NameFormat

Description

Status

MarkAsDeleted

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

Second level of application
categorization. (See Category for
details.)

Third level of application
categorization. (See Category for
details.)

Deprecated and not in use.

Always contains a zero value (a string
of 16 zeroes) for an on-premises
implementation.

Deprecated and not in use.

Astring literal that identifies the
class in the BMC dataset.

A fixed value that must match the
company identifier embedded in the
Atrium CMDB.

Value attached to the dataset
considered. Must match the value
embedded in the Atrium CMDB.

Full name separated by a colon from
the market version of the software
product (for example, “Microsoft
Office Professional:2010”).

A string literal describing the format
of the Name attribute.

Composite of the software name and
device name (such as “Microsoft
Office Professional 2010 on vincent-

ltp”).

A fixed value, since the records are
extracted from the installed software
listings.

Boolean (0 = no, 1 =yes). Whether or
not this product has been deleted
from the computer system under
consideration. Note that this flag is
raised only for the first import after
the product is deleted; thereafter,
further imports do not contain this
row.
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Appendix 3: Import of Assets

The following table shows:

¢ Columns from the BMC_ComputerSystem view (and AST : ComputerSystem form) in Atrium CMDB that are

exported

¢ The equivalent column name in the Assets table of the intermediate database (in case you wish to inspect the

dataset there)

o The matching columns in the FlexNet Manager Suite database where this information is imported.

Reconciliation
Identity

Domain

HostName
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Reconciliation

Identity

DOMAIN

HostName

Not stored.

[ComplianceDomain]
QualifiedName and

FlatName

ComputerName

Used internally to link the
BMC_ComputerSystemview and
AST:ComputerSystem form.

The domain extracted from BMC
Atrium is processed to provide a dot-
separated qualified name in the form
flexerasoftware.com. The same
value is processed again to provide a
flat domain name (such as
flexerasoftware). Where these
values match existing entries in the
ComplianceDomain table, no
further action is taken with them
(other than to return the
ComplianceDomainID key); but
where they are not already known,
they are added to this table for use in
FlexNet Manager Suite.

As well, the ComplianceDomainID
value returned form this update is
then written into the
ComplianceComputer record,
which may update the domain for
the current computer.

The name of this computer. Based on
a matching
ComplianceComputerID, thisvalue
may be over-written with the value
imported from Atrium.
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CITag

ImportLog table

[AST:
ComputerSystem]
System Role

[AST:
ComputerSystem]
Reconciliation
Identity

[AST:
ComputerSystem]
Assigned To

CITag

Instanceld

LastImportDate

System Role

Reconciliation
Identity

Assigned To

Compliance
ComputerID

Not stored.

Not stored.

Custom property Role
in the Details tab (User

group) of the

inventoried computer

properties.

Not stored.

AssignedUserID
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The identity for the computer record.
Where this matches an existing
record, its other columns may be
updated. Otherwise, a new record is
created for ComplianceComputerin
FlexNet Manager Suite.

Deprecated and not in use.

Calculated from data in the
ImportLog table.

Both systems record roles for servers,
but the FlexNet Manager Suite role
has various licensing implications,
and so is not updated by imports
from Atrium. Instead, a read-only
custom field is added to FlexNet
Manager Suite to accept the asset
role for each BMC_ComputerSystem.
The role is displayed in the Details
tab of the computer properties.
Values include:

e« Lab

« Development
o SIT

o UAT

e Training

e Performance
« Contingency

e Production.

Used internally to link the
BMC_ComputerSystemview and
AST:ComputerSystem form.

The ID associated with
ComplianceUser.UserName,
written here to link the
ComplianceComputer to the user
record.
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[AST:
ComputerSystem]
Owner_name

[AST:
ComputerSystem]
AssetlLifecycle
Status

[AST:
ComputerSystem] DNS
Host Name

[AST:
ComputerSystem]
Domain

[AST:
ComputerSystem]
Instance Id
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Modified Date

Owner_name

AssetLifecycle
Status

DNS Host Name

Domain_1

Instance Id

Not stored.

[ComplianceUser]
UserName

Compliance
Computer StatusID

Not stored.

Not stored.

Not stored.
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Deprecated and not in use.

The full name of the user assigned to
this computer. FlexNet Manager Suite
defaults to a concatenation of title,
first name, middle name, last name
and suffix, so any of these parts may
be present, based on the record in
BMC Atrium. Where this matches an
existing user record, no further action
is taken with it; otherwise a new user
record is created. In either case, the
ID for this user is returned, and
written into the AssignedUserID
column.

L Tip: Beware of small changes in
record data from Atrium causing
near-duplicate records to
represent the same person. Also
note that when new records are
created, you may wish to update
additional details about this
person in FlexNet Manager Suite.

Atranslation of the BMC Atrium
status values into the nearest
equivalent status value supported in
FlexNet Manager Suite. This is then
mapped by the Business Importer
into the correct ID for the status value
before being written into the
ComplianceComputer record.

Host name from the
BMC_ComputerSystemis used in
preference to this one.

Domain from the
BMC_ComputerSystemisusedin
preference to this one.

Used internally.
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[AST: Data Set Id Not stored. Used internally.
ComputerSystem]
Data Set Id
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AWS EC2 Connector

This part introduces the AWS EC2 connector, with a particular focus on managing licenses that you provide for software
used in the cloud (often called "bring your own software license", or BYOSL). The complementary case, where you
purchase instances fully provisioned by AWS (including the provision of relevant licenses), is of less interest to your
license management team, and is perhaps more the focus of your finance team.

The AWS EC2 connector is only a part of a complete BYOSL management strategy for instances (typically, virtual machines
that are tracked as inventory devices) that are hosted for you by this cloud service provider. By itself, the AWS EC2
connector does not gather sufficient data to allow for license management: for example, it does not gather software
inventory for the applications that are running on your cloud-hosted devices.

For that reason, this part covers more than the AWS EC2 connector itself. As well as details of prerequisites, set up, and
data gathering with the AWS EC2 connector, the part includes some insights into:

« Processes for gathering complete hardware and software inventory for your cloud-based instances
o Considerations for license management

« Preparing different Amazon Machine Images (AMI) from which to launch instances capable of reporting software and

hardware inventory.

In fact, using those guidelines, you could configure inventory gathering in AWS EC2 without using the AWS EC2 connector
at all. Provided that you are deploying the latest FlexNet inventory agent (13.2.x or later), inventory alone even returns the
cloud service provider. What the AWS EC2 connector adds is:

o Automatically setting the Hosted in property in the inventory device records created when inventory is returned

¢ Adding the cloud service provider and instance details when these are missing from inventory collected by legacy
versions of FlexNet inventory agent, or from third-party inventory sources

» Populating the Cloud Service Provider Inventory page with records of instances currently running in your AWS EC2
environment, including a few properties that are additional to the normal hardware and software inventory

« Importing permanent records of instances that were previously running but that have now been terminated (and for
which, as a result, any prior inventory devices records have now been deleted)

« Triggering automatic deletion (completed at the next fullimport and compliance calculation) of any inventory device
record linked to an instance that is now terminated.

This part focuses on background about the AWS EC2 connector, and additional material you need in order to build license
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management around the AWS EC2 connector. You will not find details about how to choose the right connection method
for your business processes (there are three method available), or how to undertake the actual connection here. Instead,
step-by-step instructions for configuring the connection to AWS ECS are available on the online help at FlexNet Manager
Suite Online Help > Inventory Beacon Help > Inventory Systems Page > Connecting to External Inventory Systems >
Managing PowerShell Connections > Managing AWS EC2 Connections.
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Prerequisites and Setting Up

The AWS EC2 connector is configured on a convenient inventory beacon, for which there are the following prerequisites:

» PowerShell 3.0 or later is running on Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later; with the

PowerShell execution policy set to RemoteSigned.

« The FlexNet Beacon software installed on the inventory beacon must be release 13.1.1 (shipped with FlexNet Manager
Suite 2018 R2) or later.

* A web browser is installed and enabled on the inventory beacon.
* You must log onto the inventory beacon, and run FlexNet Beacon, using an account with administrator privileges.

¢ You must have downloaded AWS Tools for Windows PowerShell from https://aws.amazon.com/powershell/, and

installed them on the inventory beacon. The minimum required version of these tools is 3.3.283.0.

¥
= Tip: To check the version installed on your inventory beacon:

1. Asadministrator, run AWS Tools for Windows PowerShell.
2. Execute the Get-AWSPowerShel LVersion cmdlet.

New versions are available for download from https://aws.amazon.com/powershell/.

i |

|=| Note: The permissible values for Instance region are currently hard coded in the AWS Tools for Windows
PowerShell. This means that if AWS create additional regions, and you want to have instances in one of the new
regions, you will need to update AWS Tools for Windows PowerShell at that time.

On the AWS side, you must first create:
« Within AWS, you must create a policy allowing access to your EC2 service
« Similarly, you must create a policy allowing access to an Identity and Access Management (IAM) entity

o ThelAM roles to grant access to AWS resources (not required when using the Configuring Connections to AWS EC2

using IAM Users method)

o The lAM user account (still within AWS) with minimum privileges that makes the connection to AWS APIs and imports
the available data (Configuring Connections to AWS EC2 using IAM Roles without FlexNet Beacon installed on EC2

instance only)
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Prerequisites and Setting Up

« Finally, on the inventory beacon that is to make the connection to AWS, you must specify the connection (which is
automatically scheduled for you).

Using Proxy Connections

The connection to AWS supports optional use of a proxy for connections that do not connect using a locally installed
FlexNet Beacon.

Step-by-step instructions for creating these, and then configuring the connection to AWS ECS, are available on the online
help at FlexNet Manager Suite Online Help > Inventory Beacon Help > Inventory Systems Page > Connecting to
External Inventory Systems > Managing PowerShell Connections > Managing AWS EC2 Connections.
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Thinking about Inventory and
Licensing

In many ways, collecting inventory and working out license consumption for instances in AWS EC2 is much the same as
licensing virtual machines on host servers sitting within the datacenter in your own offices. However, there are some
differences that are worth thinking about. For example, within your own datacenter, you have full control of, and
presumably full inventory for, the host server as well as the VMs running on it; and for some license types, host details
are relevant even when licensing software on a virtual machine. Depending on what you purchase, this may not be the
casein AWS EC2.

The following topics bring together some points to consider, first about inventory collection, and then about licensing.

Collecting Inventory from Instances

The AWS EC2 connector gathers useful information, but it cannot gather information valuable for license consumption
calculations from each of the instances running in your AWS cloud. To gather useful inventory from all instances, best
practice is to include the FlexNet inventory agent (release 13.2.buildNumber or later) in the Amazon Machine Image
(AMI) from which your devices are instantiated. For details, see the AWS documentation, Create a Standard Amazon
Machine Image Using Sysprep for Windows, or for Linux Creating an Amazon EBS-Backed Linux AMI. For additional
guidance about the kinds of customizations your AMI may need (depending on the life expectancy of instances to be
launched from the image), see either:

« Configuring an AMI for Short-Lived Instances

» Configuring an AMI for Longer-Life Instances.

Unique device naming is critical

Itis critical to your license management in AWS to ensure that each instance is uniquely named on instantiation. If you
do not do this, incoming inventory reports are not differentiated, and are interpreted as updated inventory from a
single device, named with the default device name provided by the base image.

One easy way that appears to give each instance a unique name different from its AMI is through the AWS Ec2 Launch
Settings dialog, by selecting the Set Computer Name check box (or setting the Boolean in the LaunchConfig. json
file). However, be aware that, since this name is of the form ip-hexInternalIP,the name may not be unique over

168 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1


https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html
https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html

Thinking about Inventory and Licensing

time, particularly if you have short-life instances. If an internal IP address is dropped when a first instance is shut down,
and reused for another instance that is instantiated later, then these different instances are overlaid in the FlexNet
inventory database as being updates to the same device (having the same name). However, when the inventory records
are then imported over time into the compliance database, they are differentiated by their different instance IDs,
producing separate (duplicate) device records with the same device name. Therefore, the following topics provide
another way to get a truly unique name for each device reported in inventory; and recommended best practice is to
always leave the Set Computer Name check box clear. At the very least, use this convenient AWS method for naming
instances only when you deem the risk of duplicate device records in FlexNet Manager Suite to be low enough to ignore
(or you are prepared to manually fix any duplicate inventory device records that do occur).

To ensure a device name for each instance that is unique over time, methods vary across platforms, and are detailed in
following topics. In summary:

o The easiest method on Windows is to use Sysprep when creating your AMI, leaving the name unset so that a new

name is provided on instantiation.

o For Linux, if you already provide for unique Hostname values on all your instances, no further action is required; and
otherwise, a little extra preparation can ensure that the unique InstanceID for each instance is also returned in
inventory as the MachineID, where it differentiates all returned inventory as coming from devices with distinct

names.

Schedule specialization

Scheduling inventory collection by the locally-installed FlexNet inventory agent requires that you take either of two
different approaches, based the 'life expectancy' of each instance:

« Short-lived, on-demand instances may not have a long enough life cycle for default FlexNet inventory processes to
come to full operation. For these short-lived instances, consider a customized default schedule and configuration file
in the AMI that will:

o Provide an upload location (ManageSoftRL) for inventory collection

o Omit any download location, since the instance life-cycle is projected to be too short to require any policy update
or system-wide schedule update

o Trigger inventory collection on start-up, followed immediately by inventory upload to the defined ManageSoftRL
(this cycle might typically require 3-5 minutes all up, a figure which may change based on other customizations
you may want to include in your AMI)

o Provide a back-up schedule of daily inventory collection, covering off the possibility that, unexpectedly, this
instance now needs to run for a longer period.

Keep in mind, as well, that removing the normal paths for policy update also removes the normal updates to
InventorySettings.xml, which includes arange of advanced capabilities for FlexNet inventory agent, including
Oracle inventory collection and advanced inventory techniques for Microsoft and other vendors. Your strategy
therefore includes embedding your most recently downloaded InventorySettings.xml in your AMI (and later,
updating it as required). For more guidance on customizing short-lived instances, see Configuring an AMI for Short-

Lived Instances.

« Instances with longer life spans can be managed exactly as you manage third-party installations on other inventory
devices (particularly virtual machines) within your enterprise. These instances do not require a custom schedule,
since they can share the same schedule for local inventory collection that applies throughout your enterprise. You
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do still need to consider customizations built into the AMI for these instances, such as providing a bootstrap
inventory beacon with upload and download locations, as well as giving the instance its unique device name. For
more details, see Configuring an AMI for Longer-Life Instances.

Planning your inventory beacons

The final major question is the location of your inventory beacon(s) for uploading inventory data from these instances.
Depending on the reliability of network communications between your cloud-based instances and your own enterprise
network, you may choose either:

o Torun (at least) one instance within your AWS cloud as an inventory beacon, ready 24/7 for any of your instances in
the cloud to upload their inventory. This is especially valuable for short-lived instances, where the locally-installed
FlexNet inventory agent has no opportunity to retry uploads around any network failures; and where fast network
speeds may best support your planned short life-cycle for these instances. The cloud-based inventory beacon can
then provide a more rugged upload to your enterprise network, since it has longer up-time and built-in mechanisms
for retrying any uploads that are interrupted by transient networking issues. This also enables running the AWS EC2
connector without having to create an IAM User.

« Run an inventory beacon within your enterprise network (or even, potentially, in a demilitarized zone outside your
firewall), to which all the cloud-based instances have network access, allowing them to upload their inventory files
as and when needed.

Choosing between these alternative places for your inventory beacon may require balancing questions of security and
performance against cost. Whichever choice you make, a good practice is to use a DNS alias to identify the inventory
beacon, so that you can quickly and easily make changes without disrupting the rest of your infrastructure.

¥
= Tip: As for all communication between your enterprise network and the AWS EC2 network, an Amazon Virtual Private

Cloud (VPC) is required for either of the above architectures; and if you require a link from your inventory beacon in the
AWS cloud to your central application server in your datacenter, consider a hardware VPN connection as well (see the
AWS documentation for details).

Keep in mind that an inventory beacon does not normally initiate ('push') communication to FlexNet inventory agents
installed on your AWS instances. (The only exceptions are for the 'remote execution' tasks known as adoption and zero
footprint inventory collection, neither of which you expect to use in a cloud environment.) Since all other
communications are initiated by the FlexNet inventory agent ('pull' communications, such as policy updates, collection
of self-update packages, and the upload of inventory), this means that your implementation only needs to point the
FlexNet inventory agent on each instance to its bootstrap inventory beacon (as described in following topics). You do
not need to know details like the IP addresses (public or private) for the instances reporting inventory through the
FlexNet inventory agent.

Inventory records and exceptions

After a full inventory import and license reconciliation, you can expect to see records created/updated in FlexNet
Manager Suite as follows:

o Forevery instance where the locally-installed FlexNet inventory agent has uploaded inventory, an inventory device
record

« Similarly, for every instance reporting inventory through a third-party tool (such as SCCM), an inventory device
record

170 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Thinking about Inventory and Licensing

For every cloud instance appearing in data from the AWS EC2 connector, regardless of whether it appears in

uploaded inventory or not, a cloud instance record in the CloudServiceInstance table (and of those, the ones

that also have an inventory device record show a link to it in the Cloud Service Provider Inventory page)

For dedicated hosts identified through the AWS EC2 connector (and only dedicated hosts, not any other kind of host),

an inventory device record for the host.

You will not find inventory device records for any of the following:

» Acloud instance that does not report inventory

» Ahost device that is anything other than a dedicate host (such as a default host, or a host for dedicated instances)

» Anyinstance that you have terminated.

Terminated instances are a special case.

1.

2,

Before termination, the running instance may have had an inventory device record (provided that it was reporting
inventory).

When you terminate the instance, AWS keeps the terminated instance visible through the API for about an hour,
and if you have implemented your AWS EC2 connector on an inventory beacon with the default 30 minute
schedule, the termination is imported through the AWS EC2 connector, and the record in the
CloudServiceInstance table is updated with the terminated status. (This record, with its terminated status, is
visible in the Cloud Service Provider Inventory page, if you set the filters on that page appropriately.)

. Atthe next full inventory import (by default, overnight, immediately before the license compliance calculations),

any inventory device record linked to a terminated instance is deleted, because you do not want terminated
instances consuming from your licenses.

. Of course, the terminated instance no longer reports inventory; but its previously-recorded inventory is still in the

inventory database (and in normal processes is not cleaned up for a while). Although the next full import (typically
the next night) normally imports records from the inventory database, for terminated instances this is prevented
by the terminated flag in the CloudServiceInstance table. This prevents the deleted inventory device record
from reappearing.

Should you ever need to review the software previously installed on a terminated instance, you can:

1.

2.

Navigate to Discovery & Inventory > Cloud Service Provider Inventory.

Change the default filter (top left) for Include terminated instances to Yes.

. Optionally, filter the Last known state column to show only Terminated.

. Optionally, use other filters, such as Instances reported in an appropriate period, or the Instance type and

Instance region columns, to narrow your search for this instance.

. Check the Image ID column to identify the original image from which this instance was launched (you may need

to drag this column out of the column chooser).

. Through your AWS console, identify this AMI, and inspect its software load and resulting license impacts.

Data integration

Inventory from a hosted instance may come from multiple sources, and must be integrated correctly. Various rules are

used depending on the sources being combined:
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* AWS EC2 connector + current FlexNet inventory agent are linked by:

o CloudServiceProviderID (displayed as the Cloud service provider name in the web interface)
o InstancelID

o AWS EC2 connector + other inventory sources (such as legacy versions of FlexNet inventory agent, or third-party
inventory tools, neither of which provides the instance ID) are linked by:

o MAC address (provided that the MAC address is unique in the unmatched inventory and cloud data).

Matching of the incoming data with existing inventory device records (that is, determining whether this is an update to
an existing record, or a new record) uses the standard device matching rules, with the Cloud service provider and
Instance ID checked as last priority.

Finally, the merging of data between the AWS EC2 connector and the current FlexNet inventory agent uses these
priorities:

1. If one source contains a data point that the other does not, the data is used.

2. If both sources contain the same data point but with different values, the data with the most recent inventory date
is used.

3. If different values were imported on the same day, the FlexNet inventory agent is given priority if it has been set as
the primary inventory source.

4. Otherwise, the data is used from the most recently created inventory source, with the winning source visible in the
inventory device properties as Last inventory source.

BYOSL Licensing Considerations

Full software and hardware inventory may be returned from an AWS EC2 instance when either:

» FlexNet inventory agent is locally installed on the instance, usually because it is part of the Amazon Machine Image
(AMI) from which the instance was launched

* You have some third-party tool (such as Microsoft SCCM) collecting inventory from your AWS instances, and these
results are then being imported into FlexNet Manager Suite.

Whatever the method, when inventory is returned from a running AWS EC2 instance, it has an inventory device record
in FlexNet Manager Suite. As always for all inventory devices, the installations found in software inventory for that
device consume entitlements from the licenses to which each software record is linked.

However, there are a few special adjustments for inventory from AWS EC2 instances.

Beware of terminating short-lived instances

For some special purposes, instances in the AWS EC2 cloud may be launched, run for a short period (from a few
minutes to a few hours), and then shut down until needed again.

Itis quite possible to configure the AMI from which short-lived instances are launched so that inventory is collected and
uploaded through one or more inventory beacons to your FlexNet Manager Suite application server (for details, see
Configuring an AMI for Short-Lived Instances).

However, the licensing implications are quite different when you stop an EBS-backed instance than when you terminate
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an instance:

« The assumption is that a stopped instance may be restarted when required, and resume operation with (quite likely)
the same software installed. It is therefore reasonable to calculate license consumption for such an instance, and, if
you use the configuration described in Configuring an AMI for Short-Lived Instances, this happens as usual for virtual
machines (whether those are VMs within your enterprise network or instances in the cloud).

o Aterminated AWS instance cannot be restarted, and if you are choosing BYOSL for instances that you terminate, you
should check your license terms carefully and make appropriate provision. The working assumption in FlexNet
Manager Suite is that a terminated instance should no longer consume from your software licenses, just as license
consumption stops when you uninstall software from a device, or decommission a hardware asset. As described in
Collecting Inventory from Instances, this is achieved by permanently deleting any inventory device record that may
have previously been created for the instance that is now terminated. (See the same topic for a way of re-discovering
the software load for a terminated instance, and hence its potential license implications.)

The complexity of managing licenses on transient instances is why it is more common to purchase these based on a
fully-loaded image provided by (and licensed through) AWS. However, if you need repeated runs of a short-lived
instance for special purposes, and such an instance must include software for which you provide the license (BYOSL),
consider running such an instance as a stop/start instance, rather than terminating it and re-launching it, to simplify
your license management.

Thirty-minute inventory and IBM PVU licenses

The default schedule for the AWS EC2 connector is to have it run every 30 minutes. Coincidentally, this happens to be
the same interval that IBM requires for hardware checks of devices linked to IBM PVU licenses (when you have IBM's
approval to use FlexNet Manager Suite as the source for sub-capacity licensing calculations, for which see the Sub-
Capacity Licensing with IBM PVU chapter of the FlexNet Manager Suite System Reference PDF, available through the title
page of online help).

However, each of these coincidental but distinct schedules has its own separate reasons:

e The AWS EC2 connector should run every 30 minutes to allow it to capture transient information that AWS keeps
available for only an hour, so that you can track your terminated instances where required. This is the connector
schedule, and the AWS EC2 connector does not return enough inventory detail to satisfy the IBM requirements.

o The hardware check for IBM PVU licenses must run every 30 minutes as part of your amended contractual agreement
with IBM. This is an inventory schedule that controls operations of FlexNet inventory agent embedded on an
operational instance.

If you are providing IBM PVU licenses for use in the AWS EC2 cloud, and have the IBM amended agreement to allow sub-
capacity calculations within FlexNet Manager Suite, these two default schedules conveniently satisfy both
requirements within AWS. However, be aware of the following requirements:

e IBM PVU licenses in the BYOSL model are not appropriate for very short-life instances that are then terminated (see
previous section about the pitfalls of terminating instances with BOYSL). Start/stop operations can be used when
necessary, if the instance is maintained and not terminated.

 Persistent (unchanging) inventory device names and matching instance IDs are critical to this license model,
allowing proper calculations of peak consumption values over time. For details about setting a unique but persistent
device name for inventory, see Configuring an AMI for Longer-Life Instances.

o Asalways, full hardware and software inventory (from the instance) is required for IBM PVU licensing. Compliance
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with your IBM license requires regular software inventory (daily is recommended best practice) as well as the
30-minute hardware check. Use of the FlexNet inventory agent is also mandated by your adjusted license
agreement. The techniques in Configuring an AMI for Longer-Life Instances prepare an AMI from which you can
launch instances with the operational FlexNet inventory agent embedded, satisfying those requirements.

o Asalways, the first full software and hardware inventory must be uploaded and processed on the central application
server before the 30-minute hardware checks take effect. (This allows the calculation of updated rule targets that
identify all devices affected by IBM PVU licensing processes.) Typically the relevant compliance calculations take
place overnight, after which the revised device policy must be distributed through the inventory beacon hierarchy to
affected installations of FlexNet inventory agent, bringing with it the special schedule for the hardware check. All of
this process means that in the normal course of events, IBM PVU operations typically are running effectively from the
day after an instance is launched with PVU-licensed software in operation.

Uncapped calculations except on dedicated hosts

Some license types allow that, where the total license liabilities for many VMs on the same host theoretically exceed
factors like the total number of cores available on the host, the summing process is 'capped' or given an upper limit by
the actual capacity of the host. For example, if five VMs on a host are each allocated 2 cores, for a total of 10 allocated
cores when the host actually only has 8 cores available, then, just as in reality the time-sharing between the VMs limits
the cores in use at any moment, so also the license rules cap (or reduce) the calculated figure (10 cores) to the total
capacity of the host (8 cores).

Obviously, capping of consumption calculations requires inventory not only of all the VMs on a host, but also of the
host itself. However, in the case of AWS EC2 instances, inventory details are not available for any host types other than
'dedicated hosts', over which you have full control. This means that on all other, non-dedicated hosts in AWS EC2,
capping of license calculations cannot occur.

All calculations for BOYSL licensing of instances on non-dedicated AWS hosts are based entirely on the inventory taken
from the instances themselves, without capping. This does not expose you to any risk of under-licensing (provided that
allinstances are returning inventory); the only risk is that you may perhaps be over-calculating the consumption that
might apply on a known host with capping applied.

However, this may not be an issue at all. Carefully check your BYOSL terms and use rights. You may find that software
publishers already disallow capping in cloud environments, because of the impossibility of tracking instances that may
pop up now on this host and now on another, depending on resource allocations within AWS.
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Images for Different Kinds of
Instances

The easiest way to collect inventory from all your cloud-based instances is to make sure that they are launched from
Amazon Machine Images (AMI) that already contain everything needed for the collection of FlexNet inventory.

However, the required customization varies somewhat, based on your plans for the resulting instances:

« Instances with short lifespans (from a few minutes to a few hours) need special provision so that they collect and
upload inventory as soon as they are launched. For details of ways to achieve this, see Configuring an AMI for Short-
Lived Instances.

« Instances with longer lifespans (two days or more, whether or not they are actually running for all of that period) can
use a more conventional customization that brings them into the normal policy-based management processes used
everywhere by FlexNet Manager Suite. For these, see Configuring an AMI for Longer-Life Instances.

Configuring an AMI for Short-Lived
Instances

The requirements for short-lived on demand instances in your AWS EC2 service are somewhat specialized because of
the need to capture and upload inventory within a short space of time. This means you need to prepare a separate
Amazon Machine Image (AMI) from which to instantiate these short-lived instances. The requirements include:

« Installing the latest approved FlexNet inventory agent into the image
» Adding a customized configuration file that identifies the upload location for inventory

« Installing a customized schedule to manage FlexNet inventory agent in the resulting instances, triggering inventory
gathering on start-up (and best practice is to include a backup schedule for further inventory collection in case an
instance from this AMI runs for an unexpectedly long time)

« Including the current version of InventorySettings.xml that provides advanced functionality for FlexNet

inventory agent, since the short lifetime does not allow for normal policy-based downloads

« Ensuring a unique name for each instance created from this AMI.
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At this summary level, the requirements are the same for Windows and Linux platforms. In the details, of course, there
are platform specifics.

[i] To prepare an AMI for short-lived instances:
1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.
The Inventory Settings page displays.
2. Expand the Inventory agent for download section.
3. Collect the template configuration file:

o ForaWindows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

« For a Linux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
mgsft_rollout_response in a convenient working folder (such as C: \temp).

4. From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your
AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for AWS EC2, you must use FlexNet inventory agent
13.2.0 or later.

5. Inyour preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory
agent in your AWS EC2 environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the upload location for gathered inventory, as described
below. (A download location for policy updates is not needed for short-life instances on Windows.) On Linux,
FlexNet inventory agent requires both an upload location and a download location. As always, on either
platform, experts may also customize other preferences needed for your implementation, as described in the
platform-specific topics in the Gathering FlexNet Inventory PDF:

o Agent third-party deployment: Edit the Configuration File for Microsoft Windows
« Agent third-party deployment: Configure the Bootstrap File for UNIX.

The upload (and download) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the AMI.

» For Windows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the
following settings:

; Registry settings to be created under
; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]
desc@ = UploadSettings\Bootstrap Server\Protocol
vale = http
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descl = UploadSettings\Bootstrap Server\Priority
vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority
val2 = False

desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com
desc4 = UploadSettings\Bootstrap Server\Port
vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory
val5 = /ManageSoftRL/

b. Optionally, modify the Protocol value if you want to use HTTPS (vale = https).

¢. You must customize the Host preference (shown above asval3 = beacon.fnms.com) to your chosen
DNS alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in
your enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its public and private DNS hostnames on the AWS console (select Instances in
the navigation pane, choose the instance hosting the inventory beacon, and read both its public and
private DNS hostnames in the details pane).

I:- Tip: If you have an inventory beacon on an AWS instance, your installations of FlexNet inventory agent
on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

d. Optionally, customize the port setting (for example, if you are switching to the HTTPS protocol, the default
portis 443).

B’ Important: The Directory preference is mandatory, and must be set as shown above.

e. Create a subfolder (such as ShortLifeAMI) and save your edited mgssetup.ini there. Do not change
the file name, which is mandatory.

o ForLinux,inmgsft_rollout_response:

a. Inthe first section of the file, customize the setting for the download location (see also the comments for
the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftDL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/

b. In the next section of the file, customize the setting for the reporting (upload) location:

# The initial reporting location(s) for the installation.
# For example, http://myhost.mydomain.com/
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ManageSoftRL/
# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as
required. You must customize the host URL (shown above as beacon.fnms. com) to your chosen DNS
alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in your
enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its DNS hostname on the AWS console (select Instances in the navigation pane,
choose the instance hosting the inventory beacon, and read its DNS hostname in the details pane).

B’ Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Inthe last line of the file, switch the value to prevent policy running after installation, as short-lived
instances do not have time to wait for policy and its outcomes:

MGSFT_RUNPOLICY=0

d. Create a subfolder (such as ShortLifeAMI) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

e. Unless you already have a strategy and practice that gives every Linux instance a unique name, also create
a new text file for your Linux AMI, called tmpconfig.ini, with exactly the following two lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

6. For either platform, copy the following and paste it into a plain ASCII text file, and save it in your ShortLifeAMI
folder as DefaultSchedule.nds (this file name is mandatory). Of course, you may choose to unwrap those lines
wrapped for readability here.

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE Schedule PUBLIC "Flexera Inventory Manager schedule"
"http://www.managesoft.com/dtd/schedule.dtd">

<Schedule NAME="Default Schedule" TIMEDATESTAMP="20180903T044104Z"
SCHEDSCHEMA="60">
<Event NETWORK="False"
NAME="Generate Inventory"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="0" TIMESTART="143950"
DATESTART="20180903" TYPE="Logon" MAXDELAY="0"/>
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</Event>
<!-- Following two events are optional (see notes) --!>
<Event NETWORK="False"
NAME="Generate Inventory" IDLEDURATION="86400"
CATCHUP="Never" ID="{F065A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="1" TIMESTART="001000"
DATESTART="20180903" TYPE="Daily" REPEAT="21600"
TIMEWINDOW="3600" DURATION="86400"/>
</Event>
<Event NETWORK="False"
NAME="Upload Client Files"
CATCHUP="Never" ID="{9CB87BAE-2829-498C-8643-10A9BD3BFA56}">
<LogicalCommand PARAM="-a"
ACTION="Upload" COMPONENT="Uploader"/>
<Trigger TYPE_PARAM="1" TIMESTART="002000"
DATESTART="20180903" TYPE="Daily" REPEAT="600"
DURATION="86400"/>
</Event>
</Schedule>

The first event in this schedule triggers machine inventory collection on startup (TYPE="Logon"), and the
tracker component automatically attempts an upload to the bootstrap inventory beacon as soon as inventory
gathering is complete. If you are certain that all instances from this image are short-lived, only this event is
required. If you are using an EBS-backed instance, and you choose to stop and restart your instance (rather than
to terminate and re-launch it), this inventory is checked on each restart.

In addition, two further schedule events provide easy management of cases where an instance proposed to have
a short life in fact keeps on running for some longer time.

The second event also generates inventory, and is triggered every 6 hours (REPEAT="21600", with all times
expressed in seconds), to start within an hour thereafter (TIMEWINDOW="3600"). However, this inventory
collection is different than the first case, because here the FlexNet inventory agent does not repeat the inventory
collection if it has been successful within the last 24 hours (IDLEDURATION="86400"). This means that,
effectively, the FlexNet inventory agent checks four times a day whether there has been a successful inventory
collection in the last 24 hours, and if not, it runs a new inventory collection.

In a perfect world, the third event is redundant because the tracker component uploads inventory as soon as it
is collected. This third, separate upload event is a catch-up to work around transient network issues. It checks
every 10 minutes to see whether any inventory files have failed to upload (and are therefore still waiting in the
staging folder). In normal cases, nothing is waiting, and the uploader shuts down immediately, causing
negligible load on the instance. But where there have been networking issues, upload is attempted again every
10 minutes until all files are successfully uploaded and removed from the staging folder.

7. Ona convenient inventory beacon, navigate to %CommonAppData%\Flexera Software\Staging\Common\
ClientConfiguration,take a copy of InventorySettings.xml, and save it to your ShortLifeAMI working
folder.

This completes the preparation of materials for your AMI for instances of this expected life. Now continue to use
these materials to prepare the AMI. For both platforms, the high-level process is to customize a running instance,
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and then save it as an AMI.

For a Windows-based AMI, the recommended best practice is to run Sysprep, as this can easily ensure that each
instantiation from this AMI receives a unique device name. For Sysprep, AWS offers two different sets of scripts to
assist, with separate documentation:

o ForaWindows 2016 AMI, use EC2Launch, and see https://docs.aws.amazon.com/AWSEC2/latest/
WindowsGuide/ec2launch.html#ec2launch-sysprep

« For an AMI for an earlier version of Microsoft Windows, use the EC2Config service, and see
https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html

For a Linux AMI, the following notes relate to an EBS-backed instance, since this is the simpler process, and the
flexibility of the resulting instances is greater (for example, supporting stopping an instance without necessarily
terminating it). If you have instead chosen to use an instance store-backed instance, follow the AWS
documentation closely, and give it priority where there may be any disparities with this document. Choose from
either:

e https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html (preferred, for your EBS-
backed instance)

o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-instance-store.html (for an instance
backed by the instance store).

. Following the AWS documentation, select (or create), launch and connect to your chosen instance from which you

are creating your AMI.

9. To customize your instance:

180

a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create
it.

The default paths for each platform are:
e OnWindows, C:\Program Files (x86)\Flexera Software\Agent
e OnLinux, /opt/managesoft/bin.

b. From your local ShortLifeAMI working folder, copy these files into the destination folder on your

instance:
e DefaultSchedule.nds
e InventorySettings.xml
e Only on Windows, mgssetup.ini
e Onlyon Linux, tmpconfig.ini.
¢. ForLinuxonly, also copy your amended mgsft_rollout_response fileto /var/tmp/ onyourinstance.

d. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the
installer on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
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Inventory PDF, focusing on the installation topic for your preferred platform.

e. When installation is complete, in the same destination folder and for both platforms, run the following
command to install your default schedule:

start ndschedag.exe -t machine .\DefaultSchedule.nds

i
= Tip: When creating your AMI in the following steps, make the name for this image meaningful, such as "Short-

life instances', to remind you of the special conditions embodied in the AMI.

10. Only for Windows: complete the remaining steps in the AWS document to Sysprep your instance, finishing by
clicking Shutdown with Sysprep (or, for pre-2016 versions of Windows, click OK and confirm Yes to run Sysprep
and shut down the instance).

|_¢' Important: If you are using EC2Launch on Windows 2016, in the Ec2 Launch Settings dialog, be sure to leave
the Set Computer Name check box clear. This allows Sysprep to clear the computer name from the instance
as it shuts down, so that new instances launched from this image each receive a unique device name.

11. Only for Linux (for an EBS-backed image):
a. Navigate to your instance configuration.

For example, if you are creating a new instance, select the third tab across the top of your console,
showing 3. Configure Instance.

b. If necessary, scroll down, and expand the Advanced Details panel.

c. Inthe User data field, add the following two lines As text to ensure that each Linux instance reports a
unique device name in its inventory (lines are wrapped here for publication, but each command should be
entered on a single line):

sudo sed -i

"s/MachineID=/MachineID=$(curl
http://169.254.169.254/1latest/meta-data/instance-id/)/g"

tmpconfig.ini

/opt/managesoft/bin/mgsconfig -i /var/tmp/
tmpconfig.ini

The first line replaces the unfinished MachineID setting in the tmpconfig. ini file with a setting
completed with the Instance ID, which is recovered in the standard way from the AWS metadata for the
currentimage. The second line runs a small FlexNet utility that merges the new value into the standard
config.ini for the Linux-based FlexNet inventory agent. These two lines of code are run as the instance
is being instantiated, before the FlexNet inventory agent is run. The result is that, whenever an instance is
launched from the image you are creating, FlexNet inventory agent takes the MachineID setting from
the config.ini file, and reports that unique device name as part of its uploaded inventory.

d. If yourinstance is running, stop it now. (Making an AMI from a stopped instance is preferred for lower risk
and better stability in your image.)

12. Monitor the Instances page in the Amazon EC2 console, until the state for your chosen instance displays stopped.

13. Follow your preferred process to create an AMI from that stopped instance.
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For example, on Windows, since you have already installed AWS Tools for Windows PowerShell, you could use
the cmdlet New-EC2Image. For Linux, in the navigation pane, you can choose Instances, select your instance,
and then choose Actions > Image > Create Image, and provide the necessary details. For more information on
creating AMIs, see either of:

o https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/Creating_EBSbacked_WinAMI.html
o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html.

This AMI is now ready to instantiate short-lived instances. As soon as each instance is spawned, the embedded FlexNet
inventory agent gathers inventory from the instance, and immediately uploads it to the bootstrap inventory beacon.
Depending on the resources on each instance, this process may take around 2-5 minutes, after which the instance can
be stopped (but remember, not terminated if you wish to track related software licenses in FlexNet Manager Suite).

Configuring an AMI for Longer-Life
Instances

An AWS EC2 instance that runs for a longer period (such as at least a day or two) can take part in the normal processes
for inventory collection that you use for any virtual machines, whether on-premises or in the cloud. The requirements
include:

« Installing the latest approved FlexNet inventory agent into the image

« Adding a customized configuration file that identifies both the download location for requesting the initial policy for
FlexNet inventory agent on the instance, and the upload location for inventory

« Ensuring a unique name for each instance created from this AMI.

Both the operational schedule for FlexNet inventory agent, and the latest InventorySettings.xml providing
enhanced inventory-gathering functionality, are delivered automatically as part of policy. However, this can take a
couple of days in the worst case; so if you wish you may also include a start-up schedule and
InventorySettings.xml inthe image to shorten the time to full functionality of FlexNet inventory agent. If you do
so, both of these are over-written automatically once policy is fully operational. (You can find some notes about these
additional documents in Configuring an AMI for Short-Lived Instances.)

These guidelines cover both Windows and Linux instances, so skip the parts that do not apply to your platform.

[i] To prepare an AMI for longer-life instances:
1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.
The Inventory Settings page displays.
2. Collect the template configuration file:

* For aWindows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

o Fora Linux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
mgsft_rollout_response in a convenient working folder (such as C:\temp).
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3. From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your
AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for AWS EC2, you must use FlexNet inventory agent
13.2.0 or later.

4. Inyour preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory
agent in your AWS EC2 environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the download location for requesting policy, as described
below. (On Windows, all other requirements are delivered through policy; but for safety we'll also provide an
upload location.) On Linux, FlexNet inventory agent requires both an upload location and a download location.
As always, on either platform, experts may also customize other preferences needed for your implementation, as
described in the platform-specific topics in the Gathering FlexNet Inventory PDF:

o Agentthird-party deployment: Edit the Configuration File for Microsoft Windows
o Agent third-party deployment: Configure the Bootstrap File for UNIX.

The download (and upload) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the AMI.

o For Windows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the
following settings:

; Registry settings to be created under
; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]

desc@ = UploadSettings\Bootstrap Server\Protocol
vale = http

descl = UploadSettings\Bootstrap Server\Priority
vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority
val2 = False
desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com
desc4 = UploadSettings\Bootstrap Server\Port
vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory
val5 = /ManageSoftRL/

desc6 = DownloadSettings\Bootstrap Server\Protocol

valée = http
desc7 = DownloadSettings\Bootstrap Server\Priority
val7 = 100

desc8 = DownloadSettings\Bootstrap Server\AutoPriority
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val8 = False

desc9 = DownloadSettings\Bootstrap Server\Host

val9 = beacon.fnms.com

desc1l0 = DownloadSettings\Bootstrap Server\Port
valle = 80

descll = DownloadSettings\Bootstrap Server\Directory
valll = /ManageSoftDL/

b. Optionally, modify the Protocol values if you want to use HTTPS (val® = https,andval6é = https).

c. You must customize the Host preference (shown above asval3 = beacon.fnms.comandval9 =
beacon.fnms. com) to your chosen DNS alias (or preferred host setting) and your own enterprise name if
the inventory beacon is located in your enterprise network rather than on an AWS EC2 instance. For an
inventory beacon hosted on an AWS instance, you can identify its DNS hostname on the AWS console
(select Instances in the navigation pane, choose the instance hosting the inventory beacon, and read its
DNS hostname in the details pane).

-

= Tip: If you have an inventory beacon on an AWS instance, your installations of FlexNet inventory agent
on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

d. Optionally, customize the port settings at val4 and val1@o (for example, if you are switching to the HTTPS
protocol, the default port is 443).

B’ Important: The Directory preference is mandatory, and in each case must be set as shown above.

e. Create a subfolder (such as LongLifeAMI) and save your edited mgssetup.ini there. Do not change the
file name, which is mandatory.

o ForLinux,inmgsft_rollout_response:

a. Inthe first section of the file, customize the setting for the download location (see also the comments for
the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftDL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/

b. In the next section of the file, customize the setting for the reporting (upload) location:

# The initial reporting location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftRL/

# Refer to the documentation for further
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details.

MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as
required. You must customize the host URL (shown above as beacon.fnms. com) to your chosen DNS
alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in your
enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its DNS hostname on the AWS console (select Instances in the navigation pane,
choose the instance hosting the inventory beacon, and read its DNS hostname in the details pane).

R] Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Create a subfolder (such as LongLifeAMI) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

d. Unlessyou already have a strategy and practice that gives every Linux instance a unique name, also create
a new text file for your Linux AMI, called tmpconfig.ini, with exactly the following two lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

This completes the preparation of materials for your AMI for instances of this expected life. Now continue to use
these materials to prepare the AMI. For both platforms, the high-level process is to customize a running instance,
and then save it as an AMI.

For a Windows-based AMI, the recommended best practice is to run Sysprep, as this can easily ensure that each
instantiation from this AMI receives a unique device name. For Sysprep, AWS offers two different sets of scripts to
assist, with separate documentation:

o ForaWindows 2016 AMI, use EC2Launch, and see https://docs.aws.amazon.com/AWSEC2/latest/
WindowsGuide/ec2launch.html#ec2launch-sysprep

o For an AMI for an earlier version of Microsoft Windows, use the EC2Config service, and see
https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html

For a Linux AMI, the following notes relate to an EBS-backed instance, since this is the simpler process, and the
flexibility of the resulting instances is greater (for example, supporting stopping an instance without necessarily
terminating it). If you have instead chosen to use an instance store-backed instance, follow the AWS
documentation closely, and give it priority where there may be any disparities with this document. Choose from
either:

o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html (preferred, for your EBS-
backed instance)

e https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-instance-store.html (for an instance
backed by the instance store).

5. Following the AWS documentation, select (or create), launch and connect to your chosen instance from which you
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are creating your AMI.
6. To customize your instance:

a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create
it.

The default paths for each platform are:
e OnWindows, C:\Program Files (x86)\Flexera Software\Agent
e OnLinux, /opt/managesoft/bin.
b. From your local ShortLifeAMI working folder, copy these files as shown onto your instance:

e ForWindows, copy mgssetup.ini into the destination folder C: \Program Files (x86)\Flexera

Software\Agent
e ForLinux, copymgsft_rollout_responseinto /var/tmp/ on your instance.

c. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the
installer on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
Inventory PDF, focusing on the installation topic for your preferred platform.

L
= Tip: When creating your AMI in the following steps, make the name for this image meaningful, such as "Long-life

instances", to remind you of the special conditions embodied in the AMI.

7. Only for Windows: complete the remaining steps in the AWS document to Sysprep your instance, finishing by
clicking Shutdown with Sysprep (or, for pre-2016 versions of Windows, click OK and confirm Yes to run Sysprep

and shut down the instance).

|_b Important: If you are using EC2Launch on Windows 2016, in the Ec2 Launch Settings dialog, be sure to leave
the Set Computer Name check box clear. This allows Sysprep to clear the computer name from the instance
as it shuts down, so that new instances launched from this image each receive a unique device name.

8. Only for Linux (for an EBS-backed image):
a. Navigate to your instance configuration.

For example, if you are creating a new instance, select the third tab across the top of your console,
showing 3. Configure Instance.

b. If necessary, scroll down, and expand the Advanced Details panel.

c. Inthe User data field, add the following two lines As text to ensure that each Linux instance reports a
unique device name in its inventory (lines are wrapped here for publication, but each command should be
entered on a single line):

sudo sed -i
"s/MachineID=/MachineID=$(curl
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http://169.254.169.254/1latest/meta-data/instance-id/)/g"
tmpconfig.ini
/opt/managesoft/bin/mgsconfig -i /var/tmp/
tmpconfig.ini

The first line replaces the unfinished MachineID setting in the tmpconfig. ini file with a setting
completed with the Instance ID, which is recovered in the standard way from the AWS metadata for the
current image. The second line runs a small FlexNet utility that merges the new value into the standard
config.ini for the Linux-based FlexNet inventory agent. These two lines of code are run as the instance
is being instantiated, before the FlexNet inventory agent is run. The result is that, whenever an instance is
launched from the image you are creating, FlexNet inventory agent takes the MachineID setting from
the config.ini file, and reports that unique device name as part of its uploaded inventory.

d. If yourinstance is running, stop it now. (Making an AMI from a stopped instance is preferred for lower risk
and better stability in your image.)

9. Monitor the Instances page in the Amazon EC2 console, until the state for your chosen instance displays stopped.
10. Follow your preferred process to create an AMI from that stopped instance.

For example, on Windows, since you have already installed AWS Tools for Windows PowerShell, you could use
the cmdlet New-EC2Image. For Linux, in the navigation pane, you can choose Instances, select your instance,
and then choose Actions > Image > Create Image, and provide the necessary details. For more information on
creating AMlIs, see either of:

o https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/Creating_EBSbacked_WinAMI.html
o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html.

This AMI is now ready to instantiate longer-life instances. As soon as each instance is spawned, FlexNet inventory agent
asks its bootstrap inventory beacon for policy. Once downloaded, its device policy triggers delivery of your global
schedule for inventory collection by the locally-installed FlexNet inventory agent, as well as the latest
InventorySettings.xml file that brings enhanced functionality.
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Appendices: Technical Data

The following topics do not include content you need for set-up or operation of the AWS EC2 connector. These are the
deep-down technical data that you can ignore until you have a real need.

Appendix 1: Cmdlets in the AWS EC2
connector

The connection from FlexNet Manager Suite to the AWS EC2 service relies on the AWS Tools for Windows PowerShell (as
described in Prerequisites and Setting Up). Within that toolset, the AWS EC2 connector uses the following PowerShell
cmdlets:

o Get-AWSRegion — To identify the available AWS geographic regions where your instances may be running

e Get-EC2Instance — To return the list of the instances (virtual machines) you own, and then collect summary

inventory details on each one
e Get-EC2Host — To identify any dedicated hosts you have available in each region

* Get-EC2ReservedInstance — To returninventory details on any instance/capacity you have reserved in an

Availability Zone
¢ Get-IAMUser — Used as a test for connection success

e Get-IAMPolicy — To retrieve information about the specified managed policy, including the policy's default

version and the total number of IAM users, groups, and roles to which the policy is attached

e Get-IAMPolicyVersion — To retrieve information about the specified version of the specified managed policy,

including the policy document
o Get-IAMAttachedRolePolicylist — Lists all managed policies that are attached to the specified 1AM role
o Get-IAMAttachedUserPolicylist — Lists all managed policies that are attached to the specified IAM user
e Get-IAMGroupForUser — Lists the IAM groups that the specified IAM user belongs to

e Get-STSCallerIdentity — To return details about the IAM user or role whose credentials are used to call the
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operation

e Get-IAMRole — To retrieves information about the specified role and the role's trust policy that grants permission

to assume the role

e Use-STSRole — To return a set of temporary security credentials that you can use to access AWS resources that you

might not normally have access to

o Set-AWSProxy — Specifies the proxy setting for the following interactions through other cmdlets

Appendix 2: Data Imported by AWS EC2
connector

The AWS EC2 connector returns information about each AWS instance, and its host. All instances are subsequently
displayed in the Cloud Service Provider Inventory page. Hosts are never displayed in this page, as in general hosting
is variable and controlled by AWS.
.
= Tip: One exception where you have direct control is the 'dedicated host' Like all other host types, dedicated hosts do
not appear in the Cloud Service Provider Inventory listing; but they do automatically appear in inventory device
listings, such as the All Inventory page, where you can search for them using the Hosted in property. Any instances
from the Cloud Service Provider Inventory listing that are hosted on your dedicated host also display a link to the
dedicated host properties in the Host column.

Instance data
-
= Tip: All kinds of instances return this set of data, whether they are virtual machines or bare metal instances. The
latter return an Instance type starting with 13..

If the data gathered through the AWS EC2 connector matches inventory collected from another source, the Cloud
Service Provider Inventory page includes a hyperlink to open the inventory device properties page for the instance.
Putting that another way, inventory device records are not created when the AWS EC2 connector is the sole source of
information; but they are created when inventory is returned from another source that covers the cloud instance (one
possible example is having FlexNet inventory agent running locally on the instance). In this latter case, linked records
exist in both the ComplianceComputer and CloudServiceInstance tables.

Some data is additional to the normal content collected as inventory. For example, the InstanceTenancyID, used for
identifying whether the current device is aDedicated instance,orisaninstance runningOn dedicated host,is
imported into the CloudServiceInstance table, and, as Availability type, is visible in both the Cloud Service
Provider Inventory page and the Cloud Hosting tab of the inventory device properties (where inventory exists for the
instance).

-

= Tip: AWS "bare metal instances" behave like other instances in terms of data gathered and records created.
When there is an inventory device record for an instance, the inventory-related values imported through the AWS EC2

connector (and shown below in alphabetical order) are displayed in the separate Cloud Hosting tab of the inventory
device properties:

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

189



Appendices: Technical Data

e Availability type

e Availability Zone

« Cores

e« Creation date (andtime)

e Host ID (useto linkto host)

o Image ID (forthe AMI, or Amazon Machine Image, from which the instance was instantiated)
¢ Instance ID

e Instance region

« Instance type

e« Last known state

e Lifecycle mode (displayed as Lifecycle in the Cloud Service Provider Inventory page, and as Purchased option

in the Cloud Hosting tab of the inventory device properties)
e MAC address
e Network ID

e Threads per core.

Host data

If the host is a "dedicated host" (which means that your enterprise has exclusive use and detailed control), an inventory
device record is automatically created for the dedicated host in the ComplianceComputer table (with the resulting
property sheet). Separate inventory device records are not created for any other kind of host; and hosts (other than
dedicated hosts) are not listed separately on the Cloud Service Provider Inventory page.

.
= Tip: For dedicated hosts, the following properties are displayed on the Cloud Hosting tab of the inventory device
properties.

The following properties (listed alphabetically) are collected for hosts of all types through the AWS EC2 connector:

e Availability Zone
¢« Cores

e Creation time

¢ Host ID

e Instance region

« Instance type

e SocketsVcpu.
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Appendix 3: Enhanced Inventory Gathered
by Agent

As well as the high-level data gathered from the AWS EC2 connection, FlexNet inventory agent (version 13.1 or later)
gathers addition inventory data for each AWS instance where FlexNet inventory agent is locally installed. To do so,
FlexNet inventory agent accesses two AWS-internal URLs:

e http://169.254.169.254/1latest/meta-data/instance-id returnsthe unique identifier for the AWS EC2
instance.

e http://169.254.169.254/latest/dynamic/instance-identity/document returns a JSON-formatted
value containing data about the instance where FlexNet inventory agent is locally installed. For example:

{
"devpayProductCodes" : null,

"marketplaceProductCodes"” : [ "labc2defghijklm3nopgrs4tu"” ],

"availabilityZone" : "us-west-2b",
"privateIp" : "10.158.112.84",
"version" : "2017-09-30",

"instanceId" : "i-1234567890@abcdef0",
"billingProducts” : null,
"instanceType" : "t2.micro",
"accountId" : "123456789012",

"imageId" : "ami-5fb8c835",
"pendingTime" : "2018-11-19T16:32:1172",
"architecture" : "x86_64",

"kernelId" : null,
"ramdiskId" : null,
"region" : "us-west-2"

These two data points are then embedded within the normal . ndi inventory file as a pseudo-hardware WMI class
called MGS_AWSComputerSystem. The class looks similar to this example (lines wrapped for presentation):

<Hardware class="MGS_AWSComputerSystem" Name="ec2amaz-vrkiu@p" Evidence="metadata">
<Property Name="instance-id" Value="1i-1234567890abcdef0"
Evidence="/latest/meta-data/instance-id"/>
<Property Name="document" Value="ewogICJwcml2YXR1SXAiIDogIjE3Mi4zMS4yLjEXxNiIs...."
Evidence="/latest/dynamic/instance-identity/document”/>
</Hardware>

After a full inventory import, these details are eventually saved in the CloudServiceInstance tablein the
compliance database.
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This part introduces the FlexNet connector to Microsoft Azure, enabling you to collect Azure virtual machine inventory
data, managed by Azure Resource Manager.

The connector to Azure is only a part of a complete "bring your own software license", or BYOSL management strategy for
instances (typically, virtual machines that are tracked as inventory devices) that are hosted for you by this cloud service
provider. By itself, the connector does not gather sufficient data to allow for license management: for example, it does not
gather software inventory for the applications that are running on your cloud-hosted devices.

For that reason, this part covers more than the connector itself. As well as details of prerequisites, set up, and data
gathering with the connector, the part includes some insights into:

» Processes for gathering complete hardware and software inventory for your cloud-based instances
« Considerations for license management

In fact, using those guidelines, you could configure inventory gathering in Azure without using the connector at all.
Provided that you are deploying the latest FlexNet inventory agent (13.2.x or later), inventory alone even returns the
cloud service provider. What the connector adds is:

» Automatically setting the Hosted in property in the inventory device records created when inventory is returned

« Adding the cloud service provider and instance details when these are missing from inventory collected by legacy
versions of FlexNet inventory agent, or from third-party inventory sources

» Populating the Cloud Service Provider Inventory page with records of instances currently running in your Azure
environment, including a few properties that are additional to the normal hardware and software inventory

« Importing permanent records of instances that were previously running but that have now been terminated (and for
which, as a result, any prior inventory devices records have now been deleted)

» Triggering automatic deletion (completed at the next fullimport and compliance calculation) of any inventory device
record linked to an instance that is now terminated.

This part focuses on background about the connector, and additional material you need in order to build license
management around the connector. You will not find details about making the actual connection here.

—
=3

|==| Note: The Microsoft Azure inventory connector does not collect virtual machine inventory for virtual machines managed
by Microsoft's classic deployment model. For these devices we recommend you use an alternative such as the inventory
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spreadsheet upload, the Business Importer or simply through editing manually.

—
1=

I=| Note: Containers are not currently supported.

Step-by-step instructions for configuring the connection to Azure are available in the online help at FlexNet Manager
Suite Online Help > Inventory Beacons > Inventory Systems Page > Connecting to External Inventory Systems >

Managing PowerShell Connections > Managing Azure Connections.
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Prerequisites and Setting Up

The connector to Microsoft Azure is configured on a convenient inventory beacon, for which there are the following
prerequisites:

o The operating system is either:

o Windows Server 2008 R2 SP1 or later
o Windows 7 SP1 or later.
¢ FlexNet Beacon software has been updated to release 13.2.x.x (2018 R1) or later
« PowerShell 5.1 or later is running
o The Azure adapter requires a service principal identity with read permission to Microsoft.Compute/virtualMachines
» FlexNet inventory agent version 13.2.x.x (2019 R1) or later
» The PowerShell execution policy is set to RemoteSigned
* Aweb browser is available

¢ AzureRM for Windows PowerShell version 5.1 or later is installed

¥
= Tip: To check the version installed on your inventory beacon:

1. As administrator, run AzureRM for Windows PowerShell.
2. Execute the $psversiontable cmdlet.

New versions are available for download from https://www.powershellgallery.com/packages/AzureRM.
« You must log onto the inventory beacon, and run FlexNet Beacon, using an account with administrator privileges.
On the Azure side, you must first create:
» Aservice principal identity

Step-by-step instructions for configuring the connection to Azure are available in the online help at FlexNet Manager
Suite Online Help > Inventory Beacons > Inventory Systems Page > Connecting to External Inventory Systems >
Managing PowerShell Connections > Managing Azure Connections.
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Thinking about Inventory and
Licensing

In many ways, collecting inventory and working out license consumption for instances in Microsoft Azure is much the
same as licensing virtual machines on host servers sitting within the datacenter in your own offices. However, there are
some differences that are worth thinking about. For example, within your own datacenter, you have full control of, and
presumably full inventory for, the host server as well as the VMs running on it; and for some license types, host details
are relevant even when licensing software on a virtual machine. Depending on what you purchase, this may not be the
case in Microsoft Azure.

The following topics bring together some points to consider, first about inventory collection, and then about licensing.

Collecting Inventory from Instances

The connector to Microsoft Azure gathers useful information, but it cannot gather information valuable for license
consumption calculations from each of the instances running in your Azure cloud. To gather useful inventory from all
instances, best practice is to include the FlexNet inventory agent (release 13.2.buildNumber or later) in the Microsoft
Azure managed VM image from which your devices are instantiated. For details, see the Azure documentation Create a
managed image of a generalized VM in Azure for Windows, or for Linux see How to create an image of a virtual machine
or VHD.

Unique device naming is critical

It is critical to your license management in Microsoft Azure to ensure that each instance is uniquely named on
instantiation. If you do not do this, incoming inventory reports are not differentiated, and are interpreted as updated
inventory from a single device, named with the default device name provided by the base image.

By default, the internal name of a virtual machine is the same as the external name given to it when it is created. While
you can change the internal name of a virtual machine, you cannot change the external name of the virtual machine as
displayed in the Azure portal.

Resource names for virtual machines are immutable. So, you will need to redeploy your virtual machine. You can do
this by deleting the current virtual machine, while maintaining the current virtual machine disks, and then creating a
new virtual machine using the correct name and point it to the previously maintained disks.
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To ensure a device name for each instance that is unique over time, methods vary across platforms, and are detailed in
following topics. In summary:

o The easiest method on Windows is to use Sysprep when creating your managed VM image, leaving the name unset

so that a new name is provided on instantiation.

o For Linux, if you already provide for unique Hostname values on all your instances, no further action is required; and
otherwise, a little extra preparation can ensure that the unique InstanceID for each instance is also returned in
inventory as the MachineID, where it differentiates all returned inventory as coming from devices with distinct

names.

Schedule specialization
Scheduling inventory collection by the locally-installed FlexNet inventory agent requires:

o Provide an upload location (ManageSoftRL) for inventory collection

« Omitany download location, since the instance life-cycle is projected to be too short to require any policy update or
system-wide schedule update

« Trigger inventory collection on start-up, followed immediately by inventory upload to the defined ManageSoftRL
(this cycle might typically require 3-5 minutes all up, a figure which may change based on other customizations you
may want to include in your managed VM image)

o Provide a back-up schedule of daily inventory collection.

» Keep in mind, as well, that removing the normal paths for policy update also removes the normal updates to
InventorySettings.xml, which includes arange of advanced capabilities for FlexNet inventory agent, including
Oracle inventory collection and advanced inventory techniques for Microsoft and other vendors. Your strategy
therefore includes embedding your most recently downloaded InventorySettings.xml in your managed VM
image (and later, updating it as required). For more guidance on customizing instances, see Configuring an Azure VM

Image for Instances.

Planning your inventory beacons

The final major question is the location of your inventory beacon(s) for uploading inventory data from these instances.
Depending on the reliability of network communications between your cloud-based instances and your own enterprise
network, you may choose either:

« Torun (at least) one instance within your Azure cloud as an inventory beacon, ready 24/7 for any of your instances in
the cloud to upload their inventory. This is especially valuable for instances, where the locally-installed FlexNet
inventory agent has no opportunity to retry uploads around any network failures; and where fast network speeds
may best support your planned life-cycle for these instances. The cloud-based inventory beacon can then provide a
more rugged upload to your enterprise network, since it has longer up-time and built-in mechanisms for retrying
any uploads that are interrupted by transient networking issues.

« Run an inventory beacon within your enterprise network (or even, potentially, in a demilitarized zone outside your
firewall), to which all the cloud-based instances have network access, allowing them to upload their inventory files
as and when needed.

Choosing between these alternative places for your inventory beacon may require balancing questions of security and
performance against cost. Whichever choice you make, a good practice is to use a DNS alias to identify the inventory
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beacon, so that you can quickly and easily make changes without disrupting the rest of your infrastructure.

i
= Tip: As for all communication between your enterprise network and the Microsoft Azure network, an Amazon Virtual

Private Cloud (VPC) is required for either of the above architectures; and if you require a link from your inventory
beacon in the Azure cloud to your central application server in your datacenter, consider a hardware VPN connection
as well (see the Microsoft Azure documentation for details).

Keep in mind that an inventory beacon does not normally initiate ('push') communication to FlexNet inventory agents
installed on your Microsoft Azure instances. (The only exceptions are for the 'remote execution' tasks known as
adoption and zero footprint inventory collection, neither of which you expect to use in a cloud environment.) Since all
other communications are initiated by the FlexNet inventory agent ('pull' communications, such as policy updates,
collection of self-update packages, and the upload of inventory), this means that your implementation only needs to
point the FlexNet inventory agent on each instance to its bootstrap inventory beacon (as described in following topics).
You do not need to known details like the IP addresses (public or private) for the instances reporting inventory through
the FlexNet inventory agent.

Inventory records and exceptions

After a full inventory import and license reconciliation, you can expect to see records created/updated in FlexNet
Manager Suite as follows:

» Forevery instance where the locally-installed FlexNet inventory agent has uploaded inventory, an inventory device

record

« Similarly, for every instance reporting inventory through a third-party tool (such as SCCM), an inventory device
record

» For every cloud instance appearing in data from the Azure PowerShell connector, regardless of whether it appears in
uploaded inventory or not, a cloud instance record in the CloudServiceInstance table (and of those, the ones

that also have an inventory device record show a link to it in the Cloud Service Provider Inventory page)

o For dedicated hosts identified through the Azure PowerShell connector (and only dedicated hosts, not any other kind
of host), an inventory device record for the host.

You will not find inventory device records for any of the following:

« Acloud instance that does not report inventory

* Ahost device that is anything other than a dedicate host (such as a default host, or a host for dedicated instances)
* Any instance that you have terminated.

Terminated instances are a special case.

1. Before termination, the running instance may have had an inventory device record (provided that it was reporting
inventory).

2. When you terminate the instance, Microsoft Azure keeps the terminated instance visible through the API for about
an hour, and if you have implemented your Azure PowerShell connector on an inventory beacon with the default
30 minute schedule, the termination is imported through the connector, and the record in the
CloudServicelInstance tableis updated with the terminated status. (This record, with its terminated status, is
visible in the Cloud Service Provider Inventory page, if you set the filters on that page appropriately.)

3. Atthe next full inventory import (by default, overnight, immediately before the license compliance calculations),
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any inventory device record linked to a terminated instance is deleted, because you do not want terminated
instances consuming from your licenses.

. Of course, the terminated instance no longer reports inventory; but its previously-recorded inventory is still in the

inventory database (and in normal processes is not cleaned up for a while). Although the next full import (typically
the next night) normally imports records from the inventory database, for terminated instances this is prevented
by the terminated flag in the CloudServiceInstance table. This prevents the deleted inventory device record

from reappearing.

Should you ever need to review the software previously installed on a terminated instance, you can:

1.

2,

Navigate to Discovery & Inventory > Cloud Service Provider Inventory.

Change the default filter (top left) for Include terminated instances to Yes.

. Optionally, filter the Last known state column to show only Terminated.

. Optionally, use other filters, such as Instances reported in an appropriate period, or the Instance type and

Instance region columns, to narrow your search for this instance.

. Check the Image ID column to identify the original image from which this instance was launched (you may need

to drag this column out of the column chooser).

. Through your Azure console, identify this managed VM image, and inspect its software load and resulting license

impacts.

Data integration

Inventory from a hosted instance may come from multiple sources, and must be integrated correctly. Various rules are
used depending on the sources being combined:

» PowerShell connector + current FlexNet inventory agent are linked by:

o CloudServiceProviderID (displayed as the Cloud service provider name in the web interface)

Matching of the incoming data with existing inventory device records (that is, determining whether this is an update to
an existing record, or a new record) uses the standard device matching rules, with the Cloud service provider and

Instance ID checked as last priority.

Finally, the merging of data between the PowerShell connector and the current FlexNet inventory agent uses these

priorities:

1.

2.

198

If one source contains a data point that the other does not, the data is used.

If both sources contain the same data point but with different values, the data with the most recent inventory date
is used.

. If different values were imported on the same day, the FlexNet inventory agent is given priority if it has been set as

the primary inventory source.

Otherwise, the data is used from the most recently created inventory source, with the winning source visible in the
inventory device properties as Last inventory source.
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BYOSL Licensing Considerations

Full software and hardware inventory may be returned from an Microsoft Azure instance when either:

« FlexNetinventory agent is locally installed on the instance, usually because it is part of the Azure VM Image from
which the instance was launched

» You have some third-party tool (such as Microsoft SCCM) collecting inventory from your Azure instances, and these
results are then being imported into FlexNet Manager Suite.

Whatever the method, when inventory is returned from a running Microsoft Azure instance, it has an inventory device
record in FlexNet Manager Suite. As always for all inventory devices, the installations found in software inventory for
that device consume entitlements from the licenses to which each software record is linked.

However, there are a few special adjustments for inventory from Microsoft Azure instances.

Beware of terminating instances

For some special purposes, instances in the Microsoft Azure cloud may be launched, run for a short period (from a few
minutes to a few hours), and then shut down until needed again.

Itis quite possible to configure the Azure VM Image from which instances are launched so that inventory is collected
and uploaded through one or more inventory beacons to your FlexNet Manager Suite application server (for details, see
Configuring an Azure VM Image for Instances).

However, the licensing implications are quite different when you stop an instance than when you terminate an instance:

« The assumption is that a stopped instance may be restarted when required, and resume operation with (quite likely)
the same software installed. It is therefore reasonable to calculate license consumption for such an instance, and, if
you use the configuration described in Configuring an Azure VM Image for Instances, this happens as usual for virtual
machines (whether those are VMs within your enterprise network or instances in the cloud).

o Aterminated instance cannot be restarted, and if you are choosing BYOSL for instances that you terminate, you
should check your license terms carefully and make appropriate provision. The working assumption in FlexNet
Manager Suite is that a terminated instance should no longer consume from your software licenses, just as license
consumption stops when you uninstall software from a device, or decommission a hardware asset. As described in
Collecting Inventory from Instances, this is achieved by permanently deleting any inventory device record that may
have previously been created for the instance that is now terminated. All resources attached to the terminated
instance will remain and you can then manually delete these resources as desired. (See the same topic for a way of
re-discovering the software load for a terminated instance, and hence its potential license implications.)

The complexity of managing licenses on transient instances is why it is more common to purchase these based on a
fully-loaded image provided by (and licensed through) Microsoft Azure. However, if you need repeated runs of an
instance for special purposes, and such an instance must include software for which you provide the license (BYOSL),
consider running such an instance as a stop/start instance, rather than terminating it and re-launching it, to simplify
your license management.

Thirty-minute inventory and IBM PVU licenses

The default schedule for the Azure connector is to have it run every 30 minutes. Coincidentally, this happens to be the
same interval that IBM requires for hardware checks of devices linked to IBM PVU licenses (when you have IBM's
approval to use FlexNet Manager Suite as the source for sub-capacity licensing calculations, for which see the Sub-
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Capacity Licensing with IBM PVU chapter of the FlexNet Manager Suite System Reference PDF, available through the title
page of online help).

However, each of these coincidental but distinct schedules has its own separate reasons:

o The Azure connector should run every 30 minute to allow it to capture transient information that Azure keeps
available for only an hour, so that you can track your terminated instances where required. This is the connector
schedule, and the connector does not return sufficient inventory detail to satisfy the IBM requirements.

o The hardware check for IBM PVU licenses must run every 30 minutes as part of your amended contractual agreement
with IBM. This is an inventory schedule that controls operations of FlexNet inventory agent embedded on an
operational instance.

If you are providing IBM PVU licenses for use in the Microsoft Azure cloud, and have the IBM amended agreement to
allow sub-capacity calculations within FlexNet Manager Suite, these two default schedules conveniently satisfy both
requirements within Azure. However, be aware of the following requirements:

¢ IBM PVU licenses in the BYOSL model are not appropriate for short-lived instances that are then terminated (see
previous section about the pitfalls of terminating instances with BOYSL). Start/stop operations can be used when
necessary, as long as the instance is maintained and not terminated.

« Persistent (unchanging) inventory device names and matching instance IDs are critical to this license model,
allowing proper calculations of peak consumption values over time. For details about setting a unique but persistent

device name for inventory, see Collecting Inventory from Instances.

o Asalways, full hardware and software inventory (from the instance) is required for IBM PVU licensing. Compliance
with your IBM license requires regular software inventory (daily is recommended best practice) as well as the
30-minute hardware check. Use of the FlexNet inventory agent is also mandated by your adjusted license
agreement. The techniques in Collecting Inventory from Instances prepare an Azure VM Image from which you can
launch instances with the operational FlexNet inventory agent embedded, satisfying those requirements.

o Asalways, the first full software and hardware inventory must be uploaded and processed on the central application
server before the 30-minute hardware checks take effect. (This allows the calculation of updated rule targets that
identify all devices affected by IBM PVU licensing processes.) Typically the relevant compliance calculations take
place overnight, after which the revised device policy must be distributed through the inventory beacon hierarchy to
affected installations of FlexNet inventory agent, bringing with it the special schedule for the hardware check. All of
this process means that in the normal course of events, IBM PVU operations typically are running effectively from the
day after an instance is launched with PVU-licensed software in operation.

Uncapped calculations except on dedicated hosts

Some license types allow that, where the total license liabilities for many VMs on the same host theoretically exceed
factors like the total number of cores available on the host, the summing process is 'capped' or given an upper limit by
the actual capacity of the host. For example, if five VMs on a host are each allocated 2 cores, for a total of 10 allocated
cores when the host actually only has 8 cores available, then, just as in reality the time-sharing between the VMs limits
the cores in use at any moment, so also the license rules cap (or reduce) the calculated figure (10 cores) to the total
capacity of the host (8 cores).

Obviously, capping of consumption calculations requires inventory not only of all the VMs on a host, but also of the
host itself. However, in the case of Microsoft Azure instances, inventory details are not available for any host types other
than 'dedicated hosts', over which you have full control. This means that on all other, non-dedicated hosts in Azure,
capping of license calculations cannot occur.
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All calculations for BOYSL licensing of instances on non-dedicated Azure hosts are based entirely on the inventory taken
from the instances themselves, without capping. This does not expose you to any risk of under-licensing (provided that

allinstances are returning inventory); the only risk is that you may perhaps be over-calculating the consumption that
might apply on a known host with capping applied.

However, this may not be an issue at all. Carefully check your BYOSL terms and use rights. You may find that software
publishers already disallow capping in cloud environments, because of the impossibility of tracking instances that may
pop up now on this host and now on another, depending on resource allocations within Azure.
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Configuring an Azure VM Image for
Instances

The easiest way to collect inventory from all your cloud-based instances is to ensure that they are launched from an

Azure image that already contains everything needed for the collection of FlexNet inventory. The requirements include:

Installing the latest approved FlexNet inventory agent into the image
Adding a customized configuration file that identifies the upload location for inventory

Installing a customized schedule to manage FlexNet inventory agent in the resulting instances, triggering inventory
gathering on start-up (and best practice is to include a backup schedule for further inventory collection in case an
instance from this AMI runs for an unexpectedly long time)

Including the current version of InventorySettings.xml that provides advanced functionality for FlexNet

inventory agent, since the short lifetime does not allow for normal policy-based downloads

Ensuring a unique name for each instance created from this Azure VM Image.

At this summary level, the requirements are the same for Windows and Linux platforms. In the details, of course, there

are platform specifics.

=
[_] To prepare an Azure Resource Image:

1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.

The Inventory Settings page displays.

2. Expand the Inventory agent for download section.

3. Collect the template configuration file:

o For a Windows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

« For a Linux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
mgsft_rollout_response in a convenient working folder (such as C:\temp).
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4. From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your
AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for Microsoft Azure, you must use FlexNet inventory
agent 13.2.0 or later (see Appendix 3: Enhanced Inventory Gathered by Agent).

5. Inyour preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory agent
in your Microsoft Azure environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the upload location for gathered inventory, as described
below. On Linux, FlexNet inventory agent requires both an upload location and a download location. As always,
on either platform, experts may also customize other preferences needed for your implementation, as described
in the platform-specific topics in the Gathering FlexNet Inventory PDF:

o Agent third-party deployment: Edit the Configuration File for Microsoft Windows
» Agent third-party deployment: Configure the Bootstrap File for UNIX.

The upload (and download) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the virtual machine image.

o ForWindows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the

following settings:

; Registry settings to be created under
; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]

desc@ = UploadSettings\Bootstrap Server\Protocol
vale = http

descl = UploadSettings\Bootstrap Server\Priority
vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority
val2 = False
desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com
desc4 = UploadSettings\Bootstrap Server\Port
vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory
val5 = /ManageSoftRL/

b. Optionally, modify the Protocol value if you want to use HTTPS (vale = https).

c. You must customize the Host preference (shown above as val3 = beacon.fnms.com) to your chosen
DNS alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in
your enterprise network rather than on an Azure instance. For an inventory beacon hosted on an Azure
instance, you can identify its public and private DNS hostnames on the Azure console (select Instances in
the navigation pane, choose the instance hosting the inventory beacon, and read both its public and private
DNS hostnames in the details pane).
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i Tip: Ifyou have an inventory beacon on an Azure instance, your installations of FlexNet inventory agent
on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

d. Optionally, customize the port setting (for example, if you are switching to the HTTPS protocol, the default
portis 443).

RJ Important: The Directory preference is mandatory, and must be set as shown above.

e. Create a subfolder (such as SysPrepAgent) and save your edited mgssetup. ini there. Do not change the
file name, which is mandatory.

e ForLinux,inmgsft_rollout_response:

a. Inthe first section of the file, customize the setting for the download location (see also the comments for
the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/ManageSoftDL/

# Refer to the documentation for further details.
MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/

b. In the next section of the file, customize the setting for the reporting (upload) location:

# The initial reporting location(s) for the installation.

# For example, http://myhost.mydomain.com/ManageSoftRL/

# Refer to the documentation for further details.
MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as required.
You must customize the host URL (shown above as beacon . fnms. com) to your chosen DNS alias (or
preferred host setting) and your own enterprise name if the inventory beacon is located in your enterprise
network rather than on an Azure instance. For an inventory beacon hosted on an Azure instance, you can
identify its DNS hostname on the Azure console (select Instances in the navigation pane, choose the
instance hosting the inventory beacon, and read its DNS hostname in the details pane).

R] Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Inthe last line of the file, switch the value to prevent policy running after installation, as short-lived
instances do not have time to wait for policy and its outcomes:

MGSFT_RUNPOLICY=0

d. Create a subfolder (such as SysPrepAgent) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

e. Unless you already have a strategy and practice that gives every Linux instance a unique name, also create a
new text file for your Linux virtual machine image, called tmpconfig. ini, with exactly the following two
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lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

6. For either platform, copy the following and paste it into a plain ASCII text file, and save it in your SysPrepAgent
folder as DefaultSchedule.nds (this file name is mandatory). Of course, you may choose to unwrap those lines
wrapped for readability here.

<?xml version="1.0" encoding="UTF-8"?>
<!IDOCTYPE Schedule PUBLIC "Flexera Inventory Manager schedule"
"http://www.managesoft.com/dtd/schedule.dtd">

<Schedule NAME="Default Schedule" TIMEDATESTAMP="20180903T044104Z"
SCHEDSCHEMA="60">
<Event NETWORK="False"
NAME="Generate Inventory"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="0" TIMESTART="143950"
DATESTART="20180903" TYPE="Logon" MAXDELAY="0"/>
</Event>
<!-- Following two events are optional (see notes) --!>
<Event NETWORK="False"
NAME="Generate Inventory" IDLEDURATION="86400"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="1" TIMESTART="001000"
DATESTART="20180903" TYPE="Daily" REPEAT="21600"
TIMEWINDOW="3600" DURATION="86400"/>
</Event>
<Event NETWORK="False"
NAME="Upload Client Files"
CATCHUP="Never" ID="{9CB87BAE-2829-498C-8643-10A9BD3BFA56}">
<LogicalCommand PARAM="-a"
ACTION="Upload" COMPONENT="Uploader"/>
<Trigger TYPE_PARAM="1" TIMESTART="002000"
DATESTART="20180903" TYPE="Daily" REPEAT="600"
DURATION="86400"/>
</Event>
</Schedule>

The first event in this schedule triggers machine inventory collection on startup (TYPE="Logon"), and the
tracker component automatically attempts an upload to the bootstrap inventory beacon as soon as inventory
gathering is complete. If you are certain that all instances from this image are short-lived, only this event is
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required. If you are using an instance, and you choose to stop and restart your instance (rather than to terminate
and re-launch it), this inventory is checked on each restart.

In addition, two further schedule events provide easy management of cases where an instance proposed to have a
short life in fact keeps on running for some longer time.

The second event also generates inventory, and is triggered every 6 hours (REPEAT="21600", with all times
expressed in seconds), to start within an hour thereafter (TIMEWINDOW="3600"). However, this inventory
collection is different than the first case, because here the FlexNet inventory agent does not repeat the inventory
collection if it has been successful within the last 24 hours (IDLEDURATION="86400"). This means that,
effectively, the FlexNet inventory agent checks four times a day whether there has been a successful inventory
collection in the last 24 hours, and if not, it runs a new inventory collection.

In a perfect world, the third event is redundant because the tracker component uploads inventory as soon as it
is collected. This third, separate upload event is a catch-up to work around transient network issues. It checks
every 10 minutes to see whether any inventory files have failed to upload (and are therefore still waiting in the
staging folder). In normal cases, nothing is waiting, and the uploader shuts down immediately, causing
negligible load on the instance. But where there have been networking issues, upload is attempted again every 10
minutes until all files are successfully uploaded and removed from the staging folder.

7. Ona convenient inventory beacon, navigate to %CommonAppData%\Flexera Software\Staging\Common\
ClientConfiguration,take a copy of InventorySettings.xml, and save it to your SysPrepAgent working
folder.

This completes the preparation of materials for your virtual machine image for instances of this expected life. Now
continue to use these materials to prepare the virtual machine image. For both platforms, the high-level process is
to customize a running instance, and then save it as a virtual machine image.

For a Windows-based VM Image please refer to the following link:

e https://docs.microsoft.com/en-us/azure/virtual-machines/windows/tutorial-custom-images
For a Linux-based VM Image please refer to the following link:
o https://docs.microsoft.com/en-us/azure/virtual-machines/linux/tutorial-custom-images

8. Following the Azure documentation, select (or create), launch and connect to your chosen instance from which you
are creating your Azure VM Image.

9. To customize your instance:
a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create it.

The default paths for each platform are:

e OnWindows, C:\Program Files (x86)\ManageSoft
e OnLinux, /opt/managesoft/bin.

b. From your local SysPrepAgent working folder, copy these files into the destination folder on your
instance:

e DefaultSchedule.nds
e InventorySettings.xml

e Only on Windows, mgssetup.ini
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e OnlyonLinux, tmpconfig.ini.
c. For Linux only, also copy your amended mgsft_rollout_response fileto /var/tmp/ on yourinstance.

d. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the installer
on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
Inventory PDF, focusing on the installation topic for your preferred platform.

e. When installation is complete, in the same destination folder and for both platforms, run the following
command to install your default schedule:

start ndschedag.exe -t machine .\DefaultSchedule.nds

This virtual machine image is now ready. As soon as each instance is spawned, the embedded FlexNet inventory agent
gathers inventory from the instance, and immediately uploads it to the bootstrap inventory beacon. Depending on the
resources on each instance, this process may take around 2-5 minutes, after which the instance can be stopped (but
remember, not terminated if you wish to track related software licenses in FlexNet Manager Suite).
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Appendices: Technical Data

The following topics do not include content you need for set-up or operation of the Microsoft Azure connector. These are
the deep-down technical data that you can ignore until you have a real need.

Appendix 1: Cmdlets in Azure PowerShell

The connection from FlexNet Manager Suite to the Microsoft Azure service relies on the AzureRM Tools for Windows
PowerShell (as described in Prerequisites and Setting Up). Within that toolset, the connector uses the following
PowerShell cmdlets:

e Connect-AzureRmAccount — To log into Microsoft Azure
e Disconnect-AzureRmAccount — To log out Microsoft Azure

e Get-AzureRmVM — To return the list of the instances (virtual machines) you own, and then collect summary

inventory details on each one

o Get-AzureRmLocation — To identify the available Azure geographic regions of the instance type (size in Microsoft

term) where your instances may be running

e Get-AzureRmVMSize — To return the list of the instances type based on location.

Appendix 2: Data Imported by Microsoft
Azure Connector

The PowerShell connector for Microsoft Azure returns information about each Azure instance, and its host. All instances
are subsequently displayed in the Cloud Service Provider Inventory page. Hosts are never displayed in this page, as in
general hosting is variable and controlled by Microsoft Azure.

(2]
W Tip: One exception where you have direct control is the 'dedicated host'. Like all other host types, dedicated hosts do
not appear in the Cloud Service Provider Inventory listing; but they do automatically appear in inventory device

listings, such as the All Inventory page, where you can search for them using the Hosted in property. Any instances
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from the Cloud Service Provider Inventory listing that are hosted on your dedicated host also display a link to the
dedicated host properties in the Host column.

Instance data

7
= Tip: All kinds of instances return this set of data, whether they are virtual machines or bare metal instances. The
latter return an Instance type starting with 13..

If the data gathered through the connector matches inventory collected from another source, the Cloud Service
Provider Inventory page includes a hyperlink to open the inventory device properties page for the instance. Putting
that another way, inventory device records are not created when the Azure connector is the sole source of information;
but they are created when inventory is returned from another source that covers the cloud instance (one possible
example is having FlexNet inventory agent running locally on the instance). In this latter case, linked records exist in
both the ComplianceComputer and CloudServiceInstance tables.

Some data is additional to the normal content collected as inventory. For example, the InstanceTenancyID, used for
identifying whether the current device is aDedicated instance, orisaninstance runningOn dedicated host,is
imported into the CloudServiceInstance table, and, as Availability type, is visible in both the Cloud Service
Provider Inventory page and the Cloud Hosting tab of the inventory device properties (where inventory exists for the
instance).

7
= Tip: Azure "bare metal instances" behave like other instances in terms of data gathered and records created.

When there is an inventory device record for an instance, the inventory-related values imported through the Microsoft
Azure connector (and shown below in alphabetical order) are displayed in the separate Cloud Hosting tab of the
inventory device properties:

e AvailabilityZone (state of the instance, will be mapped to Started, Stopped, or Unknown)
¢ CoreCount

¢ ImageID

e« InstanceCloudID (Azure VmId, whichis also UUID of the VM)

¢ InstanceType

e Region

¢ VMEnabledStatelID.

Appendix 3: Enhanced Inventory Gathered
by Agent
As well as the high-level data gathered from the Microsoft Azure connection, FlexNet inventory agent (version 13.1 or

later) gathers addition inventory data for each Azure instance where FlexNet inventory agent is locally installed. To do
so, FlexNet inventory agent access the following Azure-internal URL:

e curl -H Metadata:true "http://169.254.169.254/metadata/instance?api-version=YYYY-MM-DD"
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— you must replace YYYY-MM-DD with the api-version date to return the unique identifier for the Azure instance. For
example, curl -H Metadata:true "http://169.254.169.254/metadata/instance?api-
version=2018-10-01".

o Toview the api-version dates enter curl -H Metadata:true "http://169.254.169.254/metadata/

instance" which will return an error message which identifies the api-versions. For example:

{

"error": "Bad request. api-version was not specified in the request. For more
information refer to aka.ms/azureimds", "newest-versions": [

"2018-10-01",

"2018-04-02",

"2018-02-01"

]

}

e http://169.254.169.254/metadata/instance returns a JSON-formatted value containing data about the
instance where FlexNet inventory agent is locally installed. For example:

{
"devpayProductCodes" : null,
"marketplaceProductCodes"” : [ "labc2defghijklm3nopgrs4tu" ],
"availabilityZone" : "us-west-2b",
"privateIp" : "10.158.112.84",
"version" : "2017-09-30",
"instanceId" : "i-1234567890abcdef0",
"billingProducts” : null,
"instanceType" : "t2.micro",
"accountId" : "123456789012",
"imageId" : "ami-5fb8c835",
"pendingTime" : "2018-11-19T16:32:11Z2",
"architecture" : "x86_64",
"kernelId" : null,
"ramdiskId" : null,
"region" : "us-west-2"

These two data points are then embedded within the normal . ndi inventory file as a pseudo-hardware WMI class
called MGS_CloudMetadata. The class looks similar to this example (lines wrapped for presentation):

<Hardware class="MGS_CloudMetadata" Name="ec2amaz-vrkiu@p" Evidence="metadata">
<Property Name="instance-id" Value="1i-1234567890abcdef0"
Evidence="/latest/meta-data/instance-id"/>
<Property Name="document" Value="ewogICIwcml2YXR1SXAiIDogIjE3Mi4zMS4yLjEXNiIs...."
Evidence="/latest/dynamic/instance-identity/document”/>
</Hardware>

After a full inventory import, these details are eventually saved in the CloudServiceInstance tablein the
compliance database.
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Data Platform Integration

This part introduces the integration between FlexNet Manager Suite and Data Platform, an umbrella product that includes
both Technopedia and Normalize.

The method of integration is a straight-forward connector, available without special installation on your inventory
beacons (including any inventory beacon you may have installed on your central application server). On the Data
Platform side, an enhanced license term and a new data pack are required (see Configuring the Data Platform Connector
for details).

Such simplicity means that the main use for the documentation in this part is to understand the mapping between
« Database tables and columns that underlie Normalize, and
o The destination tables and columns in the compliance database for FlexNet Manager Suite.

Also important is the embedded commentary on the current limitations of Data Platform as a sole data source driving
license compliance calculations. When you have multiple inventory sources, imports from Data Platform can be a
valuable addition to your data gathering.

Supported version

The Data Platform v5 connector supports import only from version 5 of Normalize.
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Data Platform version 5 (formerly from BDNA, and now from Flexera) combines Technopedia, a reference catalog with
120 million datapoints across more than 1.7m products, and Normalize, which provides a unified view of the data
applicable to your environment.

To integrate this data for your use in license and asset management within FlexNet Manager Suite, release 2020 R1
includes a connector that imports normalized data from Normalize v5 into your compliance database. The imported
dataincludes:

¢ Records of inventory devices (for both physical servers and virtual machines) found in your environment by the
inventory tools (such as Microsoft SCCM or BMC ADDM) that are feeding into Normalize v5

 Details of applications recognized within your enterprise through those tools

« Installation records that link the found software to the inventory devices where it is installed

 Details of end-users who log onto the inventory devices

« Where available, records of application usage (how often, and for how long, an end-user utilized an application).

Application records are dealt with in the same way as inventory data from any other source. This means that the data
representing applications within Normalize v5 is imported into FlexNet Manager Suite in the first place as inventory
evidence (in this case, as installer evidence). What happens next depends on the details of the software:

« Ifthe application is already known to the Application Recognition Library (ARL), and therefore has a Flexera ID
included in the import from Data Platform, the evidence is recognized by the ARL and a matching installed application
record is created (if it did not exist already) and displayed in the Installed Applications page. For such records, the
inventory evidence type is set to FlexeralID, and the installer evidence record is linked to the application record.

G
= Tip: It may happen that the application is only recognized by a later update of the ARL than is currently deployed in

your enterprise. If this occurs, a widget on the System Health Dashboard highlights the need to refresh your local,
downloaded ARL (or you can wait until the next automated download, which typically happens each weekend).

« Iftheinstaller evidence is not [yet] recognized by the ARL, then following normal system processes, it cannot be
linked to an application record, and it remains in the Unrecognized Evidence page, in the listing under the Installer
evidence tab. For these cases, the inventory evidence type is displayed as Data Platform. (Future updates to Data
Platform and the ARL may mean that the same installer evidence re-imported thereafter may be recognized, and an
installed application record automatically created at that time. For this reason, it is best not to manually trigger
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application creation from such records of public applications, but to wait for Flexera's continuing alignment work to
automatically complete the links for you. If you find such a case that is needed in your enterprise with some urgency,

you can ask Flexera to prioritize its delivery through a later release of the ARL.)

L
= Tip: Asubset of these unrecognized cases may be application records that you created locally within your

enterprise (records that in Data Platform are called "private applications", and in FlexNet Manager Suite are called
"local applications”). As such records may never be matched by the ARL, you may wish to start from the
unrecognized evidence record to re-create your local application record within FlexNet Manager Suite. In summary,
best practice is to manually trigger the creation of application records only for locally-created, 'private’
applications; and to await updates from Flexera for 'public’ applications.

Connector, not adapter

The integration with Data Platform v5 is not strictly an "adapter", for the following reasons:

o It does not require any custom XML file to be maintained through either the Inventory Adapter Studio or the Business
Adapter Studio

o Thereis no need (nor purpose) for any staging database

« Thereis no separate download and installation required (with the possible exception of the initial release, where
shipment of the connector is not synchronized with the product release; but in future it is embedded as a standard

part of the product).

Instead, this integration is through a connector that is available on any up-to-date inventory beacon. You set up the
import in exactly the same way as for any other inventory connection: specifying the details in the new inventory
connection dialog on the Inventory systems page on your preferred inventory beacon; and nominating your preferred
schedule for the regular imports. Full details are included below in Configuring the Data Platform Connector.

Inventory gaps and limitations

Following topics cover the mapping of data from within Data Platform to the import tables within the compliance
database in FlexNet Manager Suite. (Hints are also given for tracking data from the import tables to the operational
tables within the compliance database, with further information being available in the FlexNet Manager Suite Schema
Reference PDF, available through the title page of online help.) Within those topics are specific comments about the
impact of particular inventory gaps on tracking your license compliance.

At a high level, inventory gathered only from Normalize v5 is insufficient for:
» Oracle Processor license calculations (missing the partial number of processors)
* IBM PVU license calculations (missing the partial number of processors)

« Any licenses that rely on details about the host settings for virtual machines, such as assigned core or processor
counts (for VMs, this connector can only import the virtual host, and no other details of the VM, including pools,
clusters, capping and the like). Notice, however, that inventory is normally gathered separately both from the
virtualization host and from available guest machines, so that records are available for each device's view of its own

properties.

Validate your data processes

When there are inventory gaps, the best-practice work-around is to add a second inventory source that fills the gaps, and
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allow FlexNet Manager Suite to merge the sources to produce a unified data set. The risk factor is that record merging
may fail (because of different values in key fields), leading to duplicate records in your compliance database that cause
over-counting.

Such a case is the possible merging of imports from Data Platform with another source, such as the FlexNet inventory
agent. One of the key fields for merging inventory device records is the domain name that the device reports, and
currently the values for domain are by default saved differently. Data Platform v5 typically saves a flat domain name
(such as flexera); and while FlexNet Manager Suite can handle either format, by default is saves and uses the DNS
domain name format (distinguished name) that includes the root domain (such as flexera. com). At first glance this
difference looks high-risk; but there is a compliance database table that helps to resolve this issue, called the Domain
table. Since this stores both the fully-qualified distinguished name for the domain, and also its flat name, it allows
reliable matching between the two forms, provided that it has been populated with the appropriate records before a
mapping is requested.

So, to prevent duplicate inventory device records, it is important to ensure that the Domain table is populated with all
your domain names in both formats before importing from Data Platform (or indeed, any other inventory source that
reports the flat name for domains). There are three ways to do this, of which the first is best practice:

« Runan import from Active Directory. This populates the Domain table appropriately with both domain name formats.
» Import FlexNet inventory, since the FlexNet inventory agent reports both name formats.

¢ Import inventory from Microsoft SCCM 2012 or later, since from that release, SCCM also reported the domain name in
both formats.

The first option is clearly preferable since it gives the most complete coverage of all your domains. Therefore, before
importing from Data Platform, ensure that your Active Directory imports are up-to-date.

L
= Tip: If you have domains that are outside the reach of your Active Directory implementation, you can create a

spreadsheet and write a business adapter to populate the Domain table.

A match between host name, domain, and serial number is sufficient for merging (de-duplicating) inventory device
records. Where these high-priority values are not available, FlexNet Manager Suite continues checking lower-priority
properties including:

e HostIdentifyingNumber
¢ HostType
e ILMTAgentID.

Since all these properties are unavailable from Data Platform v5 (see Imported Computers (Inventory Devices)), this
makes correct mapping between the naming formats of your domains all the more important in avoiding duplicate
device records.

|_¢ Attention: Even when you follow best practice and use the above techniques to populate the Domain table with both
the flat name and the distinguished name for each domain, issues with domain reporting may still cause creation of
duplicate records for computers or users. This is because some data sources (notably HP-UD and ADDM) report domain
properties for users and computers in ambiguous ways, and where overlapping data comes from another source
(including coming through Data Platform even from the same original source), duplicate records may result. You may
both prevent and repair such duplication simply by setting your Primary inventory source to a known-good choice
from the overlapping sources, such as SCCM, FlexNet inventory, or Data Platform. (To find this setting, navigate to the
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system menu (% ¥ in the top right corner), choose Data Inputs and select the Inventory Data tab). To clear duplicate
records previously created through this issue, set your good source that's reporting the domain as primary, and wait for
(or trigger) a full import and compliance calculation. By default, these full imports and calculations happen overnight,
so you can check that your previous duplicates are cleaned up the day after adjusting your primary inventory source.

If you are considering the use of two data paths for overlapping inventory records (such as having a common source
imported directly into FlexNet Manager Suite on the one hand, and imported through Data Platform v5 on the other),
one caveat to be aware of is the need for additional expertise. Suppose that you are trying to analyze a problem with
recognition of a particular application. With two data paths, you must first determine which data path delivered the
record, because the recognition logic differs between the paths:

If the path was direct from the inventory source (such as SCCM) into FlexNet Manager Suite, then the evidence rules in
the Application Recognition Library (ARL) must be assessed for effective matching.

If that path from the inventory source led through Data Platform v5, you first need expertise to analyze the
recognition process within that domain, because it is Data Platform (and in particular Normalize v5) that has
recognized the application. In addition, you must validate that Data Platform v5 is supplying a Flexera ID for the
application it recognizes, and that the same Flexera ID is listed as evidence in your installed ARL — otherwise, despite
its initial recognition, the 'application' languishes in the Unrecognized Evidence page within FlexNet Manager Suite.

In summary, combining both data paths provides a growth opportunity.

Supported versions

The connector is validated for operations between Data Platform v5 and FlexNet Manager Suite 2018 R1. Within that
framework, the following recommendations apply:

Data Platform: The preferred release of Data Platform (and in particular, Normalize) is 5.5.4 (or later), as this release
fixed a problem where, for virtual machines, imported data contained incorrect values for the count of Cores and
Threads (or logical processors). Both these values are visible in FlexNet Manager Suite on the Hardware tab of the
inventory device properties. In the same location, you may also manually override both these values when a
correction is needed, and your overridden values are unaffected by future inventory imports (for more details, see the
online help for the Hardware tab).

FlexNet Manager Suite: While formal validation is limited to release 2018 R1 and later, informal spot testing suggests
backward compatibility of the connector should extend back to at least release 2017 R1 of FlexNet Manager Suite.

|_":' Important: If you are testing with an earlier version of FlexNet Manager Suite, be sure that, on all relevant
inventory beacons, you remove the superseded folder C: \ProgramData\Flexera Software\Compliance\
ImportProcedures\Inventory\Reader\BDNA before distributing the new Data Platform v5 folderasa
replacement (full details about the new folder are included in Configuring the Data Platform Connector).
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Configuring the Data Platform
Connector

Configuring the Data Platform connector is a one-time task, and quite straight-forward. Thereafter, the imports continue

at the intervals you schedule. Have ready your connection details for the Normalize v5 database.

=
[_] To configure the Data Platform connector:

1. To minimize the risk of duplicate records when you have imports from multiple inventory sources, ensure you have
completed Active Directory imports from all your domains.

For more details, refer back to Integration with Data Platform v5. For guidance about Active Directory imports, see
FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.

2. If necessary, apply for your updated Data Platform license to enable integration with FlexNet Manager Suite, by
contacting your Flexera Support consultant.

This updated license is available free of charge to existing customers who have implemented Data Platform. It

authorizes additional functionality and a new data pack. If you are unsure whether you already have this updated
license, there are two ways you may check:

» You can send a question to Data Platform Support

» You can run the following SQL statement against your Normalize v5 database:

Select IS _SUBSCRIBED from BDNA_CP where CP_NAME = ‘Technopedia Flexera Mapping’

If the result returns Y, your Data Platform instance includes the license term, and you may skip ahead to step 4.

If it returns N, you need to apply for the license update.

3. When you receive the updated activation key:

b.
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In BDNA Admin, navigate to the Preferences page.
Enure that the Registration tab is selected (top left).

Delete the current contents of the Activation Key field.

. Copy the key in full from the email you received, and paste it into the Activation Key field.
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e. Click Register New Key.
4. Download the new data pack:
a. Navigate to the Technopedia page in BDNA Admin.
b. Click Start Catalog Sync, and wait for the data pack to download.
5. Ensure that the Data Platform connector is in place in your FlexNet Manager Suite implementation.

You can check whether the Data Platform connector is already in place by inspecting any inventory beacon, or (for
an on-premises implementation) your central application server (in a multi-server implementation, check the
batch server). In each case, open Windows Explorer and navigate to C: \ProgramData\Flexera Software\
Compliance\ImportProcedures\Inventory\Reader. Ifyou find afolder there called Data Platform v5,
your connector is already in place, and you may skip ahead to the next major step. If not, switch to a web browser
to obtain your copy:

a. Right-click the zip archive, and choose Extract All....

b. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2020R1.zip>
Data Platform v5.

c. CopytheData Platform v5 folderinits entirety to C: \ProgramData\Flexera Software\

Compliance\ImportProcedures\Inventory\Reader onyourchosen inventory beacon.

i
= Tip: Copy the folder to the same location on your central batch server (or server hosting that

functionality), and FlexNet Manager Suite automatically transmits it to all your inventory beacons as
part of their reqular policy update. Allow an hour or two (depending on how many inventory beacons
you have) for this process to complete.

6. Ensure that you have your preferred schedule for imports from Data Platform set on the appropriate inventory
beacon:

a. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu,
search for FlexNet Beacon, right-click it, and select Run as administrator).

i
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

b. From the Data collection group in the navigation bar, choose Scheduling.

c. Ifthereis not already a suitable schedule in the list, click New... and complete the details (see the online
help for that page for more information). Otherwise, identify the schedule you will use.

7. Define the connection to your Data Platform implementation:
a. Select the Inventory systems page (in the same group), and then click New....
If you used the down arrow on the split button, use only the SQL Server option.

b. Complete the details, using a name that is distinct within the first few characters so that it is recognizable in

a narrow column.

|_b Important: Take care that:

o The Source Type isData Platform v5
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 You provide the connection details for your Normalize database (not the Technopedia one).
See the help for this page for more details. When you are done, click Save.
8. Select your new connection from the displayed list, and click Schedule....

9. Inthe dialog that appears, select the name of your chosen schedule for inventory collection through this
connection, and click OK.

10. At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

¥

= Tip: Consider whether you want to select your connection, and click Execute Now, before you exit.
The connection is now configured, and imports data from Data Platform on your chosen schedule. Shortly after each
import is completed, the inventory beacon automatically uploads the resulting inventory to the central application
server. After the next full import and compliance calculation (typically scheduled overnight), the inventory is visible in
the web interface of FlexNet Manager Suite.
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Data Mappings, Gaps, and Impacts

The following topics provide a mapping between the source tables (and their columns) in the Normalize v5 database,
and the corresponding destination tables and columns in the compliance database within FlexNet Manager Suite. This
mapping covers only the first stage of the process, into the tables with names starting Imported. . .. These are
effectively staging tables that hold the data between the upload from Data Platform, and the major transition (or import)
into the operational tables in the compliance database, normally followed immediately by the license compliance
calculations (the calculations of consumption against entitlements). The descriptions also identify the operational
tables where the data eventually resides, and for a more detailed understanding of those tables and their columns, see
the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

The topics are separated by the target Imported. . . tables, each of which is aligned with a particular data object within
FlexNet Manager Suite. Within each listing, the columns are in the same order that they appear in the Schema Reference,
for your convenience if you are cross-referencing both documents.

As well as the list of imported data, a second list within each topic identifies the values that cannot be imported through
Data Platform v5, together with notes on the impact that these gaps have on compliance calculations. Some gaps affect
the suitability of this data source when you are managing certain types of licenses.

Each topic lists every column within the relevant Imported. . . table, so that if you are working across both this and the
Schema Reference, there is no ambiguity about any column: it is either listed in the imports, or in the list of items missing
from the import. Notice that this means some columns included for completeness appear in the list of "missing" items
when in fact there is no expectation that they should be imported from any inventory source (or, to put it another way,
they are correctly omitted from the import). These items are marked as "internally generated" by FlexNet Manager Suite.

Exempted kinds of data
The following kinds of data are not imported from Data Platform v5 to FlexNet Manager Suite:

« File evidence — this evidence type is not needed from Data Platform, as the import of installer evidence includes all

required information

* WMI evidence — this evidence type is not needed from Data Platform, as the import of installer evidence includes all

required information

« Client access evidence (used for Microsoft Client Access Licenses, or CALs) — this evidence is not available in Data

Platform v5

o App-Vevidence — this evidence is not available in Data Platform v5, and App-V application usage cannot be tracked if

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 219



Data Mappings, Gaps, and Impacts

Data Platform v5 is the single inventory source

« Oracle Database and Oracle option evidence, and Oracle LMS evidence — this evidence is not imported from Data
Platform v5, so that recognition of Oracle Database version and edition, or of Oracle options, is not possible if Data
Platform v5 is the single inventory source (but this information, along with detailed content to deliver to Oracle
License Management Service, is fully available within FlexNet Manager Suite using the FlexNet inventory agent).

Comparison of Sources

This topic has two parts:

» Acomparison of the inventory sources that are supported by FlexNet Manager Suite and Data Platform v5

« For data sources fully supported by both, a summary of the inventory gaps (some of which may affect compliance
calculations) with data imported from each source either directly into FlexNet Manager Suite, or firstly into Data
Platform and then imported from Data Platform v5 into FlexNet Manager Suite.

For additional detail, down to the level of individual data fields, refer to subsequent topics.

Supported inventory sources
For each of the data sources (listed alphabetically), this table displays:

¢ "Y"when either product offers out-of-the-box support for imports from that source
» Ablankin either product's column when the data source is not supported

o "C"when either product has a custom extractor/adapter available to collect data from the source and import it into
the connecting product.

I:-- Tip: Support in FlexNet Manager Suite may be offered through a connector, requiring minimal configuration other
than identifying the source; or an adapter, which may require a separate download and installation, and possibly
setting up a staging database. In addition, FlexNet Manager Suite supports the development of custom adapters, for
example, through the Inventory Adapter Studio (see The Inventory Adapter Studio). For Data Platform, the equivalent

terminology is extractor.

Inventory source FlexNet Manager Suite Data Platform v5
Symantec IT Management Suite (formerly Altiris) Y C

App-V Standalone Y

BMC BladeLogic Client Automation (previously Marimba) Y C

BMC Discovery (previously ADDM) Y Y

EdgeSight for Citrix Virtual Apps (previously XenApp Y

EdgeSight)

Citrix XenApp server agent (for Citrix Virtual Apps) Y

FlexNet Inventory Manager (previously ManageSoft) Y
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Inventory source FlexNet Manager Suite Data Platform v5
FlexNet Manager for Engineering Applications Y

HP Discovery and Dependency Mapping Inventory Y C

(DDMI)

HPE Universal Discovery (HP-UD) Y Y

IBM BigFix Platform (previously Tivoli Endpoint Y Y

Manager)

IBM License Metric Tool (ILMT) or IBM BigFix Inventory Y
(see note 1)

JAMF Pro (previously Casper) C Y
Microsoft Exchange ActiveSync Y
Microsoft Office 365 Y
Microsoft SCCM (previously SMS) Y Y
Salesforce Y
SAP (through FlexNet Manager for SAP Applications) Y
ServiceNow (see note 2) Y
SolarWinds Orion C Y
Symantec IT Management Suite (formerly Altiris) Y C
Tanium Asset C Y

D Note: In the table above:

1. Forimports from IBM BigFix Inventory, only applications with IBM as the Publisher are recognized by the

Application Recognition Library.

2. FlexNet Manager Suite does provide for integration with ServiceNow, but in this case it is not importing raw
inventory. ServiceNow is regarded as a source of business data rather than inventory data for FlexNet Manager
Suite.

Inventory gaps by import path

The following four inventory sources (column 1) are fully supported by both FlexNet Manager Suite and Data Platform
v5. Based on the import path, there may be gaps in the imported inventory, and these gaps may be significant enough
to prevent compliance calculations for related license types:

o The middle column identifies inventory gaps when FlexNet Manager Suite imports inventory data directly from each
source

o Thefinal column identifies inventory gaps if the inventory is first imported into Normalize v5 (within Data Platform),
and subsequently imported from there into FlexNet Manager Suite.
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DEVEELT Direct import to FlexNet Manager  Import through Data Platform
Suite
BMC Discovery (previously ADDM) No inventory gaps. Allvirtualization data is missing.
HPE Universal Discovery (HP-UD) No inventory gaps. Advanced virtualization data missing
(see note below).

DNS domain name missing (domain
flat name is available).

IBM BigFix (previously Tivoli Allvirtualization data is missing. Allvirtualization data is missing.
Endpoint Manager)

Microsoft SCCM (previously SMS) All virtualization data is missing. Advanced virtualization data
missing.
DNS domain name missing (domain
flat name is available).

D Note: This table distinguishes between:

« Simple virtualization calculations for technologies like VMware ESX and Hyper-V — these require only the host/
guest relationships to be tracked

« Advanced virtualization calculations for hardware partitioning technologies like HP-UX vPar, IBM LPAR, and Solaris
zones — these require tracking of greater detail, such as partial processors and processor pool information.
Information about clusters and host affinity (and the like) is also included in the advanced class.

And obviously, "all virtualization data" includes both of the above.

Imported Installer Evidence

The ImportedInstallerEvidence table is a staging table used for input of records about installation evidence. From
here, de-duplicated and normalized records are merged into the InstallerEvidence table.

InstallerEvidence typically lists installer evidence left behind after a particular item of software has been installed
on a computer. In the case of imports from Data Platform v5, applications identified there are first imported as installer
evidence. As always, this installer evidence is tested against rules saved in the Application Recognition Library (ARL),
and when matched, the appropriate application record is added to the InstalledApplications table (if it does not
already exist there), and is linked to the installer evidence. This application record is then visible in the Installed
Applications page of the web interface for FlexNet Manager Suite. A record of installer evidence that cannot be
matched by the ARL appears in the web interface on the Unrecognized Evidence page.

This process means there are three cases to consider, any of which may produce inventory gaps that can impact
compliance calculations:

1. For applications recognized within Data Platform, and for which the normalized installer evidence has been
mapped to an entry in the Application Recognition Library (ARL): there is no inventory gap as such, since at a
minimum all these items are recognized within FlexNet Manager Suite; but in a few cases, some application
variants (such as interface language, hotfix number, or platform) may be recognized by either tool but not the
other.
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2. For applications recognized within Data Platform, for which there is as yet no mapping to the ARL: the
unrecognized evidence in FlexNet Manager Suite may mean that license consumption is under-counted because
the applications have not been recognized within FlexNet Manager Suite, and therefore the licenses cannot
measure consumption against the 'missing' applications.

3. For applications not recognized within Data Platform, but which could have been recognized by the ARL from
other inventory sources: where Data Platform is your only data source, the unrecognized application may result in
under-counting of license consumption.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstallerEvidence table, that are not available from Data

Platform v5.

Data mapping for imported installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstallerEvidence table. Other columns from the ImportedInstallerEvidence table cannot be

populated from Data Platform v5, and so are omitted here (and shown below). For more details on the database tables
and columns within FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available

through the title page of online help.

Data Platform (Table)/Column

(MATCH_HOST_SW_PROD) /
CAT_SW_UUID

(MATCH_HOST_SW_PROD) /
CAT_PRODUCT_NAME or the Flexera
ID for the application if available in
ARL_ID

iy
w  Tip: Aprefixofarl://is

prepended to the ARL_ID on
import.

(MATCH_HOST_SW_PROD) /
CAT_VERSION or an empty string
when the Flexera ID for the
application is available

(MATCH_HOST_SW_PROD) /
CAT_MANUFACTURER or an empty
string when the Flexera ID for the
application is available

FNMS (Table)/Column

(ImportedInstallerEvidence)/
ExternalInstallerID

(ImportedInstallerEvidence)/
DisplayName

(InstallerEvidence)/Version

(ImportedInstallerEvidence)/
Publisher

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1

Notes

The identifier used in Data Platform
for the installer evidence.

The display name of the software
recorded in Data Platform, which is
imported only when there is no
Flexera ID available. When the
Flexera ID is returned instead, this
allows matching in the ARL, which
then supplies its standard display
name for the application instead.

When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the version
value is imported from Data
Platform.

When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the publisher's
name is imported from Data
Platform.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
Hard-coded values: (ImportedInstallerEvidence)/  When the Flexera ID is known, the
Evidence evidence type FlexeralD reflects

e FlexeraIDwhenitisavailablein

(CAT_FLEXERA ARL)/ARL_ID this. Otherwise, when Data Platform

is unaware of any matching entry in
« BDNA when the Flexera ID for the the ARL, it is identified as the

application is not available. evidence type.

W Tip: The internal database
value BDNA is replaced with Data

Platform for presentation in the
web interface.

(CAT_FLEXERA_ARL)/ARL_IDwhen (ImportedInstallerEvidence)/  The FlexeraID (withoutthearl://
the Flexera ID is available, or an ProductCode prefix) is used when available.
empty string Otherwise an empty string.

Data not imported from Data Platform v5

These columns in the ImportedInstallerEvidence table cannot be populated by inventory imports from Data

Platform v5. These missing data points do not impact license compliance calculations. For further details about these
columns, please see the schema reference.

e ComplianceConnectionID — internally generated

e AccessModelID (relevant only to file evidence, whereas this import is of installer evidence).

Imported Computers (Inventory Devices)

The ImportedComputer table is a staging table used for input of inventory device records. From here, de-duplicated
and normalized records are merged into the ComplianceComputer table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedComputer table, that are not available from Data Platform v5,
and the impact of these gaps on license reconciliation calculations where these rely on data from only this source.

Data mapping for imported inventory devices

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedComputer table. Other columns from the ImportedComputer table cannot be populated from Data
Platform v5, and so are omitted here (and shown below). For more details on the database tables and columns within
FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of
online help.
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Fabricated from:
(MATCH_TASK_DET) /
PROCESS_ID

(MATCH_TASK_DET)/ TASK_NAME

and the checksum for the same
(MATCH_HOST_0S) /HOST_ID

(MATCH_HOST_OS) / HOSTNAME

(MATCH_HOST_0S) / DOMAIN

(MATCH_HOST_0S) /
DISOVERED_0S_NAME

(MATCH_HOST_0S) /
DISOVERED_0S_PATCH_LEVEL

(MATCH_HOST_0S) /
CALC_NUM_OF_PHYSICAL_CPUS

(MATCH_HOST_0S) /
DISC_CPU_MODEL

FNMS (Table)/Column

(ImportedComputer)/ExternallID
The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

(ImportedComputer)/ComputerName

(ImportedComputer)/Domain

(ImportedComputer)/
OperatingSystem

(ImportedComputer)/ServicePack

(ImportedComputer)/
NumberOfProcessors

(ImportedComputer)/ProcessorType

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1
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Notes

An external ID is fabricated from
the various details shown
(truncated as required and joined
with various separator
characters). This is then mapped
through the
ImportedStringMapping table
to convert string IDs to integer
IDs.

The name of the computer.

¢ InWindows, this is the NetBIOS
name of the local computer, as
returned by
GetComputerName()

o For UNIX-like platforms, it is
the host name of the machine,
as returned by
gethostname(2).

The domain reported by the
computer.

D Note: Data Platform exports
a domain flat name, while the
ImportedComputer table
handles either a flat or DNS
domain name, but the DNS
domain name is preferred.
Watch out for possible
problems merging device
records obtained from
multiple inventory sources.

The operating system of the
computer.

The service pack installed for the
operating system.

The number of processors in the
computer.

The type of processor in the
computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_0S) / (ImportedComputer)/MaxClockSpeed  The maximum clock speed of the
DISC_SPEED_MHZ fastest processor in the computer.
(MATCH_HOST_O0S) / (ImportedComputer)/NumberOfCores  The number of cores in the
CALC_NUM_OF_CORES computer.

IZ] Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations for
all license types that use cores
as a metric (most of these
assume 1 core per processor
when the number of cores is
not available):

o Device (Core-Limited)
e Core Points

e IBMPVU

e Microsoft Server Core

e Microsoft Server/
Management Core

o Oracle Processor.

(DISC_ALL_OS)/TOTALMEMORY (ImportedComputer)/TotalMemory The total RAM in the computer, in
bytes.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL)/ (ImportedComputer)/ChassisType The type of case of the computer.

CAT_TAXONOMY_CATEGORY2 Some license types use this
information to optimize the
licensing position, particularly
with desktop and laptop
computers. Types used in Data
Platform are mapped to typesin
FlexNet Manager Suite as follows:

Data Platform FNMS

Empty Unknown
Handhelds Tablet
Notebooks Laptop

Mainframes Main System

Chassis
Servers Rack Mount
Chassis
All others Desktop
(DISC_HDDS) / The count of (ImportedComputer)/ The number of hard drives in the

entries for this device NumberOfHardDrives computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom extractor.
FlexNet Manager Suite
imports it where it is
available.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
(DISC_ALL_OS)/ (ImportedComputer)/TotalDiskSpace The totalsize of all hard drivesin
LOCALFILESYSTEMSPACETOTAL the computer. The results differ

for inventory collected from

SCCM directly by FlexNet Manager
Suite, or indirectly through Data
Platform v5:

o The FlexNet connection
imports the physical disk space
(DISK_DATA)

« Data Platform imports the
logical hard drive space
(v_GS_Logical_DISK).

(DISC_NICs)/ The count of (ImportedComputer)/ The number of network cards in
entries for this device NumberOfNetworkCards the computer.
(DISC_MONITORS)/The countof  (ImportedComputer)/ The number of graphics cards in
entries for this device NumberOfDisplayAdapters the computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom extractor.
FlexNet Manager Suite
imports it where it is
available.

(DISC_NICs)/IP_ADDRESS (ImportedComputer)/IPAddress The IP address of the computer.

(DISC_NICs)/MACADDRESS (ImportedComputer)/MACAddress The MAC address of the
computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL)/ (ImportedComputer)/Manufacturer The manufacturer of the

CAT_MANUFACTURER computer hardware. Some
Failover to examples include:
(DISC_COMPUTERSYSTEM) /

¢ On Windows, the SMBios
MANUFACTURER manufacturer (the WMI
Manufacturer property of the
‘Win32_ComputerSystem’

class).

¢ On Linux, ‘Manufacturer’ in the
‘System Information’ section
resulting from the ‘dmidecode’
command. Sample command:
‘dmidecode -s system-
manufacturer’

« On Solaris x86, as for Linux,
with failovers first to ‘sysinfo
SI_HW_PROVIDER’ and then to
‘ModelNo’.

« On Solaris SPARC, the ‘sysinfo
SI_HW_PROVIDER’. Typically
this value is ‘Sun_Microsystems’
or, more recently, ‘Oracle
Corporation’. Failover to the
‘ModelNo’.

e On HP-UX, the string literal ‘HP".

e OnAIX, the ‘modelname’
system attribute preceding the
comma character. For example,
if the ‘modelname’ system
attribute is ‘1BM,8202-E4B’, then
use ‘IBM’. This value is typically
‘IBM’.
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Data Platform (Table)/Column

(MATCH_HOST_HW_PROD_MODEL) /

CAT_HARDWARE_PRODUCT and
CAT_HW_MODEL, joined with a
space

Failover to
(DISC_COMPUTERSYSTEM) /
MODEL

(MATCH_HOST_0S) /
SERIALNUMBER

Failover to (DISC_ALL_OS)/
SERIALNUMBER

(DISC_HOSTS_USERLOGON) /
DOMAIN_USERNAME

(DISC_ALL_OS)/ScanDate

Hard-coded value Data
Platform
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FNMS (Table)/Column

(ImportedComputer)/ModelNo

(ImportedComputer)/SerialNo

(ImportedComputer)/
LastLoggedOnUser

(ImportedComputer)/InventoryDate

(ImportedComputer)/InventoryAgent
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The model of the computer
hardware or the virtual machine.
This value is defined for the
context of the current execution
environment, rather than the
physical server that may be
hosting a virtual machine or
partition. For examples across
operating systems, see the
schema documentation.

The hardware serial number of
the computer. The goal of this
value is to be tied to the physical
hardware, partition or virtual
machine and to be as unique as
possible across all computers in
the organization. This is due to its
use in tracking computers,
particularly after an operating
system rebuild. This value is also
used to socialize computer
inventory from different
inventory sources, and is used to
map virtual machine guest
operating system inventory to the
VM host on which the virtual
machine is running.

The DOMAIN\SAMAccountName
of the user last logged onto the
computer. Data Platform uses the
flat domain name.

The date the computer last had
inventory reported.

The name of the person or tool
that performed the last inventory.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
(MATCH_HOST_CPU) / (ImportedComputer)/ The number of sockets in the
DISC_NUM_OF_SOCKETS NumberOfSockets computer.

I‘;’I Tip: Data Platform supplies
this value from Technopedia.
Other inventory sources
supported by FlexNet
Manager Suite cannot gather
this value from inventory; and
in general, for compliance
calculations where the
number of sockets is not
available in inventory, the
value is approximated by
using the number of
processors (which is
satisfactory when there are no
empty sockets in the inventory
device). In devices that have
any empty sockets, non-blank
information from
Technopedia is superior.
Notice that certain Oracle
license types (such as Oracle
Database Standard Edition)
have a restriction on the
number of sockets on the host
server.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
(MATCH_HOST_CPU) / (ImportedComputer)/ The number of logical processors
CALC_NUM_OF_LOGICAL_CPUS NumberOfLogicalProcessors in the computer.

D Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations for
all license types that use
processors as a metric:

 Device (Processor-Limited)
o Microsoft Server Processor
e Processor

e Processor Points.

Data not imported from Data Platform v5

These columns in the ImportedComputer table cannot be populated by inventory imports from Data Platform v5. The
majority of these missing data points do not impact license compliance calculations (these are listed here without
comment). Those that do have an impact are noted below. For further details about these columns, please see the
schema reference.

e HardwareInventoryDate

e ServicesInventoryDate

o ComplianceConnectionID — internally generated
o ComplianceComputerID — internally generated

e ComplianceDomainID — internally generated

e IncompleteRecord — Thisis always set to zero for imports from Data Platform (that is, the imported record is
regarded as 'sufficient' for its normal use in license compliance calculations, subject to the known limitations
described in these pages).

e PartialNumberOfProcessors — Absence of this value prevents subcapacity license consumption calculations for

IBM PVU and Oracle Processor licenses.
e UntrustedSerialNo
e FullDetailsFromExternalID
e FullDetailsFromComplianceConnectionID

e ComplianceComputerTypeID — Thisis the foreign key to the ComplianceComputerType table, identifying

232 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1



Data Mappings, Gaps, and Impacts

whether the device is a VM, a VM host, and so on. Compliance impact: Prevents (unrecognized) VDI templates
consuming from a license. Prevents (unrecognized) VMs from observing license rules that require (or disallow)
consumption by VMs,

o TILMTAgentID — Forimports from ILMT, identifies the device as a candidate for subcapacity calculations on any
related IBM PVU license(s). Compliance impact: Device consumption may be at full capacity, and calculated only
when a full inventory import and compliance calculation is run (typically, once daily).

¢ FNMPComputerUID

e HostIdentifyingNumber — Useful for matching records from different sources, but no direct effect on compliance

calculations.
o HostType — Useful for matching records from different sources, but no direct effect on compliance calculations.
e IsRemoteACLDevice
e IsDuplicate
e LegacySerialNo
¢ UUID
¢ IMEI
¢ PhoneNumber (for mobile devices)
¢« EmailAddress (for mobile devices)

e CalculatedUser — Typically, calculated by FlexNet Manager Suite as the most frequent user in the last ten log-on

records. Data Platform v5 only reports this last logged on user name (LastLoggedOnUser); but this is sufficient.
e LastSuccessfulInventoryDate
e MDScheduleGeneratedDate
e MDScheduleContainsPVUScan
e FirmwareSerialNumber
e MachineID

e IgnoredDueTolicense.

Imported VMs and Hosts

The ImportedVirtualMachine table is a staging table used for input of virtual machine records, including their host
server. From here, de-duplicated and normalized records of the VM properties are merged into the VirtualMachine
table; and if not already present, records for both the VM and the host are added to the ComplianceComputer table.

o
= Tip: This data is in addition to the inventory imported for the virtual machine (and, separately, its host) and imported
as part of the inventory device records. For details, see Imported Computers (Inventory Devices).
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There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedVirtualMachine table, that are not available from Data

Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on data from only this

source.

Data mapping for imported virtualization records

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedVirtualMachine table. Other columns from the ImportedVirtualMachine table cannot be populated

from Data Platform v5, and so are omitted here (and shown below). For more details on the database tables and
columns within FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through

the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column

Fabricated from: (ImportedVirtualMachine)/
(MATCH_TASK_DET)/ HostComputerID
PROCESS_ID The format is of this form (shown with

(MATCH_TASK_DET)/TASK_NAME  Nonsense values):

and the checksum for the same
(DISC_VIRTUAL_HOSTGUEST)/
HOST_ID

(MATCH_HOST_HW_PROD_MODEL) /
CAT_MANUFACTURER

(DISC_ALL_0S)/

OSCOMPUTERNAME ComputerName

(MATCH_HOST_HW_PROD_MODEL) /
CAT_HW_MODEL

Failover to
(MATCH_HOST_HW_PROD_MODEL)
/DISCOVERED_MODEL

(MATCH_HOST_HW_PROD_MODEL) /

CAT_MANUFACTURER Manufacturer

234

PID123|TheTask|654321:Host789

(ImportedVirtualMachine)/
VirtualMachineType

(ImportedVirtualMachine)/

(ImportedVirtualMachine)/ModelNo

(ImportedVirtualMachine)/

Notes

A computer ID for the host is
fabricated from the various
details shown (truncated as
required and joined with various
separator characters). This is then
mapped through the
ImportedStringMapping table
to convert string IDs to integer
IDs.

The type of virtual machine.
Values from Data Platform are
transformed as follows:

e Microsoft becomes

VMType.HyperV

¢ VMware becomes

VMType.VMware

* Any other value becomes
VMType.Unknown.

As Data Platform has only one
name for the VM, the previous
value is replicated here (again).

The model number reported for
the VM.

The manufacturer visible to the
guest OS running on the VM.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
Fixed value Data Platform (ImportedVirtualMachine)/ The tool that provided this
InventoryAgent inventory record.
(DISC_ALL_0S)/ (ImportedVirtualMachine)/ The operating system configured
OPERATINGSYSTEM_TYPE_LABEL GuestFullName for the guest.
Fabricated from: (ImportedVirtualMachine)/ A computer ID for the guest is
(MATCH_TASK_DET)/ VMComputerID fabricated from the various
PROCESS_ID The format is of this form (shown with details shown (truncated as
(MATCH_TASK_DET) / TASK_NAME  Nonsense values): required and joined with various
dth _h k_ for th - separator characters). This is then
and the checksum for the same PID123|TheTask|654321:H05t789  mansed through the
(DISC_VIRTUAL_HOSTGUEST)/ ImportedStringMapping table
Guest_ID

to convert string IDs to integer
IDs.

Data not imported from Data Platform v5

The following columns in the ImportedVirtualMachine table cannot be populated by inventory imports from Data
Platform v5. Notice that several of them (such as NumberOfProcessors, NumberOfHardDrives, and IPAddress)
have matching data points imported as part of the inventory device import for the same guest machine. While several
of these missing data points do not impact license compliance calculations, the following gaps are significant:

o When the original input to Data Platform was from BMC Discovery (ADDM), information about virtual machines (and
hosts) is not available. In contrast, when the data source for Data Platform was Microsoft SCCM, the identification of
hosts and guests is available for supported platforms such as Hyper-V.

I:-- Tip: This is the inverse of the result obtained when FlexNet Manager Suite takes inventory from these sources
directly (rather than through Data Platform). In the this unmediated case, inventory from SCCM does not include
the host/quest, and the inventory from ADDM does include the host/guest relationship. Of course, if you have
multiple inventory sources collecting from a common target device, the results are merged within FlexNet Manager
Suite to provide the most complete record possible.

« When data is available (from inventory sources such as Microsoft SCCM into Data Platform), the import from Data
Platform to FlexNet Manager Suite is missing information about resource pools, vMotion, and partitions. This means
that, when Data Platform v5 is the only inventory source for these machines, compliance calculations are impossible
for consumption from some licenses such as IBM PVU, Microsoft, or Oracle server licenses.

For further details about these columns that are missing data, please see the schema reference.

¢ VMName

e VCObjectID
e FriendlyName
« UUID

e TotalMemory

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 235



Data Mappings, Gaps, and Impacts

e PoolName

e CPUUsage

¢ MemoryUsage

e MaxNumberOfLogicalProcessors
e VMEnabledStateID

e NumberOfProcessors

¢ ProcessorType

* NumberOfNetworkCards

e ComplianceConnectionID

e VMLocation

e PoolType

e ZoneResourceManagementMethodType
e AffinityEnabled

o CPUAffinity

e CoreAffinity

e PartitionID

e PartitionNumber

e FullComputerName

o IPAddress.

Imported Installation Records

The ImportedInstalledInstallerEvidence tableis a staging table used to collect records of which installation

evidence has been found on what inventory devices. From here, de-duplicated and normalized records are merged into
the InstalledInstallerEvidence table.

InstalledInstallerEvidence isasimple table that mainly links installer evidence records with inventory device
records. In the case of imports from Data Platform v5, only the two external IDs are needed, with other values supplied
by FlexNet Manager Suite as and when required. The first listing below maps the two columns from Data Platform
source to FlexNet Manager Suite destination. Below is a list of the remaining columns in the
ImportedInstalledInstallerEvidence table that are not populated by this import (and do not need to be).

Data mapping for imported installed installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
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ImportedInstalledInstallerEvidence table. For more details on the database tables and columns within

FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of
online help.

Data Platform FNMS (Table)/Column

(Table)/Column

(MATCH_HOST_SW_PROD) / (ImportedInstalledInstallerEvidence) The same value asthe
CAT_SW_UUID /ExternalInstallerEvidenceID (ImportedInstallerEvidence)

/ ExternalInstallerID.

Fabricated from: (ImportedInstalledInstallerEvidence) An external ID for the inventory
(MATCH_TASK_DET) / /ExternallD device is fabricated from the
PROCESS_ID The format is of this form (shown with various details shown (truncated
(MATCH_TASK_DET)/ nonsense values): as required and joined with
TASK NAME and the various separator characters). This
- PID123|TheTask|654321:Host789 is then mapped through the
checksum for the same . .
ImportedStringMapping table
(MATCH_HOST_SW_PROD) / to convert string IDs to integer IDs.
HOST_ID The same value as the
(ImportedComputer)/
ExternallID.
(MATCH_HOST_SW_PROD) / (ImportedInstalledInstallerEvidence) The installation date recorded for
DISCOVERED_INSTALLDATE /InstallDate the installer evidence.

Data not imported from Data Platform v5

These columns in the ImportedInstalledInstallerEvidence table cannot be populated by inventory imports
from Data Platform v5. These missing data points do not impact license compliance calculations. For further details
about these columns, please see the schema reference.

e ComplianceConnectionID — internally generated
e ExternalInstanceID

e DiscoveryDate (will be set to the date of first import from this connection).

Imported Users

The ImportedUser table is a staging table used for input of records about users. From here, de-duplicated and
normalized records are merged into the ComplianceUser table.

ComplianceUser stores information about end-users in the enterprise, including contact details, login details, and
inventory source details (if applicable). End-users are the people using computers within your enterprise (as distinct
from operators, who are people permitted to use FlexNet Manager Suite).

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedUser table, that are not available from Data Platform v5.
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Data mapping for imported users

The following listing matches the source data from Data Platform v5 with the equivalent column in the ImportedUser
table. Other columns from the ImportedUser table cannot be populated from Data Platform v5, and so are omitted
here (and shown below). For more details on the database tables and columns within FlexNet Manager Suite, please
see the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

(DISC_HOSTS_USERLOGON) / (ImportedUser)/ExternallD Mapped through the

USERDOMAIN and USERLOGON ImportedStringMapping table to

combined convert string IDs to integer IDs.

(DISC_HOSTS_USERLOGON) / (ImportedUser) /Domain The domain of the end-user. Data

USERDOMAIN Platform exports the flat domain
name.

(DISC_HOSTS_USERLOGON) / (ImportedUser)/SAMAccountName The login name (SAM account name)

USERLOGON of the end-user.

Hard-coded value Data Platform (ImportedUser)/InventoryAgent The name of the person ortool that
performed the last inventory.

Data not imported from Data Platform v5

These columns in the ImportedUser table cannot be populated by inventory imports from Data Platform v5. These

missing data points do not impact license compliance calculations. For further details about these columns, please see
the schema reference.

e ComplianceConnectionID — internally generated
¢ UserName

e ComplianceDomainID

e LocationID

e FirstName

¢ LastName

e Email

« EmployeeNumber

o CostCenter (asreported in SAP)

e ComplianceUserID — internally generated

e ComplianceDomainID — internally generated
o IsBlacklisted —internally generated

e MapUsingEmailAddress.
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The ImportedInstalledInstallerEvidenceUsage tableis a staging table used to collect records of actual use of
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applications related to installation evidence found on inventory devices. From here, de-duplicated and normalized
records are merged into the InstalledSoftwareUsageData table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstalledInstallerEvidenceUsage table, that are not

available from Data Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on

data from only this source.

Data mapping for imported usage related to installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the

ImportedInstalledInstallerEvidenceUsage table. Other columns from the

ImportedInstalledInstallerEvidenceUsage table cannot be populated from Data Platform v5, and so are

omitted here (and shown below). For more details on the database tables and columns within FlexNet Manager Suite,
please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

Data Platform (Table)/Column

(MATCH_SOFTWARE_METERING) /

USAGE_YEAR and USAGE_MONTH_N

Failover to

(MATCH_SW_RECENTLY_USED_APPS)

/ LASTUSEDDATE

Fabricated from:
(MATCH_TASK_DET) / PROCESS_ID
(MATCH_TASK_DET) / TASK_NAME
and the checksum for the same
(MATCH_SOFTWARE_METERING) /
HOST_ID

FNMS (Table)/Column

(ImportedInstalledInstaller
EvidenceUsage)/StartDate

(ImportedInstalledInstaller
EvidenceUsage)/ExternallID

The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789
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Notes

The start date is set to a string formatted
similarly to 1SO 8601 (except for the
slash separator: 2019/04/01) by
conjoining the year and month-number
from Data Platform, and adding an
assumed day for the first of the month.
Only if there is no value available by this
path, we use the date available from the
alternate table shown.

An external ID is fabricated from the
various details shown (truncated as
required and joined with various
separator characters). This is then
mapped through the
ImportedStringMapping table to
convert string IDs to integer IDs.

U Tip: i the
MATCH_SOFTWARE_METERING table
cannot provide a host ID, it is taken
from
MATCH_SW_RECENTLY USED _APPS.
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Data Platform (Table)/Column FNMS (Table)/Column

(MATCH_SOFTWARE_METERING) /

CAT_SW_UUID EvidenceUsage)/

(ImportedInstalledInstaller

Notes

The identifier used in Data Platform for
the installer evidence.

ExternallnstallerID

(MATCH_SOFTWARE_METERING) /
USAGECOUNT plus TSUSAGECOUNT

(MATCH_SOFTWARE_METERING) /
LASTUSEDDATE

Failover to
(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSEDDATE

(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSERDOMAIN, then a backslash
\, then LASTUSERLOGON

Data not imported from Data Platform v5

(ImportedInstalledInstaller
EvidenceUsage) /NumberOfSessions

(ImportedInstalledInstaller
EvidenceUsage)/LastUsedDate

(ImportedInstalledInstaller
EvidenceUsage)/ExternalUserID

I{.r"l Tip: If the
MATCH_SOFTWARE_METERING table
cannot provide an external ID, it is
taken from

MATCH_SW_RECENTLY _USED_APPS.

If the number of sessions in which the
evidence was in use cannot be
calculated by this method, the default
value 1 is inserted.

The last known date when usage of the
application is recorded (in one table or
the other).

The end-user identified in the source as
using the software. The identifier is
fabricated by conjoining the flat domain
name and logon name (separated by a
backslash).

These columns in the ImportedInstalledInstallerEvidenceUsage table cannot be populated by inventory

imports from Data Platform v5. These missing data points do not impact license compliance calculations. For further

details about these columns, please see the schema reference.

e ComplianceConnectionID — internally generated

e ExternalInstanceID (used only for Oracle).
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HP DDMI Adapter

This part introduces the FlexNet adapter for importing data from HP DDMI (for those enterprises that have not yet
migrated to HPE Universal Discovery, for which see HPE Universal Discovery Adapter).
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Purpose and Architecture of the HP
DDMI Adapter

The FlexNet adapter for HP Discovery and Dependency Mapping Inventory (HP DDMI) collects data from your HP DDMI
implementation, and stores it in an intermediate staging database. From there, the FlexNet Manager Suite importers
bring the data into the compliance database so that you have a single, unified view of all inventory sources, and of the
impact that the collected inventory has on your license position.

The work is done in two separate stages, and by two separate components:

o The FlexNet DDMI agent reads inventory directly from the HP DDMI incoming inventory (. xsf) files, and writes the

data into the staging database.

» The FlexNet DDMI adapter connection connects to the staging database, massages the data into the format required
for integration with FlexNet Manager Suite, and imports it to the compliance database.

This architecture is summarized in the following diagram, with the numbers described below:
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HP DDMI Server

Agent

Purpose and Architecture of the HP DDMI Adapter

FlexNet
Manager
Suite

1. XSFfiles (compressed XML files) are produced by HP agents and uploaded to a central HP DDMI server.

2. XSF files are imported into the databases for HP DDMI and HP uCMDB. These two stages are the normal operation
of HP DDMI, and are unaffected by the presence of the FlexNet adapter.

3. The first component of the FlexNet adapter for HP DDMI (an agent which may be installed on the HP DDMI server,
where the XSF files are uploaded, or on any other device with read access to the same collection of XSF files) reads
the uploaded files and writes the data into the staging database required for this adapter. Copying the data from
the original XSF files allows FlexNet Manager Suite to capture evidence that, if unrecognized by HP DDMI, is

otherwise discarded.

4. The data import connection (configured from an inventory beacon, which is not shown in this simplified diagram)
links to the staging database, extracts the latest data, and uploads it to the compliance database for FlexNet

Manager Suite.
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Installation and Configuration

Everything needed to set up the FlexNet adapter for HP DDMI is included in the Adapter Tools archive available from the
Flexera Customer Community. You need credentials supplied by Flexera to access this download. The download
includes:

» Two SQL scripts to define the schema for, and populate stored procedures for, the staging database.

» The agent executable FnmpDDMIAgent.exe, and an accompanying CommandLine.d11 to enable command-line use.

This chapter includes all the details needed for installation and configuration. There are validation notes are included at
each stage of the set-up.

This chapter assumes that you have a functional implementation of HP DDMI, and an account with sufficient privileges
on your HP DDMI server to install the agent executable there (or similar in your chosen location, if you are placing the
agent elsewhere).

Download Adapter Tools Archive

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time. Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

L
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2020 R1.zip archive. One path is through the

Flexera Community:

7
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand Other Resources and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Platform,click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
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The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2020 R1.
A EULA page may appear. If so, accept the license, as this grants access to the list of Downloads.

f. Inthe list of available Downloads, in the File Name column, click Adapter Tools for FlexNet Manager
Suite2020 R1.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2020 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Creating the Staging Database

The FlexNet adapter for HP DDMI requires a staging database, which is used as follows:

o The agentinstalled on your HP DDMI server reads the DDMI inventory files directly, performs minimal data
rationalization, and saves the results to the staging database

« The connection from FlexNet Manager Suite reads the data from the staging database, shapes it appropriately, and
uploads it to the compliance database.

The staging database can be created on any convenient instance of Microsoft SQL Server that meets the following
criteria:

o Provides high-speed network access from the HP DDMI server (or other location of the installed agent), and from an
appropriate inventory beacon that can upload to the application server for FlexNet Manager Suite

o Allows read/write access to the account running the FlexNet agent on the HP DDMI server, and read access by the
service account running the BeaconEngine service on the inventory beacon (or you may choose to implement

either a special Windows account and an SQL account to collect the DDMI staged data)
 Isrunning an instance of Microsoft SQL Server 2012 or later.

The staging database size will be roughly equivalent to the sum of the inventory (. xs) files uploaded to your HP DDMI
server. The agent overwrites any previous record from the same device with the latest inventory upload, to that the net
database size does not grow appreciably larger than the sum of the source inventory files.

Your download of the Tier 1 adapters archive (see Download Adapter Tools Archive) included two SQL scripts that can
assist with creating the staging database. You can achieve this through SQL Server Management Studio, or from the
command line as described in the following procedure. Use whichever approach best suits your enterprise practices.
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oy
[_] To create the staging database from the command line:

1. Navigate through the unzipped tools archive to Tier 1 Adapter Tools>HP Discovery and Dependency
Mapping Inventory Tools >SQL.

2. If necessary, copy the script DDMIStagingSchema.sql from the this folder of your unzipped adapter archive to a
temporary folder on your staging database server.

3. Logged in on the database server as an account with read/write access to the database, open a command prompt.
4. Inthe command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingSchema.sql

where:

« ServerName is the name of the server hosting Microsoft SQL Server 2012 or later. Use a “.” (dot) if you are
running the staging script on the same server as the database instance; or if you are adapting these
instructions to a different environment, insert the server name or its IP address.

« InstanceName is the name of the database instance to use for the database staging tables. You can omit this

parameter (and the backslash separator) if the default instance name is being used.

o TemporaryPath is the location where you saved the SQL procedure.

Example:

sqglcmd -S .\Development -1 C:\temp\DDMIStagingSchema.sql

The database DDMIStaging is created with all necessary tables, indices, and so on.

5. Similarly, execute the second script (with the same parameter substitution) to create the stored procedures
necessary in the staging database.

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingProcedures.sql

Example:

sqlcmd -S .\Development -1 C:\temp\DDMIStagingProcedures.sql

The staging database is now ready for operation.

7
= Tip: If you wish to do so, you may now rename this database. Keep the name handy for the configuration processes

that follow.

The schema for the staging database (below) is, in the main, self-explanatory, reflecting the content of the . xsf files
found on your HP DDMI server. The one unique table is InventoryImportDate. This table lists the names of inventory
files that have already been loaded into the staging database, and saves the last modified date of each file as its most
recent inventory date. When the FlexNet agent scans through the inventories for possible import into the staging
database, it uses this table to manage differential imports, only importing an inventory file if it is newer than the last
recorded inventory file of that name that was imported.
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StagedComputer StagedFileEvidence
Column Mare I Data Type I Allowe Mulls I Column Mare I Data Type I Allowe Mulls I
:|| ExternalComputerID int I :|| StagedFileEvidencell int I
AssetTag nvarchar(256) I FileMame nvarchar(256) I
_l Computerklame rivarchar{Z56) ¥ _l FileVersion rivarchar( 100} ¥
_l Domainualifiedame rivarchar( 100} ¥ _l Productyersion rivarchar( 100} ¥
_l DomainFlatiame rivarchar32) ¥ _l Producthlame rivarchar( 100} ¥
_l Operating3ywstem rvarchar(123) ¥ _l Company rivarchar( 100} ¥
_l ServicePack, rvarchar(123) ¥ _l Description rivarchar( 100} ¥
_l MNumberCfProcessars int ¥ _l FileSize int ¥
_l ProcessorType rivarchar{Z56) ¥ _l Language rivarchar{Z00) ¥
_l MaxClockSpeed int ¥ _l I
_l MNumberCfCares int ¥
_l MNumberCfSockets int ¥
| Totaltemory bigint 73 StagedComputerFileEvidence
_l ChassisTvpe rvarchar(123) ¥ Column Mame I Data Tvpe I Al Hulls I
_l Chassisserialumber nwarchar(100) ¥ _l ExternalFileID ink Il
_l MNumberCfHardDrives ink = _l ExternalComputerID int -
_l TokalDiskspace bigint ¥ _l StagedFileEvidenceID ink Il
_l Murmber CfrebworkCards  int ¥ _l FilePath riarchar{400) 2
_l MNumberCfDisplayada,,. it = _| I~
_l IPaddress nvarchar(256) ¥
_l MACAddress nvarchar(256) ¥
StagedUser
_l Manufacturer rvarchar(123) ¥ 9
Calurnn Marne I Cata Type I Al Bulls I
_l Madello nvarchar(128) ¥
_l ExternalUserID int [l
_l Seriallo nvarchar( 100) ¥
_l Userkame rcarchar (e I
_l LastLoggedonUser rivarchar(ad) ¥
_l Comain revarchar(100) [l
_l InventoryDate datetime ¥
_l SAMAccounthame rcarchar (e [l
_l InventoryAgent rvarchar(123) ¥ _| -
_ =
StagedWMIEvidence
Column Mare I Data Type I Allowe Mulls I
StagedDomain _| ExternalwMIEvidencelD | int r
Column Mame Data Tvpe I Al Hulls I _l ExternalComputerID int Il
_I Qualifiedrarne nvarchar(100) Il _l ClassMame nvarchar{s0) r
_I Flatname rvarchar(32) v _l Propertyhame rivarchar(s0) I
_I r _l Propertyitalue rivarchar{Z56) I
_ =
StagedInstallerEvidence
Calumn Mame I Data Type I Allow Mulls I InventoryImportDate *
J ExternalComputer I ink r Column Mame I Data Type I Allows Mulls I
_I ExternalinstallerD int r _l InventoryFileMame nvarchar(256] -
_I DisplayMame rwarchar (256} [l _l InwentoryDate datetime [
_I Wersion revarchar(7) I _l r
_I Publisher revarchar(200) I
_I Evidence rrvarchar(3e) I
| r
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Configuring the FlexNet Agent for HP DDMI

The FlexNet agent for HP DDMI is the code entity that accesses the inventory (. xsf) files uploaded to your HP DDMI
server, and saves the resulting data to the staging database that you have just established. Operationally, it consists of
two parts:

o Asmall C# application (an .exe and a .d11) that acts only as a transport, decompressing the . xsf files (which are

compressed XML) and feeding them to the second part

o Astored procedure, already created in the staging database (see Creating the Staging Database), that unpacks the

XML elements and saves the resulting data in the staging database.
Clearly, it is only the first of these that is the focus of this topic.

The agent may be installed anywhere, as long as it has access to the folder on your HP DDMI server where the . xsf
inventory files are uploaded, and to the staging database. Optional locations include:

¢ Onthe HP DDMI server (optimal from a network performance viewpoint)

o On the server hosting the staging database

« Onaninventory beacon that has fast network access to both of the above

« On any other computer meets that same requirement of fast network access to the data source and destination.

Although much of the inventory processing load is delegated to the SQL stored procedure, you can further control the
impact of the executable on its host device by specifying the number of CPU threads it devotes to throughput of the
.xsf files. In any case, the agent is normally scheduled to run only once daily in off-peak hours.

<3
[_] To configure the agent executable:

1. Navigate through the unzipped tools archive to Tier 1 Adapter Tools>HP Discovery and Dependency
Mapping Inventory Tools >DDMIAgent.

2. Copy both the FnmpDDMIAgent.exe and CommandLine.d11 files to their new operational location.

I} Important: Both files must be installed in the same folder.
3. Identify or configure the account that is to run the agent.

A suitable account:

» Has execute rights on the device where the agent is installed

» Has at least read-only privileges on the folder where the . xsf inventory files are saved on your HP DDMI

server
» Has read/write privileges on the staging database.
You may prefer to make this a service account to prevent interactive use.

4. Configure a Windows schedule task (or use your preferred scheduling tool) to trigger execution of the agent
running as your selected account on your preferred schedule.

Choose a schedule to suit your environment. This should allow enough time to:
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e Processall new . xsf files into the staging database

» Upload the results to the compliance database for FlexNet Manager Suite

« Align with the nightly full import and license compliance calculations, by default scheduled for 2am nightly.
A suggested schedule is daily at 10pm.

The task must invoke the FnmpDDMIAgent . exe executable with a command line that includes some of the
following parameters (the agent also supports -h to list command-line options):

FnmpDDMIAgent.exe
-s PathToInventories
-d StagingDBConnectionString
-1 LoggingLevel
-t TimeOutSeconds
-n ThreadCount

where the parameters are:

Switch M/O Value

-s Mandatory The location of the HP DDMI inventory files (no default value). The path may be
enclosed in double quotation marks, which are mandatory when there is any white
space in the file path. Example: "C: \HPDDMI\Inventories"

-d Mandatory  The connection string for the staging database (no default value). Example:
"server=172.16.38.83;Database=DDMIStaging; Trusted_Connection=yes"

-1 Optional An integer in the range 0-3 for the level of logging:

« 0:no logging (default value)
o 1:Errorsonly
o 2:Errors and warnings

» 3.Verbose logging.

-t Optional The number of seconds the executable should wait for a response to any command
given to the staging database. Default value is 3600 (an hour).

-n Optional An integer in the range 1-20 (default 5), being the number of CPU threads the agent
should use for processing the . xsf inventory files. Each thread invokes the database
stored procedures independently.

I:-- Tip: Depending on the hosting device architecture, optimum throughput is
achieved somewhere within the range of 1-20 threads, after which increasing the
number of threads overloads the system and decreases performance. Given the
variety of factors involved, there is no real substitute for experiment to determine

the optimum value for your environment.
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Example usage (all on one line):

FnmpDDMIAgent.exe
-s "C:\HPDDMI\Inventories"
-d "server=172.16.38.83;Database=DDMIStaging;Trusted_Connection=yes"
-12

When thus invoked, the agent reads through all updated XSF files in the source directory, and uploads their data
into the staging database. Files unchanged in the nominated path since the last upload are ignored.

5. On the assumption that you already have . xsf files in the nominated folder on your HP DDMI server, you may
wish to run the agent once now, and use Microsoft SQL Server Studio to validate the content is stored in the
staging database. (Loading the staging database also provides material for testing the next stage of the process.) If
you enabled logging, you may also check the log file, which is written to the same folder where the executable is
running.

Configuring Upload and Import
Connection

With data arriving in the staging database, it's time to configure its upload to the central application server for FlexNet
Manager Suite, followed by its import to the compliance database. This process is configured on, and managed by, an
inventory beacon.

=
[_] To configure the connection for upload from the staging database:

1. Runtheinventory beacon interface (for example, in the Windows Start menu, search for FlexNet Beacon, right-
click it, and select Run as administrator).

;
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

2. Open the Inventory systems page.

3. Expand the pull-down beside the New... button below the list, and choose SQL Server.
The Create SQL Source Connection dialog appears.

4. Complete the details to define the connection to the staging database:

a. Create a distinctive Connection Name that is easily recognized in the list of connections (even when the
columns are narrow).

For example: HPDDMI Staging.
b. For Source Type, you must choose HP Discovery and Dependency Mapping Inventory (DDMI).
c. Provide the host name or IP address (in IPv4 format) for the Server hosting the staging database.

d. Choose the Authentication method that the BeaconEngine process should use to connect to the
database:

o IfyouselectWindows Authentication,ensure thatthe service account that runs the
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BeaconEngine process on this inventory beacon has (as a minimum) read access to the staging

database.

« With either of the remaining two options, specify the Username and Password in the next two fields.
Of course, validate that the nominated account has (as a minimum) read access to the staging

database.

e. Use the Test connection button to validate that you have specified the details correctly, and adjust if
necessary.

f. For the Overlapping Inventory Filter, accept the default Import the inventory from this source for
possible merging selection (unless you are in the process of migrating inventory collection away from HP
DDMI, in which case see the online help for the Inventory systems page).

g. Click Save to close this dialog and add your new connection to the list in the Inventory systems page.

. Ifyou do not already have a suitable schedule for this connection available on this inventory beacon, select the
Scheduling page, and click New... to open the Edit Schedule dialog and define one.

. Back on the Inventory systems page, select the new connection in the list, and click Schedule... to select your
appropriate schedule in the Select schedule dialog. Click OK to confirm your selection.

. Inthe main FlexNet Beacon interface, click Save to store your newly scheduled connection.

. Ifyou have already run the agent to populate your staging database, you may test the new connection by keeping
it selected in the list, and clicking Execute Now.

The upload, the resulting import (which follows immediately), and the subsequent license compliance
calculation may take some time to complete. You may monitor progress in the web interface for FlexNet Manager

Suite — navigate to the system menu (" ¥ in the top right corner) and choose System Health > System Tasks,
and see the online help for that page. When the process is complete, you can inspect the inventory imported
from HP DDMI in the All Inventory page.

(4

= Tip: In the All Inventory page:
a. Add the Connection name to the listing from the column chooser
b. Display the simple filter bar

c. Filter for the name you have your HP DDMI connection (the suggestion was HPDDMI Staging).
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HPE Universal Discovery Adapter

You can use the HPE Universal Discovery (HPE-UD) adapter tool to collect and import inventory data from HPE Universal
Discovery System to FlexNet Manager Suite. The HPE-UD adapter fetches all hardware, software, and virtualization
information from the HPE-UD system and stores it in the compliance database maintained by FlexNet Manager Suite. The
HPE-UD adapter support is available only with FlexNet Manager Suite version 2015 and later.

- |

| Note: The HPE-UD adapter tool works only with version 10.10, 10.11, 10.33-11.5 of the HPE Universal Discovery System.
These versions do not support Solaris 11 zones, for which reason the HPE-UD adapter cannot import these zones. Since
host serial number and zone name are used for rationalizing duplicate inventory records across different inventory
sources, this may mean that a device imported through the HPE-UD adapter cannot be merged with another record of
the same device imported through another inventory source that supports zones information.
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Selecting a Configuration

This chapter gives an overview of the architecture, working, and configuration of the HPE-UD adapter. Choose the
appropriate configuration for your enterprise before you implement the adapter.

Architecture and Working of the HPE
Universal Discovery Adapter

The HPE-UD adapter architecture has the following main components:

o HPE-UD Server: This server has the HPUD uCMDB database and HPE discovery tools installed on it. The HPUD
uCMDB database stores the HPE-UD inventory details.

« Staging Server: This server contains the Flexera HPUCMDBStage . exe tool and a staging database. The
HPuCMDBStage . exe tool retrieves topology maps by executing TQL queries on HPUD uCMDB. The retrieved
topology maps are stored in a staging database (UCMDB_Staging) present on the staging server. The query

execution is performed using the web service interface of HPUD uCMDB.

* FlexNet Manager Suite: The Compliance Reader component residing on this server fetches data from the staging
database and loads it into the FlexNet Manager Suite database when you run an inventory import.

The following diagram shows the architecture and working of the HPE-UD adapter:

Figure 5: Architecture and working of the HPE-UD adapter
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1. The HPuCMDBStage.exe tool extracts the inventory information through the web APl of HPUD uCMDB. This tool
executes Topology Query Language (TQL) queries on the HPUD uCMDB database and retrieves responses in the
form of topology maps. With the default configuration, this tool stores the retrieved topology maps directly into
the staging database without storing them in XML files. However, you can configure this tool to write the retrieved
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topology maps to XML files and then write data from those XML files to the staging database.

ﬂ Note: One topology map is generated for each TQL query executed on HPUD uCMDB.

2. The Compliance Reader component of FlexNet Manager Suite collects data from the staging database. When you
run an inventory import on the FlexNet Manager Suite server, the data extracted from the staging database is
written to the compliance database on the application server

The Adapter Executable

HPE Universal Discovery (HPE-UD) adapter uses the ucmdb-api to obtain the version of the uCMDB instance. It uses the
UcmdbService web service API to retrieve the topology maps by executing TQL queries on the uCMDB instance. You
can retrieve the WSDL definition of the UcmdbService web service APl from http://<uCMDB Server>/axis2/
services/UcmdbService?wsdl. The configuration of the staging tool includes the TQL queries that will be executed
on the HPUD uCMDB database. You don't have to import the TQL queries into the HPUD uCMDB database and there is no
need to deploy and maintain the TQL queries on every HPE-UD instance of your enterprise.

ﬂ Note: The URL to retrieve the WSDL definition of the UcmdbService web service APl may use 'https' instead of 'http"
It may also include a port number. Please check with your HPE-UD system administrator for more details on the web
service URL.

The tool to query the web API has the following two parts:

» HPuCMDBStage.exe — A console program capable of querying the UcmdbService API of HPE-UD and writing the
results into an SQL Server database, and optionally to XML files on the local file system. This program supports
command line arguments, available using HPUCMDBStage . exe -h. Here is the list of available command line

options.
-h This help
-x <settings file> Settings file
-s <address or URL> uCMDB server address or URL
-u <user name> uCMDB export user name
-p <password> uCMDB export user password
-c <connection string> SQL Server staging database connection string
-m <staging method> Set staging method (stage/staged/prestaged/stream)
-f <staging file path> Set the staging file path

« FNMPuCMDBSettings.xml — The self-documenting configuration file for HPUCMDBStage . exe which contains TQL

queries executed against HPE-UD, and can include connection settings for HPE-UD and SQL Server.

In operation, the executable, HPUCMDBStage . exe, extracts the inventory data from HPE-UD and saves it for further
processing. The value of the method parameter determines how the data is saved. The method parameter can have the

following values:

« Stage — This option enables you to save inventory data from HPE-UD to a series of XML files on the staging server
(HPE-UD to XML). The XML files are not imported into the staging database, but you can review the extracted
inventory data. This option also enables you to collect inventory data from the HPE-UD servers that are not directly
connected to the staging server. You can manually copy and upload the inventory XML files to the staging server. Also
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see the Prestaged method below.

» Staged — This options enables you to write the data extracted from the HPE-UD servers to XML files and then copy
the information to the staging database (HPE-UD to XML/SQL) where it can be imported into FlexNet Manager Suite
for use in compliance calculations.

« Prestaged — This option takes information stored in XML files (from the Stage and Staged method) and loads it into
a staging SQL database (XML to SQL). Inventory is not gathered from HPE-UD in this mode.

e Stream— This option enables you to extract the inventory information from HPE-UD and load it into the staging
database directly, without storing it in XML files on the staging server (HPE-UD to SQL). You can import these files to
into FlexNet Manager Suite for use in compliance calculations.

You can set the default values for the method parameter and all other parameters in the FNMPUCMDBSettings.xml
file. The adapter tool uses the default parameter values when you use it without other command-line options. The
settings file is self-documented and the matching command-line options are available using HPUCMDBStage.exe -h.

Files Created by the Staging Tool

The following files are created when the staging tool performs a read/write operation on the local disk of the staging
server. You can view the contents of the following files to review HPE-UD configuration item details that have been
extracted.

Filename Content

Computer.xml Details of computers and their properties.
Virtualization.xml Virtualization and partitioning details.

InstalledSoftware.xml Installed software evidence linked to each computer.
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For on-premises implementations, the adapter XML files are included as a part of the FlexNet Manager Suite installation.
You need to download the staging tool, the configuration file, and the staging schema for this tool from
https://flexerasoftware.flexnetoperations.com,or from the Flexera Customer Community.

You need credentials supplied by Flexera to access this download. Details of the download are included in Download
Adapter Tools Archive.

o The HPE-UD adapter suits FlexNet Manager Suite releases 2015 and later for on-premises delivery.

o The build number for this adapter is 10.3.0.12006 (or higher). You can identify this number by right-clicking the
HPuCMDBStage . exe file in Windows Explorer, selecting Properties, and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the HPE-UD adapter are included in this chapter. The following chapter (see HPE-UD Adapter
Operation) covers testing the completed installation and validating the results.

Download Adapter Tools Archive

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines
needing installations for your adapter.

oy
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2020 R1.zip archive. One path is through the
Flexera Community:

;
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.

b. Inthe top right, in the navigation bar, expand Other Resources and select Product and License Center.
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c. Under the right-hand list of products that includes FlexNet Manager Platform,click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.

e. Inthe Latest Versions tab, click FlexNet Manager Suite 2020 R1.
A EULA page may appear. If so, accept the license, as this grants access to the list of Downloads.

f. Inthe list of available Downloads, in the File Name column, click Adapter Tools for FlexNet Manager
Suite2020 R1.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2020 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Selecting a Staging Server

Multiple configuration options are there to configure the staging server. You can install the staging server on any of the
following types of computers:

A dedicated stand-alone server or a virtual machine.
Any other suitable machine in your enterprise, such as a print server.
An inventory beacon.

The central application server where FlexNet Manager Suite is installed.

The following are the requirements for a staging server:

Microsoft Windows 2008 or later.

Access to an instance of Microsoft SQL Server 2012 or later to host the staging database. You can implement the
staging database on the staging server or on a separate database server.

Microsoft .NET 4.0 run time environment installed.

Efficient network access to each HPE-UD server in your enterprise, using the HTTP or HTTPS protocols.

Creating the Staging Database Tables

Once your selected staging server is able to access the Microsoft SQL Server instance, you can use the provided script to
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create the staging database and set up the appropriate database tables. You can achieve this through SQL Server
Management Studio, or from the command line as described in the following procedure.

=
[_] To create the staging database from the command line:

1.

2.

Download and install the Adapter Tools archive. For more information, see Download Adapter Tools Archive.

Navigate through the unzipped archive to Adapter Tools=>HP Universal Discovery Tools >SQL.

If necessary, copy the script uCMDB_staging.sql from the SQL\ folder of your unzipped adapter archive to a

temporary folder on your staging server.

. Open a command prompt on the staging server.

In the command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\uCMDB_staging.sql

where:

The database uCMDB_staging is created with all necessary tables, indices, and so on.

ServerName is the name of the server hosting Microsoft SQL Server 2012 or later. You can install the database
on the staging server or on any remote server. You can use the name of the staging server or its IP address, or a
“.” (dot) if you are running the staging script on the same server as the database instance.

InstanceName is the name of the database instance to use for the database staging tables. You can omit this

parameter if the default instance name is being used.

TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S 192.100.0.20\Development -1 C:\temp\uCMDB_staging.sql

The staging database is now ready for operation.

Configuring HPE Universal Discovery
System

You must configure the HPE-UD adapter settings to include a user which can perform the Run Legacy API and the Run
Query by Definition actions on the HPE-UD system.

oy
[_] To create and configure a user in HPE-UD:

1.

2.

258

In the HPE-UD interface, click Security, Roles Manager.

Create a new role for FlexNet Manager import.

. Select the role that you just created and click General Actions and assign the Run Query By Definition and the Run

Legacy API actions to this role.
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In the HPE-UD interface, click Security, Users and Groups.

. Create a new user for FlexNet Manager import.
. Click the Roles tab and assign the role that you created in Step 2 to this user.
. Click the Permissions Overview tab and review the assigned permissions for this role.

. Click Data Flow Management, Universal Discovery, Zone-Based Discovery and expand the Mapping Options

section in Preferences.

. Check the Raw OS Installed Software and set the Include option to name=. *. This enables HPE-UD adapter to

capture all raw installation evidence.

You have created and configured an HPE-UD user for use in the HPE-UD staging tool. You must add this user to the
FNMPUCMDBSettings.xml file.

Installing and Configuring the Staging Tool

This procedure includes many separate sub-processes to complete the setup of the HPE-UD adapter.

-
[_] To install and configure the HPE-UD adapter:

1.

Ensure that the account under which the adapter executable will run has read/write/execute permissions on this
UCMDB_staging database. Authentication may be through Windows authentication or SQL Server
authentication. Using Windows authentication, the default account is the username running the

HPUCMDBStage . exe adapter. The username and password for SQL Server authentication are specified in the
database connection string, which you may supply in FNMPuCMDBSettings.xml, or override with the -c option

on the command line.

. To extract information from the HPE-UD system, the HPuCMDBStage . exe tool must have the required

permissions to query the HPE-UD system. You must create a user in the HPE-UD system and assign it with
permission to perform the Run Legacy APl and the Run Query by Definition actions. You must specify this userin
the FNMPuCMDBSettings . xml file. For more information on configuring the HPE-UD system, see Configuring
HPE Universal Discovery System.

. Navigate to the fixed location on the inventory beacon where the inventory reader must find configuration files to

control its uploads. Verify the existence of the following path: C: \ProgramData\Flexera Software\
Compliance\ImportProcedures\Inventory\Reader\HP Universal Discovery.

. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a suggested

pathis under C:\Program Files\Flexera Software (for version 2015 and later, or for a stand-alone server
that is not an inventory beacon or application server). In your chosen location, create a folder such as
HPUDAdapter.

. From the HPuCMDBStage\ folder within your unzipped archive, copy both HPuCMDBStage . exe and

FNMPuCMDBSettings.xml to your newly created folder (such as C: \Program Files\Flexera Software\
HPUDAdapter).

. Open your copy of FNMPUCMDBSettings.xml in a text editor of choice, and review the self-documenting

comments within that file. Modify the following values as required. Ensure that you specify the IP address of your
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HPE-UD server. You can use the command line options to configure HPUCMDBStage . exe. Use the '-h' option to
get the list of available options.

» Update values in the first element describing the downstream connection to the HPE-UD server, including the
IP address, port, the account name and password for access. Keep a record of the account name and
password for registering with HPE-UD. The default values are:

<server protocol="http" address="10.200.20.138"
port="8080" username="exportuser" password="Pa$$word" timeout="3600"/>

¥
= Tip: If you do not wish to record the password in the plain text configuration file, you can use a script to

retrieve the password from an encrypted store, and supply it as a command-line option when starting the
HPuCMDBStage . exe tool. Here is an example:

HPuCMDBStage.exe -p <password>

« Update the second element for the connection to the staging database. The default values are:

<database
connection-string="Server=. ;Database=uCMDB_Staging;Trusted_Connection=yes;"/>

« Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from HPE-UD. The default value stores any XML files below the location of the executable:
<staging path="StagingData" method="stream"/> You may wish to redirect the path setting for

easier access for human inspection.

» Make sure that the user details in the <Server> section match with the user configured in the HPE-UD

system.
o Save the settings file.

7. Validate the HPE-UD adapter operation. For more information about validating the adapter, see Validating the
HPE-UD Adapter.

8. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task
Scheduler, and create a basic task to run the adapter.

|_b Important: It is suggested that you schedule the adapter to run at times which cannot overlap with the
inventory reader uploading the results to the application server. Check the schedule for the compliance reader
on the central application server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2 am. Therefore you might
consider scheduling this task for some time such as 10 pm daily. The command line for the scheduled task
(assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters not
specified on the command line are taken from the settings file in the same folder as the executable. Here is an
example:

HPuCMDBStage.exe -x <settings file>

This completes the configuration of the adapter executable.
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Operation and Validation

This section describes the normal operation of HPE-UD adapter and also lists the steps to validate its operation. This
section has the following tasks:

e HPE-UD Operation: See HPE-UD Adapter Operation

« Validating the HPE-UD Adapter: See Validating the HPE-UD Adapter

HPE-UD Adapter Operation

Normal operation of the HPE-UD adapter relies on the following sequence of events:

1. According to the scheduled instructions, the adapter reads the current content of the HPE-UD database and stages
the new data in the staging database after removing the previously stored data. A flag stored in the staging
database indicates the status of the data extraction. The resulting status is flagged within the database. For more
information on installing and configuring the staging tool, see Installing and Configuring the Staging Tool

2. Following the schedule on the central application server, and provided that the staging status is Success, the
import reader uploads this content to the inventory database.

3. The next compliance import brings the final data set into the compliance database, where it is automatically taken
into account for compliance calculations. As always, for compliance calculations to proceed, the inventory records
must be recognized by the Application Recognition Library, and you must have the resulting application records
linked to the appropriate license.

Validating the HPE-UD Adapter

3
U To validate the adapter operation:
1. Manually trigger the adapter executable.

You can specify a value for the method parameter if you need to override the default settings set in the settings
XML file. For example:
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'C:\Program Files\Flexera Software\HPUD\HPuCMDBStage.exe' -f 'C:\temp' -m staged

This will write XML files under your C: \temp directory for review. It will also write data into the staging database.
2. Inspect the saved XML files to validate the inventory gathered.

3. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the
StagingState property in the uCMDBStagingDatabaseConfiguration table in the staging database.
Possible values are Running, Failed, or Success. This value must be Success before the HPE-UD data can be
uploaded from the staging database to the central inventory database.

4. Wait until the next inventory import and calculations have run. You might have to wait overnight for this.

5. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been
recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
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IX

Managing Microsoft Office 365
Licenses

Microsoft Office 365 is a set of productivity tools available online (through a cloud-based subscription license) and offline
(installed locally). Office 365 subscriptions include a range of productivity tools including Microsoft Office, Microsoft
Exchange, Microsoft SharePoint, Microsoft Yammer, and Microsoft Skype for Business product lines. Multiple subscription
plans (such as E1, E3, and E5) are available. Some of these plans allow you to install Office applications locally.

With detailed information about Microsoft 365, the chapters in this part may help you in managing Microsoft 365 licenses
through FlexNet Manager Suite.

=3

|==| Note: For managing a your subscription licenses for Office 365, you may prefer to use the Flexera SaaS Manager
connector, which not only integrates information for Office 365, but simultaneously imports information for all your
SaaS-based products you choose to manage there. If you choose the Flexera SaaS Manager connector, you should not

use either of the Office 365 connectors described in this part.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2020 R1 263



Microsoft Office 365 License Management Considerations

Microsoft Office 365 License
Management Considerations

Microsoft Office 365 licenses that allow local Office installations also allow you (subject to the chosen plan) to install
Microsoft Office 365 on up to five PCs or Macs, and up to five tablets or smart phones, per Named User license. The
following section provides an overview of the tools provided in each enterprise plan.

With the FlexNet Manager for Clients product, you can use FlexNet Manager Suite to manage your Office 365
subscriptions. You can:

» Validate that the desired users have the right plan
» Determine how many Office 365 licenses you need to purchase, while negotiating license agreements
» Ensure that business units are not under- or over-subscribed.

Based on the selected plan, a subscription of Microsoft Office 365 may allow you to access multiple Office applications
online as well as offline (local installations) on up to five computers, and five tablets or smart phones. Because of this
mixture, the compliance calculations for Microsoft Office 365 licenses are different than other applications.

For example, the E3 plan allows you to install and use the following applications:

« Exchange Online Plan 2 for Office 365

» Skype for Business Online for Office 365
« Office Professional Plus for Office 365

« Azure Rights Management for Office 365
» SharePoint Online for Office 365

¢ Yammer for Office 365

(4

= Tip: For a detailed description of the available Microsoft Office 365 subscription plans, and the applications supported
in each plan, see the Microsoft Office 365 website.
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Considerations for managing Microsoft Office 365 licenses

To differentiate user records at various stages of processing, those already recorded within the compliance database of
FlexNet Manager Suite are here called "compliance users".

o Users: Each user imported from Microsoft Office 365 is mapped to the appropriate compliance user record within
FlexNet Manager Suite (by matching the Email or Alternate email field values). If an imported user cannot be
mapped to any compliance user, a new compliance user record is created with a dummy inventory device assigned to
it. These users consume against the Microsoft Office 365 multi-product license created for the Microsoft Office 365

tenant's subscription.

¥
= Tip: There are frequently differences between a user's corporate email address (such as Sam. Doe@tmnis. com)

and the same user's email address registered in Microsoft Office 365 (such as
Sam.Doe@tmnisoffice365portal.com). Since only the email addresses are available for matching (given that
your Active Directory accounts are not reflected in the Microsoft Office 365 online service), this can lead to duplicated
user records. To avoid duplicate records, you can, prior to importing from Microsoft Office 365 Online Service,
populate your existing user records with the Microsoft Office 365 email address in the Alternate email field. You may
want to consider using a Business Adapter to make widespread updates. If you have not done this prior to importing
from the Microsoft Office 365 (and as a result some user records are now duplicated), you can update the Alternate
email field in your AD-based records at any time, and the next full import and compliance calculation automatically
cleans up those duplicates.

« Devices: Although the installed device information is available to Office 365 administrators through the Office 365
Admin Center, FlexNet Manager Suite imports no device information from Microsoft Office 365. Instead, imported
users are mapped to compliance users within FlexNet Manager Suite, and the inventory devices linked to those
compliance users are considered to be the accessing devices. The method of linking the inventory devices and users
may be any of assigned user, calculated user, or last logged on user (in descending order of priority, and all visible in
the Ownership tab of the inventory device properties). The system also handles the following exceptions:

o Missing device: If an imported user maps to a compliance user who is not linked to any inventory device, a dummy
remote device is created by using the naming convention User Name (Remote). Such a dummy device is not
treated as a managed device by FlexNet Manager Suite (and specifically, does not count as a licensed device for the

license for itself).

o Installations on extra devices: If an installation of Office 365 is detected on a device, and the device is not linked to
any compliance user matched to a user imported from Microsoft Office 365, the installation consumes from an

existing perpetual license.

» Mobile devices: Because FlexNet Manager Suite does not collect inventory from all mobile devices (such as iPads),
you may need to monitor these devices separately. You can get the details of installed devices from the Office 365
Admin Center. If this reveals too many devices where a single named user is authoring or editing Microsoft Office 365
documents, you may have to deactivate Microsoft Office 365 from one (or more) of the mobile devices.

L
= Tip: You can read or present documents on a deactivated copy of Microsoft Office 365.
¢ Localinstallations: A Microsoft Office 365 subscription is represented as a Named User license, with each user
permitted to have installations on multiple devices. Only Microsoft manages the access to Microsoft Office 365.
Separately, if imported inventory identifies a local installation related to Microsoft Office on an inventory device
within your enterprise, the compliance user linked to the inventory device is checked. If this compliance user is
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matched in the subscription for Office 365, FlexNet Manager Suite assumes that the software installation is licensed. If
the device user is not matched in the subscription for Office 365, FlexNet Manager Suite looks for an existing perpetual

license to cover this installation.

« Office versions: A perpetual license of Office 365 enables you to downgrade to an earlier version, but the subscription
license does not. If you have a perpetual license of the older Office version, and you buy a subscription, the license

validity of the older version gets extended until the subscription expiry date.

» License entitlements: The entitlements data for Microsoft Office 365 is directly imported from Microsoft Office 365.
When an import matches an existing license record for Microsoft Office 365, its available entitlements are adjusted
with each import. On the other hand, if no license exists for an imported subscription to Microsoft Office 365, a new
Named User license is created for each subscription owned by each Microsoft Office 365 tenant, and the available
entitlements are recorded there. In the license properties for this automatically-created license:

o The Duration value (on the Identification tab) is set to Subscription.

o Initially, no purchases are linked (on the Purchase tab), since your entitlements are imported from Microsoft Office
365. Should you wish to link purchases to this automatically-created license (for example, as a way of
independently keeping track of your subscription purchases), notice that the value of the Assigned column is set
to @ (that is, the effective quantity on any linked purchases does not affect your total entitlements in the usual
way). As well, the Entitlement status column displays Not contributing, to again remind you that for such a
license, the compliance calculations are based entirely on the entitlement figures imported from Microsoft, rather

than on purchase records.
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Managing Office 365 Licenses
through FlexNet Manager Suite

Here is a high-level procedure for managing Microsoft Office 365 licenses using FlexNet Manager Suite.

o>
[_] To manage Office 365 licenses:

1. To avoid duplicate user records, ensure that the user email addresses recorded in Microsoft Office 365 are saved in
the user records visible in Enterprise > All Users.

These may be called "compliance users" after the compliance database table where they are saved. The Microsoft
Office 365 email addresses may be saved in either the Email field or the Alternate email field (both on the Details
tab of the user properties). Common practice is to preserve the corporate email address in the first of these, and
save the one from Microsoft Office 365 in the Alternate email field.

i
= Tip: If you have many records to update, consider preparing a spreadsheet that lists your enterprise (Active

Directory) email addresses against the Office 365 email addresses for each user, and creating a business adapter
to update your records from the spreadsheet by inserting the Office 365 email addresses into the
ComplianceUser.AlternateEmail column inyour compliance database. Of course, if it is not practical to

do this preparation before your first import from Microsoft Office 365, you can add the Office 365 email addresses
to your AD-based user records at any time. Thereafter, the next full import and compliance calculation removes
any duplicate user records, based on the now-matching email addresses.

2. Ensure that you have created and scheduled a connector from FlexNet Manager Suite for each tenant of Microsoft
Office 365.

Typically, each enterprise is represented as a single tenant, although mergers and acquisitions may mean that
your enterprise has multiple Microsoft tenants. For details on how to create and schedule a connector to Microsoft
Office 365, see Creating Connections using the Microsoft 365 Connector.

=3

I=| Note: The Microsoft 365 connector is the recommended connector to use to create a connection to Microsoft
365. However, if you would like instructions using the legacy Microsoft Office 365 (deprecated) connector, see

Creating Connections using the Microsoft Office 365 (Deprecated) Connector.

3. Duringthe next discovery and inventory collection (following a scheduled connection and the upload of the
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resulting data), FlexNet Manager Suite creates or updates the following objects:

» Users: Each imported user from Microsoft Office 365 is mapped to the appropriate compliance user record (by
matching the Email or Alternate email field values). If an imported user cannot be mapped to any compliance
user, a new compliance user record is created with a dummy inventory device assigned to this user.

o Licenses: ANamed User multi-product license (MS-Tenant-name Office 365 (Plan XX)is created for
each subscription plan linked to each Microsoft tenant:

o This license is derived from a template provided in the downloadable libraries, and selected based on the
subscription plan identifier.

o The name of the Microsoft tenant is included as a prefix in the name of each of these licenses. This helps to
distinguish licenses when you have multiple Microsoft Office Online Service tenants.

o Multiple applications are linked to this license, as defined in the license template.

i |

|==| Note: If a particular plan is not currently supported by FlexNet Manager Suite, a license with no linked
application is created. When the support for this missing plan is added during subsequent automatic
updates to the SKU library and Application Recognition Library, a recommended license change appears,
suggesting that you link the newly-identified applications to the license.

o On the Use rights & rules tab of the license properties, in the License consumption rules section, the
Allocations consume license entitlements check box is set. This is because Microsoft Office 365 is a Named

User license, and allocations to the users must consume entitlements.
o On the Consumption tab of the license properties, the template sets the Allocation type to Permanent.
4. Review the All Users and All licenses pages to ensure that the required users and licenses have been created.

5. After license reconciliation has been completed, the Product Summary page shows the compliance status for
Microsoft Office 365.

6. Navigate to License Compliance > All Licenses and filter the records to view Microsoft Office 365 licenses. You can
check the Consumed and Used columns to know how many subscription entitlements are being used.

7. You can also view the following reports for insights on Microsoft Office 365 license consumption:
+ User license details
e License Overlap.

=3

|==| Note: A subscription of Microsoft Office 365 enterprise plan (except E1) allows you to install Microsoft Office 365
on up to five PCs or Macs, and up to five tablets. FlexNet Manager Suite can only track the installation on devices
that are present within your enterprise network. If you wish to include any installation outside the enterprise
network, you can create a dummy inventory device and allocate a Microsoft Office 365 license to track the usage.

Changes in subsequent imports
Each subsequent import from Microsoft Office 365 updates the following for each license of Microsoft Office 365:

« Entitlement count
o Expiry date

o Allocations correctly configured (as described above).
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Connecting to Microsoft Office 365

This chapter provides information about how FlexNet Manager Suite connects to Microsoft Office 365.

Connector overview

There are currently two connectors available. It is recommended that you use the use the Microsoft 365 connector, a
replacement for the existing Microsoft Office 365 (deprecated) connector. To help during the transition to the
Microsoft 365 connector, the legacy connector will remain available for a period of time. The following table provides an
overview comparison of the connectors. This table assumes you have installed the FlexNet Beacon released with FlexNet

Manager Suite 2019 R1 or later.

Connector Name Installation folder

Microsoft 365 ProgramData\Flexera

Software\Compliance\
D Note: This is the latest ImportProcedures\
Inventory\Reader\
Microsoft 365

connector.

Microsoft Office 365
(deprecated)

ProgramData\Flexera
Software\Compliance\
ImportProcedures\
D Note: This is the legacy Lnventory\Reader\
connector that is now Microsoft Office 365

deprecated.

D Note: This installation
folder name and path
remains unchanged.
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Notes

Note the following:

This Tier 1 inventory connector is now available to all
customers.

The Source Type (on the inventory beacon) is
Microsoft 365 .

Note the following:

This Tier 1 inventory connector remains available
although deprecated and will longer be supported on a
future release.

This connector's Source Type (specified on the
inventory beacon PowerShell dialog) is Microsoft
Office 365 (deprecated). However, If you have not
installed the FlexNet Beacon released with FlexNet
Manager Suite 2019 R1 or later, then Microsoft Office
365 (deprecated) will not appear as a Source Type
connection on the Create PowerShell Source
Connection dialog, and instead will remain Microsoft
Office 365.
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Generating the Microsoft Office 365 license compliance position

To generate the compliance position for Microsoft Office 365 licenses, FlexNet Manager Suite needs information about
subscriptions and usage of Microsoft Office 365 licenses (both online and offline):

o The local inventory collection process (within your enterprise) returns the local installations of Microsoft Office that
are tied to your Microsoft Office 365 subscription(s).

o To get subscription and usage information from Microsoft Office Online Service, the FlexNet Beacon must be
configured with an inventory connection of source type Microsoft 365 or Microsoft Office 365 (deprecated) for each
tenant of Microsoft Office 365. (Typically, each enterprise is a single Microsoft tenant; but your corporate history,
including mergers and acquisitions, may mean that your enterprise includes multiple Microsoft tenants. Each tenant
may then have one or more subscriptions to different licensing plans, such as Midsize Business or Enterprise.)

When you have created and configured the Microsoft Office 365 connection, the relevant inventory beacon imports the
licenses, users, and usage information from the Office 365 Online Service account and uploads it to FlexNet Manager
Suite according to your chosen schedule. For details on how to create and schedule a connector to Microsoft Office 365,
see Creating Connections using the Microsoft 365 Connector or see Creating Connections using the Microsoft Office 365
(Deprecated) Connector.

Prerequisites and Configuration
Considerations

This chapter describes prerequisites and configuration considerations for:
« Eachinventory beacon that needs to download data from Microsoft Office 365

« The Microsoft 365 or Microsoft Office 365 (deprecated) connector

FlexNet Beacon

The FlexNet Beacon released with FlexNet Manager Suite 2018 R2 or later is required to use the Microsoft 365
connector. However, installing the FlexNet Beacon included in the 2019 R1 or later release provides maximum ease-of-
use with the Microsoft 365 connector by including auto-populated values on the Create PowerShell Source
Connection dialog (that otherwise need to be entered manually). In addition, if you are using a using a FlexNet Beacon
released prior to FlexNet Manager Suite 2019 R1, then Microsoft Office 365 (deprecated) will not appear as a Source
Type connection on the Create PowerShell Source Connection dialog, and instead will remain Microsoft Office 365.

In addition, the inventory beacon that will collect inventory for Office 365 in the cloud requires a 64-bit operating
system: Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later.

Microsoft connector

Ensure that the account used to connect to the Microsoft Office 365 tenant(s) has the required privileges:
« Forthe Microsoft 365 connector, the Cloud Application Administrator and Reports Reader roles are required in
order for the FlexNet Beacon to retrieve a token that allows read only access to Microsoft Graph. For more

information, see the note below as well as: https://docs.microsoft.com/en-us/azure/active-directory/users-groups-
roles/directory-assign-admin-roles.
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=]

I==| Note: To be able to show Office 365 license consumption information in FlexNet Manager Suite, Microsoft requires
read access for Users, Subscribed SKUs, and Reports from Office 365. FlexNet Beacon uses Microsoft Graph APIs to
retrieve this data from Office 365. Microsoft Graph APIs only allow an administrator to read all of this information.
However, FlexNet Beacon does not use credentials to connect to Office 365 via Microsoft Graph, which would give it
full access as the user, but instead requests a token from Microsoft. Microsoft generates this token to allow access
only to requested resources, and only for requested permissions. The token cannot be used to access any other
resources and cannot be used to access any information on requested objects which requires other permissions.
For example, a User.ReadAll permission only allows getting a list of users but does not allow getting a list of
Calendar events or reading mail. The generated refresh token can only be used to access data that the user sees
and consents to during the token generation process, which is offline read-only access to Active Directory and
Reports (directory.read.all, reports.read.all, and offline_access). Offline means the FlexNet Beacon can connect
and get data from Office 365 at schedule run without user actually signing in.

» For the Microsoft Office 365 (deprecated) connector, if the maximum privileges of Global administrator cannot be
used, then in order to collect usage data, the integration user must at a minimum have Exchange administrator and
Skype for Business administrator roles in Office365 (available as check boxes under the Custom administrator
role). For more information, see https://support.office.com/en-gb/article/About-Office-365-admin-roles-da585eea-
f576-4f55-a1e0-87090b6aaadd?ui=en-US&rs=en-GB&ad=GB.

Make sure that the following PowerShell connector prerequisite is met on each inventory beacon that needs to
download data from Microsoft Office. These requirements should have been met when the inventory beacon was
installed:

o PowerShell 5.1 or later, with the PowerShell execution policy set to RemoteSigned

¥
= Tip: Run PowerShell with administrator rights to execute the following commands:

To check the currently-installed version of PowerShell:

$PSVersionTable.PSVersion

To set PowerShell execution policy:

Set-ExecutionPolicy RemoteSigned

The following Microsoft Office 365 (deprecated) connector-specific prerequisites must be also met on each inventory
beacon that needs to download data from Microsoft Office 365. These prerequisites are required for the Microsoft
Office 365 (deprecated) connector only and are not needed for the Microsoft 365 connector):

» 64-bit version of the Microsoft Online Services Sign-in Assistant (available from https://go.microsoft.com/fwlink/
p/?Linkld=286152).

o Microsoft Azure Active Directory Module for Windows PowerShell. Microsoft Office 365 uses Azure Active Directory to
manage user identities behind the scenes). To install the Microsoft Azure Active Directory Module for Windows

PowerShell with these steps:

1. Open an administrator-level PowerShell command prompt.
2. Runthe Install-Module MSOnline command.
3. If prompted to install the NuGet provider, type Y and press ENTER.

4. If prompted that the installer is not signed, type Y and press ENTER
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5. If prompted to install the module from PSGallery, type Y and press ENTER.

o Skype for Business Online, Windows PowerShell Module 64-bit version (https://www.microsoft.com/en-us/
download/details.aspx?id=39366).

Network

For information relating to the network requirements for your firewall or proxy server, please refer to the Microsoft
documentation https://docs.microsoft.com/en-us/office365/enterprise/urls-and-ip-address-ranges. You may also like
to refer to the Flexera knowledge base article How to configure Office 365 connector in a proxy enabled environment or
firewall

Creating Connections using the Microsoft
365 Connector

I} Important: The instructions in this section are for use with the Microsoft 365 connector. This is the recommended
connector to use to create a connection to Microsoft Office 365 on an inventory beacon. However, if you would like
instructions using the legacy Microsoft Office 365 (deprecated) connector, see Creating Connections using the
Microsoft Office 365 (Deprecated) Connector.

Use the following procedure to create a connection to Microsoft Office 365 on an inventory beacon using the Microsoft
365 connector. A separate connection is required for each tenant of Microsoft Office 365. (Typically, there is one tenant
per enterprise; but your corporate history, particularly of mergers and acquisitions, may mean that your enterprise has
multiple Microsoft tenants.) The inventory beacon requires this connection to import entitlements, users, and usage
information from the Microsoft Office 365 online account. Each per-tenant import covers all subscriptions for that
tenant.

When you use the Microsoft 365 connector, there are two ways of creating connections to the Microsoft Office 365
online service. Refer to the following sections for associated instructions:

o Using FlexNet Manager Suite’s Multi-Tenant App to Connect to Microsoft 365 — The Microsoft 365 connector uses a
pre-registered multi-tenant app that has been configured by Flexera for the purpose of collecting Microsoft Office
365 data. This app is configured to allow customers to collect data without the overhead required to register an app
using the Azure portal in their own Microsoft Office 365 instance.

o Registering an app using the Azure portal to connect to Microsoft 365 — This second method registers an app within
your own Microsoft Office 365 instance.

Using FlexNet Manager Suite’s Multi-Tenant App to
Connect to Microsoft 365

I:i) Important: The instructions in this section are for use with the Microsoft 365 connector. This is the recommended
connector to use to create a connection to Microsoft Office 365 on an inventory beacon. If you would like instructions
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using the legacy Microsoft Office 365 (deprecated) connector, see Creating Connections using the Microsoft Office
365 (Deprecated) Connector.

L
[_] To create a connection to Microsoft 365 on an inventory beacon using FlexNet Manager Suite's multi-tenant
app:

1. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu, search for
FlexNet Beacon, right-click it, and select Run as administrator).

i
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

2. From the Data collection group in the navigation bar, choose Inventory Systems.
3. Choose either of the following:

o To change the settings for a previously-defined connection, select that connection from the list, and click
Edit....

» To create a new connection, click the down arrow on the right of the New split button, and choose
Powershell.

4. Complete (or modify) the values for the following required fields:

« Connection Name: The name of the inventory connection. The name may contain alphanumeric characters,
underscores or spaces, but must start with either a letter or a number. When the data import through this
connection is executed, the data import task name is same as the connection name.

» Source Type: Select Microsoft 365 from this list.

5. Optionally, if your enterprise uses a proxy server to enable Internet access, complete (or modify) the values in the
Proxy Settings section of the dialog box in order to configure the proxy server connection.

» Use Proxy: Select this checkbox if your enterprise uses a proxy server to enable Internet access. Complete
the additional fields in the Proxy Settings section, as needed. If the Use Proxy checkbox is not selected, the
remaining fields in the Proxy Settings section are disabled.

» Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or

IPAddress:PortNumber). This field is enabled when the Use Proxy checkbox is selected.

« Username and Password: If your enterprise is using an authenticated proxy, specify the username and
password of an account that has credentials to access the proxy server that is specified in the Proxy Server
field. These fields are enabled when the Use Proxy checkbox is selected.

6. Inthe Microsoft 365 section, do the following:

a. Note that the following fields are auto-populated if you have installed the FlexNet Beacon released with
FlexNet Manager Suite 2019 R1 or later. If you have not installed this FlexNet Beacon, then manually enter
the following values into these fields:

o Authorization Endpoint: https://login.microsoftonline.com/common/oauth2/v2.0/

authorize
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« Token Endpoint: https://login.microsoftonline.com/common/oauth2/v2.0/token
« Application (client) ID: 5bb1a5a2-0d97-4335-9448-119f7b27aff9
o Redirect URIL: https://login.microsoftonline.com/common/oauth2/nativeclient

b. Next to the Refresh Token click the Generate button to generate a refresh token that will be used to
integrate with Microsoft 365.

When you click the Generate button to the right of the Refresh Token field, a Microsoft popup appears
asking you to Pick an account to use to log into Microsoft Office 365.

¢. Choose an Active Directory account with the Cloud Application Administrator and Reports Reader role
privileges, and enter the password.

¥
= Tip: The Cloud Application Administrator and Reports Reader roles are required in order for the

FlexNet Beacon to retrieve a token that allows read only access to Microsoft Graph. For more
information, see https://docs.microsoft.com/en-us/azure/active-directory/users-groups-roles/
directory-assign-admin-roles. The generated refresh token can only be used to access data that user
sees and consents to during the token generation process, which is offline read-only access to Active
Directory and Reports (directory.read.all, reports.read.all, and offline_access). Offline means the
FlexNet Beacon can connect and get data from Office 365 at schedule run without user actually
signing in.

A Permissions requested dialog appears.

d. Click Consent on behalf of your organization to accept the read only permissions that will be granted to
the refresh token.

e. Click Accept.
The Refresh Token field is now populated.

7. Atthe bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

L
= Tip: Consider whether you want to select your connection, and click Execute Now, before you exit. For

information about scheduling data imports through this connection, see Scheduling a Connection in the
online help.

After a successful data import, the users, applications, licenses, and usage data are all visible in the appropriate pages

of FlexNet Manager Suite.

=

|==I' Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see
Invent